
User’s Guide

Copyright 2008 IntelliTools, Inc.



ii

IntelliTools Contact Information
IntelliTools, Inc.

1726 Corporate Circle

Petaluma, CA 94954-9926

USA

Technical Support and Customer Service
Hours: 7:30 a.m.–4 p.m. Pacific Time, Monday through Friday

Phone: (800) 899-6687 (U.S. and Canada)
(707) 773-2000 (local and international)

Fax: (707) 773-2001

Email: tech@intellitools.com (for technical information)

info@intellitools.com (for general information)

World Wide Web: http://www.intellitools.com

To ensure that returns are handled correctly and without delays, please call us for a Return Merchandise Authorization (RMA)
before returning any item.

Copyright Notice
© 2008, IntelliTools, Inc. All rights reserved. The distribution and sale of this software and manual are authorized for
the original purchaser only. Unauthorized duplication is a violation of federal copyright law. Images that appear in
Intellitools Classroom Suite may not be used in any commercial application without the prior consent of IntelliTools,
Inc.

Trademarks and Acknowledgments
IntelliTools (and logo), IntelliKeys, IntelliMathics, IntelliPics, IntelliTalk (and logo), Overlay Maker (and logo),
SwitchIt!, and ClickIt! are registered trademarks of IntelliTools, Inc. All other IntelliTools product names and logos
are trademarks of IntelliTools, Inc. Other companies’ brand names, product names (including Windows, Macintosh,
QuickTime, and Adobe Reader), and logos mentioned herein are registered trademarks, trademarks, or brand
names of their respective holders and are hereby acknowledged.

Credits
Overlay Maker 3 was produced through the collaborative efforts of many staff members and individuals at
IntelliTools, including (alphabetically): Virginia Burt, Jeff Curtis, Ben Cushman, Al Dynarski, Jane Faley Smith,
Suzanne Feit, Chris Finley, Dale Goetsch, Michelle Graham, Debbie Grant, Kathy Griffin, Arjan Khalsa, Jenna Jones,
Paula Justice, Patty Kilroy, Kathie Maltby, Bruce McClanahan, Al Merkrebs, Jo Meyer, Ed Murphy, Philip
Nittenberg, Meida Pang, Aakash Patel, Lucinda Ray, Solana Reed Henneberry, Alan Rhody, David Robertshaw, Fred
Ross-Perry, Scott Schafer, Lisa Sheean, Karen Sheehan, Scott Solin, John Van Straalen.

MNL-OM3- Printed in U.S.A. 3/08 



Package Contents.....................................................................................................................vi

What’s New and Different? ....................................................................................................vii

01: IntelliKeys, Overlays, and Overlay Maker 3 .................................1

Introduction ...............................................................................................................................1

02: Getting Started .........................................................................7

System Requirements...............................................................................................................7

Installing Overlay Maker 3 .......................................................................................................8

Uninstalling Overlay Maker 3...................................................................................................9

Launching Overlay Maker 3 ...................................................................................................10

03: Tutorials..................................................................................11

Beginners Tutorial – Creating an Overlay............................................................................11

Intermediate Tutorial – Modifying an Overlay ....................................................................23

Advanced Tutorial – The Parts of a Fish ..............................................................................31

04: Using the Navigation Screen ....................................................43

Navigation Screen: Contents..................................................................................................43

New Folder Contents..............................................................................................................45

Overlay Folder Contents ........................................................................................................46

Managing Folders and Files in the Overlays Folder ...........................................................47

Quitting Overlay Maker 3 .......................................................................................................48

Navigation Screen: FAQ .........................................................................................................49

05: Working with Overlay Files .......................................................51

Finding and Opening Overlays..............................................................................................51

Saving Overlay Files ...............................................................................................................53

Printing an Overlay .................................................................................................................57

Closing an Overlay ..................................................................................................................58

06: Working with Menus, Toolbars, and the Status Bar ...................59

Menu Listings, Menu Actions, and Keyboard Shortcuts....................................................59

Toolbars and Tools..................................................................................................................65

Status Bar.................................................................................................................................70

07: Working with Settings and Preferences ....................................71

IntelliKeys Settings... ..............................................................................................................71

Preferences... ...........................................................................................................................76

iiiTable of Contents

Table of Contents

The pictures in
this User’s Guide
may differ slightly

from what you see on-
screen, depending on
your computer system
and its settings.

Note



08: Working with Keys and Setting Key Content .............................79

Keys: General Information .....................................................................................................79

Working with Keys..................................................................................................................79

Setting Key Content (i.e., What a Key Does).......................................................................87

09: Working with Text Boxes,Frames,Lines,Pictures,Backgrounds.95

Working with Objects: General Information ........................................................................95

Working with Text Boxes (i.e., Free Text)...........................................................................95

Working with Frames (i.e., Free Shapes)...........................................................................100

Working with Lines ...............................................................................................................104

Working with Pictures (i.e., Free Pictures)........................................................................107

Working with Backgrounds .................................................................................................111

10: Making Overlays....................................................................115

Making a New Overlay: Preparation...................................................................................115

Making a New Overlay: Using a Blank Overlay ................................................................115

Making a New Overlay: Using an Overlay Activity Kit .....................................................116

Making a New Overlay: Using a Predesigned Layout ......................................................117

Making a New Overlay: To Work with Other Software Programs ..................................118

Making a New Overlay: For DynaVox Users .....................................................................120

11: Using Overlay Maker 3 with IntelliTools Classroom Suite.........121

IntelliTools Classroom Suite: Making a New Overlay Using Overlay Maker 3................121

IntelliTools Classroom Suite: Programming Switches Using Overlay Maker 3 ...............125

IntelliTools Classroom Suite: Displaying an Overlay File ..................................................125

IntelliTools Classroom Suite: Editing an Attached Overlay ...............................................126

IntelliTools Classroom Suite: Attaching an Overlay ...........................................................127

IntelliTools Classroom Suite: Sending Overlays .................................................................128

IntelliTools Classroom Suite: Printing an Overlay ..............................................................129

IntelliTools Classroom Suite: Finding, Saving and Storing Overlay Files ........................130

IntelliTools Classroom Suite: Importing and Exporting Files with Attached Overlays ..130

IntelliTools Classroom Suite: Additional Information.........................................................131

12: Working with Multilevel Overlays............................................133

Multilevel Overlays: FAQ .....................................................................................................133

All Levels ................................................................................................................................136

13: Working with Overlay Activity Kits..........................................137

Overlay Activity Kits: Suggested Grade Levels..................................................................137

iv Overlay Maker 3 User’s Guide



Overlay Activity Kits: Language Arts..................................................................................138

Overlay Activity Kits: Language Arts and Math ................................................................141

Overlay Activity Kits: Math ..................................................................................................142

Overlay Activity Kits: Braille Access ...................................................................................143

Overlay Activity Kits: Off-Computer Activities...................................................................145

14: Troubleshooting.....................................................................147

Troubleshooting – Installation.............................................................................................147

Troubleshooting – Creating an Overlay .............................................................................147

Troubleshooting – Problems Printing an Overlay.............................................................149

Troubleshooting – Problems Sending an Overlay.............................................................150

Troubleshooting – Problems Using Overlays....................................................................151

Index ..........................................................................................155

vTable of Contents



vi Overlay Maker 3 User’s Guide

Package Contents
1 Overlay Maker 3 CD

1 Overlay Maker 3 User’s Guide (includes 3 easy-to-follow tutorials)

4 Preprinted overlays:

Overlay #1

side a – I Can Write Word by Word L2

side b – I Can Write Kittens Keyboard

Overlay #2

side a – Circle Time Weather

side b – Journal Writing L4

Overlay #3

side a – Patterns and Sports

side b – Off-Computer Medium Game Board

Overlay #4

side a – Simple Sentences Level 2

side b – Simple Sentences Level 3



What’s New and Different?
For those familiar with previous versions of IntelliTools’ 
Overlay Maker, here is a list of some new and useful features
included in Overlay Maker 3.

Overlay Maker 3 files are cross-platform.
The same overlay works with both Windows and Macintosh systems. (You no longer
need to use IntelliTools Converter to use overlays on both platforms.)

Overlay Maker 3 is OS X native.
The program works with the current version of this popular Macintosh Operating
System.

Overlay Maker 3 is closely integrated with Classroom Suite.
Classroom Suite users will recognize many Overlay Maker 3 menus, tools, and
navigation features.

When making overlays, you can use the Classroom Suite appearance and style options
for overlay keys and text and use Classroom Suite background pictures for overlay
backgrounds.

Improved Make Overlay feature for Classroom Suite users.
A wizard helps you select the buttons and regions you want made into overlay keys.

Buttons from the same toolbar are automatically grouped together as keys on an
overlay.

You can select predesigned overlay layouts to use as is, or modify.

Overlay Maker 3 includes Overlay Activity Kits.
Overlay Activity Kits (a related set of sample activities, templates, and tutorials) can be
used to make Classroom Suite activities along with matching overlays.

Improved Picture Library.
The Overlay Maker 3 Picture Library includes pictures from the Classroom Suite
Picture Library.

You can search for pictures by typing partial picture names.

The Overlay Maker 3 Picture Library can include Boardmaker pictures (if the
Boardmaker 5 program is also installed on your system).

Improved Toolbar and Tools.
Use the Frame tool to draw framed shapes.

Use Fix to Background to create more diverse backgrounds.

Use Arrange tools to layer or overlap objects on an overlay.

viiWhat’s New and Different?
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Display the Advanced Toolbar for additional editing tools.

More control over overlay appearance. More design options.
Background pictures can be stretched, tiled, or centered.

Pictures on keys can be rotated and/or flipped.

You can create transparent keys by hiding borders and fill colors.

You can import JPEG, GIF, PICT, PSD, PNG, and BMP picture files.

New features save design and authoring time.
A selection of keyguard masks is provided to help you position keys on an overlay.

A selection of switch settings is provided to help you determine switch content.

You can easily create and access multiple overlay levels.

Keys can be moved off the grid.

Curriculum access for DynaVox users.
Overlays made from IntelliTools Classroom Suite documents can be saved as DynaVox-
compatible files so DynaVox users can work with IntelliTools Classroom Suite activities.

Create classroom materials for off-computer activities.
Create game boards (for Bingo, dominoes, lotto, etc.) newsletters, and other activities
that do not utilize IntelliKeys and computers. (Based on work by Jo Meyer of
SoftTouch.)

Easy upgrade to Overlay Maker 3 for previous version users.
Overlay Maker 3 is a separate program—you can have previous versions of Overlay
Maker installed on your system and use previous versions.

Overlay Maker 3 can edit, print, and send files made from previous versions of Overlay
Maker. No importing is necessary.

Saving an overlay made from a previous version of Overlay Maker automatically
converts it to an Overlay Maker 3 file. (Overlay Maker 3 files cannot be opened using
previous versions of Overlay Maker.)
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This chapter will introduce you to IntelliKeys,
overlays, and Overlay Maker 3 program
features.

Introduction
IntelliKeys is IntelliTools’ award-winning
adaptive keyboard that connects to Windows
or Macintosh computers. The original
IntelliKeys was created in 1991. IntelliKeys
USB was introduced a decade later. Both
IntelliKeys models (Classic and USB) offer a
range of access settings to meet the needs of
people with various disabilities. Access
settings can be customized for individual
students. IntelliKeys is most powerful and versatile
when used with interchangeable IntelliKeys overlays.

An overlay is a printed sheet of paper or plastic that is placed over the touch-sensitive front
panel of the IntelliKeys. Each overlay has a keyboard layout printed on it that may
correspond to an on-screen document. Simply insert the appropriate overlay and begin
working. Pressing a printed key on the overlay sends the desired information to your
computer. Using overlays, a student can type letters, enter numbers, navigate on-screen
displays, or execute menu commands. 

Overlay Maker 3 is IntelliTools’ popular overlay management program. It enables you to
create new overlay files for IntelliKeys, view and edit existing overlays, send overlay files to
IntelliKeys, and print overlays. In addition, Overlay Maker 3 allows you to customize access
settings for an IntelliKeys user. 

Creating and Editing Overlays Using Overlay Maker 3
If you design your own on-screen curriculum activities, you can use Overlay Maker 3 to
create matching overlays for IntelliKeys users. For instance:

• For a child learning to create sentences, you could make an overlay that has all the
subject words in one column, the verbs in a second column, the objects in a third
column, and the punctuation marks in a fourth column. 

• For someone with a speech disability, you could create a communication board
containing everyday words and phrases or standard communication symbols. 

• For someone who is learning English as a second language, you could create an
overlay that has pictures of objects on the keys. You could set key content to show the
corresponding English name for each object on-screen when the key is pressed.

In addition, the Make Overlay feature installed with Overlay Maker 3 enables you to create
an overlay file from any open IntelliTools Classroom Suite document.

In some instances, it may be useful to edit an overlay. For example, you might want to
delete some keys that a student could find distracting, reposition some keys to make them
easier to press, or change the color of a key to make it easier to see. Overlay Maker 3
enables you to edit an overlay that is already attached to a document, or to edit an overlay
that has not yet been attached to a document (perhaps one that another teacher has already
designed). 

For more detailed
instructions about
using IntelliKeys
Classic or

IntelliKeys USB, review
your IntelliKeys User’s
Guide.

For more
information
about creating

and editing overlays,
refer to chapter 10.

01: IntelliKeys, Overlays, and Overlay Maker 3

Tip

IntelliKeys with printed overlays

Tip
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Overlay Files, Attached Overlays, Sending Overlays, and Printed
Overlays
Here is some general information about four terms you will encounter throughout this
User’s Guide: overlay files, attached overlays, sending overlays, and printed overlays.

Overlay Files
Very simply, an overlay file is information that describes interactive parts of a document.
These parts are represented by keys. The overlay file is sent to IntelliKeys so its touch
sensitive surface works correctly with that document. Most overlay files also contain
graphic information used for the printed version of the overlay. You can create and edit
overlay files from any open document using Overlay Maker 3. 

Attached Overlays
When an overlay file is associated with an IntelliTools Classroom Suite document, it is said
to be “attached” to the document. It is referred to as the “attached overlay.” More than one
overlay can be attached to a document to meet the varying needs of a single student or of
students sharing an IntelliKeys. Overlay Maker 3 does not attach overlays. However, you
can choose which overlay to attach to a document using the IntelliTools Classroom Suite
Attach Overlay feature. Only one attached overlay can be active at a given time.

Sending Overlays
Sending an overlay refers to moving an overlay file from a computer to an IntelliKeys. To
make it easy for IntelliKeys users, IntelliTools’ curriculum authoring tools such as
Classroom Suite can automatically send an attached overlay file to IntelliKeys. IntelliTools
Classroom Suite users can also attach and send files manually. When working with other
programs, you send unattached overlay files to IntelliKeys using an Overlay Maker 3 menu
command or Overlay Sender (a program installed with Overlay Maker 3).

It is possible to save an overlay as “send-only” file. Send-Only files are overlay files that
contain information needed by an IntelliKeys, but don’t contain the information that would
enable them to be displayed on-screen (for editing) or printed. Therefore, they can only be
sent.

Printed Overlays
Along with an attached overlay sent to IntelliKeys, you need a corresponding printed sheet
of paper (or plastic) to place over the touch sensitive surface of the IntelliKeys. This printed
version of an overlay file is generally referred to as the “overlay.” 

An overlay can show some or all of the options a student sees on-screen. User options are
presented as printed keys (like keys on a keyboard). Pressing the key on the overlay
initiates the desired action on-screen. Overlay Maker 3 enables you to print an overlay from
any overlay file using a standard computer printer.

Overlay Maker 3 includes four doublesided, preprinted overlays and a collection of overlay
files that can be modified and/or printed. Additional preprinted overlays designed for
IntelliTools Classroom Suite activities and multipurpose use are available from IntelliTools. 

The term
“overlay” is
frequently used

to describe both the
electronic file and the
corresponding printed
overlay.

For more
information
about using

Overlay Maker with
IntelliTools Classroom
Suite, refer to chapter
11.

Note

Tip
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Working with Overlay Maker 3
After you launch Overlay Maker 3, the Navigation Screen displays. The Navigation Screen
options enable you to select and open a variety of new overlays and overlays that you have
saved. Using Navigation Screen options, you can also navigate to your desktop, manage
files and folders, choose how folders and files show, and quit the program.

Once you select and open an overlay, the overlay displays in the Overlay Maker 3 main
program window. The window contains the Overlay Maker 3 Menu bar, two Standard
Toolbars (one horizontal and one vertical), and the overlay (displayed in one of three
views). In addition, you can choose to show the Advanced Toolbar, the Status Bar, and the
Picture Library (displayed as a toolbar).

Navigation Screen

Menu bar
Standard
Toolbar

Advanced
Toolbar

Standard
Toolbar

Overlay

Status barPicture
Library

Overlay Maker 3 features

For more
information
about using the
Navigation

Screen, refer to chapter
4.

For more
information
about working

with menus and
toolbars, refer to
chapter 6.

For more
information about
working with the

Status bar, refer to
chapter 6.

Tip

Tip

Tip

Navigation
window

Directory
Path

Navigation
buttons

File/Folder
management
buttons

Open 
buttonQuit 

button

View
Options



In previous
versions of
Overlay Maker

documentation, text in
text boxes, pictures,
lines, and frames were
referred to as free text,
free pictures, free lines,
and free shapes.

For more
information
about working

with keys, refer to
chapter 8.

For more
information
about working

with text boxes, pictures,
lines, frames, and
backgrounds, refer to
chapter 9.

For more
information
about working

with multilevel overlays,
refer to chapter 12.

4 Overlay Maker 3 User’s Guide

Parts of an Overlay
An Overlay Maker 3 overlay can include:

• Keys – Keys are the interactive parts of an overlay. You can determine a key’s function.
To identify it on a printed overlay, you can add a picture or text to a key and also choose
a key’s appearance (size, shape, color, etc).

• Text Boxes – Text Boxes are used to display text such as instructions, captions, titles,
etc. You can choose the font, size, color and style of text in text boxes.

• Pictures – Pictures from the Overlay Maker 3 Picture Library or from your own
sources can be added to an overlay for illustrative or decorative purposes.

• Lines – Lines of various thickness and color can be drawn on the overlay.

• Frames – Variously shaped frames can be drawn around groups of related keys to
make them easier to identify or framed shapes can be added for decorative purposes.

• A background – You can add a background to an overlay to illustrate or decorate it. You
can use a supplied background picture, color, or pattern or design your own
background.

• Levels – A overlay can contain up to 15 levels. Each level in a multilevel overlay is
analogous to a page in a document—you can view, work with, and send individual
levels (i.e., pages) to IntelliKeys, though all the various levels belong to a single overlay
file (i.e., document).

Picture BackgroundText Box

Line

Frame

Keys with
picture and
text

Note

Tip

Tip

Tip

An overlay on an IntelliKeys
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Using Overlay Maker 3 with IntelliTools Classroom Suite
IntelliTools Classroom Suite is designed to provide one set of cross-curricular classroom
tools that steps up with students—from kindergarten through middle school. Powerful yet
easy-to-use, it delivers curriculum, creativity, and accountability in one extremely flexible
program.

Using IntelliKeys and overlays is an ideal solution for students who have difficulty
accessing IntelliTools Classroom Suite using a standard mouse or a standard keyboard. The
program includes a selection of overlays designed for popular IntelliTools Classroom Suite
activities. Using Overlay Maker 3, you can easily make your own overlays from any
IntelliTools Classroom Suite document (for instance, you might have designed a new
classroom activity and want to create a corresponding overlay). 

Once installed on your system, Overlay Maker 3 launches automatically when you select
Make Overlay from the IntelliTools Classroom Suite IntelliKeys menu options. The Make
Overlay feature enables you to create an overlay file based on the open document. You can
also print the file. 

In addition, overlays made from IntelliTools Classroom Suite documents can be saved as
DynaVox-compatible files so DynaVox users can work with IntelliTools Classroom Suite
activities.

Using Overlay Maker 3 with Other IntelliTools Programs
Using Overlay Maker 3, you can open, send, and print overlays created for previous
versions of IntelliTools Classroom Suite tools. However, you cannot use the new Make
Overlay feature to create overlays from previous program versions, as it is designed to
work only with IntelliTools Classroom Suite. To take full advantage of all the Overlay Maker
3 features, it is recommended that you install and use IntelliTools Classroom Suite in your
classroom.

Using Overlay Maker 3 with Other Software
IntelliKeys Classic and IntelliKeys USB ship with a set of Standard overlays that provide
IntelliKeys users access to a variety of software programs, including educational activities,
word processing programs, calculators, spread sheets, Internet browsers, etc.

Using Overlay Maker 3, you can easily modify these Standard overlays or make new ones.
Overlays can be customized for the needs of individual IntelliKeys users, or groups of
users. 

Setting IntelliKeys Switch Content 
IntelliKeys has two built-in, programmable switch ports allowing the IntelliKeys to be used
as a switch interface. Many commonly used switches can be plugged into these jacks. In
addition, the keyboard itself can behave as a switch. Using Overlay Maker 3, you can set
the switch content to best suit the needs of any IntelliKeys user.

For more
information
about using
Overlay Maker 3

with IntelliTools
Classroom Suite, refer to
chapter 11.

Tip
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System Requirements
If IntelliTools Classroom Suite is not already installed on your system, the Overlay
Maker 3 installation procedure automatically installs IntelliTools Classroom Suite
Player, in addition to Overlay Maker 3. See Hard Drive Space requirements.

Windows Minimum System Requirements
Operating System: Win 98, ME, 2000, XP, Vista

RAM: Win 98, ME – 64MB

Win 2000, XP – 128MB; Vista - 1GB

Hard Drive Space: 150MB – if IntelliTools Classroom Suite is already installed

310MB – if IntelliTools Classroom Suite is not already installed

Processor: Pentium 233MHz

Display: 16 bit hi colors 800 x 600

CD-ROM: Required

Sound Card: No

IntelliKeys: Required

Mouse Accessible: Yes

Switch Accessible: NA

Runs from CD: No

Macintosh Minimum System Requirements
Operating System: OS 8.6, 9.x, 10.1 or higher

RAM: 32MB available

Hard Drive Space: 150MB – if IntelliTools Classroom Suite is already installed

310MB – if IntelliTools Classroom Suite is not already installed

Computer: iMac/G3 333MHz

Display: Thousands of colors 800 x 600

CD-ROM: Required

Sound Card: No

IntelliKeys: Required

Mouse Accessible: Yes

Switch Accessible: NA

Runs from CD: No

702: Getting Started 
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Installing Overlay Maker 3
On a Windows computer:

1. Insert the Overlay Maker 3 CD into the CD-ROM drive. The program installation starts
automatically.*

2. Follow the installation instructions that appear on-screen.

* If your computer is not set up for automatic installation (the Auto insert notification
setting): 

Double-click the My Computer icon on your desktop. Right-click the CD icon and
select Explore to see the CD’s contents. Double-click the setup.EXE icon in the
content window that appears. Proceed to Step 2.

On a Macintosh computer:

1. Insert the Overlay Maker 3 CD into the CD-ROM drive. A CD-ROM icon appears on the
desktop along with an open window labeled Overlay Maker 3 CD.

2. Double-click the installer icon in the open window. The program installation starts
automatically.

3. Click Continue and follow the on-screen instructions.

Important Installation Information
• If IntelliTools Classroom Suite is not already installed on your system, you will not be

able to access the Overlay Activity Kits. 

• The Overlay Maker 3 installation procedure automatically installs files into the
IntelliTools Classroom Suite program folder. You can access these files using Overlay
Maker 3 (by clicking a shortcut icon displayed in the Overlay Maker 3 Navigation
window) or by using IntelliTools Classroom Suite program navigation features.

After installing
Overlay Maker 3,
all overlay file

icons, including those
created using previous
versions of Overlay
Maker, will have the
new Overlay Maker 3
look. However, until an
overlay file is saved
using Overlay Maker 3,
the older overlay files
can still be opened using
previous versions of
Overlay Maker.
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Begin installation

Installation in progress

Note



Uninstalling Overlay Maker 3
From a Windows computer:

1. Select Settings\Control Panel from the Start menu.

2. Click Add/Remove Programs.

3. Select Overlay Maker 3.

4. Click Change/Remove. A Select Uninstall dialog box appears.

5. Click Uninstall. Files saved to the My Overlays folder after Overlay Maker 3 was
installed will not be deleted.

From a Macintosh computer:

1. Locate and launch (i.e., double-click) the Overlay Maker 3 Uninstaller (Applications,
IntelliTools, Overlay Maker 3).

2. Click Continue. A dialog box appears asking you to verify that the folder to be deleted
is the Overlay Maker 3 folder. 

3. Click OK to delete the installed contents of the Overlay Maker 3 folder (Files saved to
the Overlays folder after Overlay Maker 3 was installed will not be deleted.)

902: Getting Started 

Overlay Maker 3 Uninstaller
in Overlay Maker 3 folder

(Macintosh)

Overlay Maker 3 Uninstaller
(Windows)



Launching Overlay Maker 3
Windows users:

1. From the Start menu, select Programs, IntelliTools Software, Overlay Maker 3, Overlay
Maker 3.

2. Click the Overlay Maker 3 icon. 

The program opens to the Overlay Maker 3 Navigation Screen. 

Macintosh users:

Double-click the Overlay Maker 3 icon located on your desktop. 

The program opens to the Overlay Maker 3 Navigation Screen. 

10 Overlay Maker 3 User’s Guide



1103: Beginners Tutorial – Creating an Overlay

Part 1: Launching Overlay Maker 3
To begin this tutorial, if it is not already launched,
launch Overlay Maker 3.

Windows users:

From the Start Menu, select Programs, IntelliTools
Software, Overlay Maker 3, Overlay Maker 3.

Macintosh users:

Double-click the Overlay Maker 3 icon located on your
desktop.

Part 2: Exploring the New Folder
After launching, the Overlay Maker 3 Navigation
Screen shows with the contents of the New folder
displayed in the navigation window (the area in the
center of the screen). Notice that the New folder
contains two folders (Overlay Activity Kits and
Predesigned Layouts) and a Blank Overlay.

1. Click the Overlay Activity Kits folder to open it.
The four subfolders (Braille Access, Language
Arts, Math, and Off-Computer Activities) contain
Overlay Activity Kits. Each kit contains:

• Overlay Maker 3 overlays 

• A step by step tutorial (as a PDF file)

03: Beginners Tutorial – Creating an Overlay

Introduction
Overlay Maker 3 is a simple, easy-to-use program that enables you to create your own custom overlays for
IntelliKeys users. Using Overlay Maker 3, you can design overlays to provide access to the computer for
people with various skill levels and/or disabilities. 

For instance, beginning readers and writers can benefit by using simple overlays that include keys with
pictures and text. For people with physical limitations, the keys can be sized to suit their needs. Background
and text color can be chosen to accommodate visual and processing difficulties. The possibilities for
creating custom overlays are endless!

About this Tutorial
Using this tutorial you will learn how to make a custom overlay by creating keys on the overlay, adding text
labels to keys, and changing the size, shape, and color of keys. You will also learn how to add special
commands to take advantage of the unique read and delete features of Writing mode in Classroom Suite.
Finally, you will send your finished custom overlay to IntelliKeys and use it with Writing mode (or other
word processing programs).

For assistance with program features, select Help from the Help menu or click a ? button.

After completing this tutorial, your 
overlay will look similar to this

Tip

Navigation Screen showing contents of New folder
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• Shortcuts (links) to IntelliTools Classroom
Suite sample activities.

• Authoring templates designed to help you
create additional activities quickly and easily.

2. Notice that the directory path at the top of the
screen shows you are looking at the Overlay
Activity Kits subfolder within the New folder. 
Click the Back button (the left-pointing blue arrow
on the left side of the directory path) to return to
the New folder.

3. Click the Predesigned Layouts folder to open it.
The four subfolders in the Predesigned Layouts
folder contain alternative keyboard layouts for use
with any software program, including IntelliTools
Classroom Suite.

4. Click the Back button to return to the New folder.

5. Click Blank Overlay to open a new overlay. In the
next part of this tutorial, you will learn how to use
a blank (untitled) overlay to create a new overlay
for an IntelliKeys user.

What you’ve learned: How to find Overlay Activity
kits, predesigned layouts, and a blank overlay.

Part 3: Saving and Naming an
Overlay
It is a good habit to immediately save and name a
blank, untitled overlay. All overlays are saved in the
Overlays folder.

1. Click the Save button on the Standard Toolbar.
The Save As dialog box displays.

2. Name the overlay Writing Sentences. 

3. You can choose to save your overlay in the My
Overlays subfolder or save it in the IntelliTools
Classroom Suite Overlays subfolder. For this
tutorial, you will save the overlay in the My
Overlays subfolder: 

a. Select the My Overlays subfolder.

b. Click Save. The Writing Sentences overlay will
be stored in the selected folder.

While you are making an overlay, save your
work regularly!

What you’ve learned: How to save an overlay in the
Overlays folder.

Navigation Screen showing 
contents of Overlays folder

Navigation Screen showing contents 
of Predesigned Layouts folder

Naming an overlay using the Save As dialog box 
(with My Overlays folder selected)

Tip

Save button
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Part 4: Creating, Copying, and
Pasting Keys on an Overlay
Now let’s add some keys to the overlay. To save time,
you will first create a single key on the overlay and
then copy and paste it to include additional keys on the
overlay.

1. Select the Key Tool (the button on the upper right
corner of the vertical Standard Toolbar).

Tools can also be selected from the Overlay
Maker menu.

2. Position your pointer on the overlay where you
want a corner of the new key to be.

3. Press the mouse button and drag your cursor
diagonally to “draw” a rectangular key
approximately 6 grid squares tall x 8 grid squares
wide in size. You have just created a new key!

Notice the black resizing handles on the new
key—this indicates the key is selected. Using the
Key Tool or the Select Tool, you can resize a key
by grabbing and dragging a resizing handle.

You can show or hide the grid by selecting
or deselecting the Grid Lines option from
the View menu.

4. From the horizontal Standard Toolbar, click the
Copy button to copy the new key to your clipboard.

5. From the same Standard Toolbar, click the Paste
button to paste the duplicate key on the overlay. 

Notice that Overlay Maker 3 will not allow keys to
overlap.

6. Repeat step 5 five more times to paste a total of
seven keys on the overlay.

7. Select and drag the keys so that they are
positioned in three columns arranged in a 2-3-2
pattern: 

• Two keys are in the left column.

• Three keys are in the middle column.

• Two keys are in the right column. 

What you’ve learned: How to create keys using the
Key Tool.

A single key created on the overlay

Keys arranged in a 2-3-2 pattern

Tip

Tip

Key Tool button

Paste button

Copy button
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Part 5: Adding Text Labels to Keys
Typically, each key on an overlay will have a text label
to identify the key to the IntelliKeys user. It is possible
to enter text and then set text properties (i.e., font,
size, style, and color) for each selected key. To save
time, before you type each label, you can set text
properties for all the keys on an overlay at once.

1. Click the Select Tool (the button on the upper left
corner of the vertical Standard Toolbar). 

2. To select all the keys on the overlay, press the
mouse button and drag your cursor from the top
left-hand corner of the overlay to the bottom right.
All keys should be selected. 

Or, if you prefer to use a menu command, from the
Edit menu, choose Select All.

3. From the Font Name drop-down menu on the
toolbar at the top of the screen, select a font.
(Many students like Comic Sans.)

4. From the Font Size drop-down list, select a size.

5. Click the Text Tool (another button on the vertical
Standard Toolbar). 

When typing entries in steps 6, 7, and 8, do
not include periods. You will add
punctuation in a later step.

6. Add text labels to the keys in the leftmost column:

a. Click inside the key in the top left-hand corner
of the overlay. Type I like.

b. Click inside the key in the lower left-hand
corner of the overlay. Type I don’t like. 

7. Add text labels to the keys in the center column:

a. Click inside the upper key. Type apples. 

b. Click inside the middle key. Type popcorn.

c. Click inside the lower key. Type salad.

8. Add text labels to the keys in the rightmost
column:

a. Click inside the key in the top right-hand
corner of the overlay. Type Read.

b. Click inside the key in the lower right-hand
corner of the overlay. Type Delete. 

What you’ve learned: How to select a font and size.
How to type text in keys to create a text label.

Adding text to keys

Text added to all keys

Note

Select Tool button

Text Tool button
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Part 6: Adding Pictures to Keys
Many IntelliKeys users respond better to pictures than
text (for instance, some students use graphics to help
decode words). The next steps teach you how to
access the Overlay Maker 3 Picture Library to access
hundreds of graphics that you can add to keys.

1. To add a picture to the “I like” key:

a. Click the Select Tool and click the “I like” key
(to select the key). 

b. Click the Picture Library button on the
Standard Toolbar. The Picture Library dialog
box displays.

c. Notice the Picture Library includes a search
function (at the bottom left of this dialog box)
that can help you find a desired picture. 

Select the Begin with option. Type Yes to
show a selection of Yes-related pictures. 

d. Select the picture of the boy’s face giving a
thumbs up. Click Insert. The picture inserts
into the selected key (i.e., the I like key).

Notice that the picture is inserted below the
text. This strategy ensures that when a student
goes to select the key, their hand does not
obscure the text. 

2. Repeat the procedure used in step 1 to add a No-
related picture from the Picture Library to the “I
don’t like” key. Insert the picture of the boy giving
the thumbs down.

3. Repeat the procedure used in step 1 to add apple,
popcorn, and salad pictures to the “apples,”
“popcorn,” and “salad” keys. If there is a choice of
similar pictures, select one.

Selecting a category in the Picture Library
dialog box can also help you find a desired
picture.

If you have the Boardmaker 5 program (or a
more recent version) installed on your
computer, you can search for and insert
pictures from your Boardmaker PCS library
using the Picture Library dialog box.

To position a text below a picture on a
selected key: Select the Text Below Picture
option from the Overlay Maker menu.

What you’ve learned: How to add pictures to keys.

A Yes picture selected from the Picture Library

A No picture selected from the Picture Library

Pictures added to keys

Tip

Tip

Tip

Note
The Picture Library will include a
Boardmaker button if Boardmaker 5 
has been installed
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Part 7: Changing the Shape and the
Fill Color of Keys
Changing the shape and color of keys can help a
student visually discriminate between key functions.
Using the next steps you will change the shape and fill
color of the Read and Delete keys.

1. Click the Select Tool. Click the “Read” key. 

2. Click the Shape button on the vertical Standard
Toolbar to display a pull out menu of shapes.
Select the circle. The shape of the Read key will
change from a rectangle to a circle.

3. Click the Fill Color button on the vertical Standard
Toolbar to display a pull out menu of colors and
patterns. Select a color for the “Read” key.

4. Repeat steps 2 and 3 to change the shape and color
of the “Delete” key.

What you’ve learned: How to change the shape and
the fill color of a key.

Part 8: Modifying Key Content
Key content is what a key does (i.e., what happens on-
screen) when the IntelliKeys user presses the key on a
printed overlay. Overlay Maker 3’s default key content
is Same As Text Label. This means that when an
IntelliKeys user presses that key, the text on the key
(i.e., the text label) shows on-screen. 

In this part of the tutorial, you will learn how to modify
the default key content so it puts more than just the
key’s text label on-screen.

To correctly format the beginning of the sentences the
IntelliKeys user will write:

1. Double-click the “I like” key to select it and display
its Properties of Key dialog box. Using this
Properties dialog box, you can edit all the
properties of this key. 

2. Click the Key Content tab. Notice that the key
content is [Same As Text Label]. We will leave that
command, because we want the key to type the
text label (i.e., the words I like) on-screen. 

3. To write a sentence correctly, we need to also type
a blank space after the phrase I like:

a. Insert your cursor directly after the key
content [Same As Text Label.]

Shape choices

Selected key with new shape and new fill color

Key Content tab in Properties of Key dialog box
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If you accidentally delete the action Same
As Text Label, you can add it back in by
selecting Other from the Key Actions drop-
down list. Click Same As Text Label and
click Add.

b. From the Key Actions drop-down list, select
Keyboard Keys. This shows a list of keyboard
commands used for typing. Scroll down the
list and select Space. 

c. Click the Add button to insert this key content
after the default key content.

d. Click OK to close the Properties of Key dialog
box.

4. Repeat steps 1–3 to add a space after the default
key content for the “I don’t like” key.

To correctly format the end of the sentences the
IntelliKeys user will write:

a. Double-click the apples key to select it and
display its Properties of Key dialog box. 

b. Click the Key Content tab. Notice that the
content is [Same As Text Label]. We will leave
that command, because we want the key to
type the word apples on-screen. 

5. To write a sentence correctly, we need to also type
a period and two returns after the word apples (so
that when a child is working in a word processing
program they see a clear delineation between
sentences):

a. Insert your cursor directly after [Same As
Text Label].

b. Type . (a period).

c. From the Key Actions drop-down list, select
Keyboard Keys. Scroll down the list and select
Enter. 

d. Click the Add button twice to add two
Enter/Return commands to the key content. 

[Enter] performs the same function as
Enter (Windows) or Return (Macintosh).

6. Repeat step 5 to modify the key content for the
“popcorn” and “salad” keys.

What you’ve learned: How to a modify the default
key content.

So that the sentence types correctly on-screen, it 
is necessary to add a [Space] to the key content

So that the sentence types correctly on-screen,
it is necessary to add a period (.) and 

[Enter][Enter] to the key content

Tip

Note
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Part 9: Customizing Key Content for
a Word Processing Activity
When using the Writing Sentence overlay with a
talking word processing program (e.g., Classroom
Suite Writing mode) it is helpful to provide the
IntelliKeys user with keys that do more than type on-
screen:

1. Set the “Read” key to read the sentence the
student just wrote. (This provides important
auditory feedback so that a beginning reader or
writer has an opportunity to self-correct his or her
work.)

a. Double-click the “Read” key to display its
Properties dialog box. Select the Key Content
tab. Delete the [Same As Text Label] action in
the Content box. 

b. Select Control (Windows) or Command
(Macintosh) from the Keyboard Keys list.
Click Add.

c. Insert your cursor after [Control] or
[Command] and type rs. 

[Ctrl]+rs and [Command]+rs are the Writing
mode keyboard shortcuts used for reading a
sentence. 

d. Select OK to close the Properties dialog box.

2. Set the “Delete” key to delete a whole word at a
time. (This makes it easier for a student with
physical challenges to delete mistakes.)

a. Double-click on the “Delete” key. Select the
Key Content tab. Delete the [Same As Text
Label] action in the Content box. 

b. Select Control (Windows) or Command
(Macintosh) from the Keyboard Keys list.
Click Add.

c. Insert your cursor after [Control] or
[Command] and type dw. [Ctrl]+dw and
[Command]+dw are the Writing mode
keyboard shortcuts used to delete a word.

3. Some IntelliKeys users have difficulty quickly
lifting their finger off a key, and as a result, the key
stays selected. In the case of the “Delete” key, this
could be problematic—the student may
accidentally delete an entire sentence. In this step
you will add Non-Repeating to the content of the

Replacing the default key content for the 
Read key with Read Sentence action

Replacing the default key content for the 
delete key with Delete Word action
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“Delete key.” Non-Repeating stops a key action
after the initial press.

a. From the Key Actions drop-down list, select
Other.

b. Select Non Repeating. Click Add. 

c. Select OK to close the Properties dialog box.

What you’ve learned: How to change the key content
to match commands in a software program.

Part 10: Adding a Background Color
to the Overlay
1. Click the Background Color button on the vertical

Standard Toolbar to display a pull out menu of
colors and patterns. 

2. Select a color.

3. Select a pattern. Selecting a pattern along with a
color, rather than a solid color, saves ink when
printing the finished overlay using a color printer.

What you’ve learned: How to add a background
color and pattern to an overlay.

You have completed the Writing Sentences overlay. If
you haven’t already done so, save your work.

Part 11: Printing an Overlay
1. From the File menu, select Page Setup.

2. Select Legal for the Paper size and Landscape for
the orientation. 

3. Click OK to close the Page Setup dialog box.

4. Click the Print button on the Standard Toolbar.
Check the settings in the print dialog box and print
the overlay.

5. Trim the printed overlay along the cut lines so it is
the correct size.

6. Place the printed overlay on an IntelliKeys.

7. Make sure your IntelliKeys is connected to your
computer and functional.

What you’ve learned: How to set printing options and
print an overlay.

Background color and pattern choices

Background color added to overlay

A Page Setup dialog box (Macintosh)

Print button
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Part 12: Trying Your Overlay with
Writing Mode
This overlay is intended to be used with a talking word
processor, such as Classroom Suite’s Writing mode. 

1. So you can easily access the overlay when using it
with Writing mode, save your overlay in the
Classroom Suite Overlays folder:

a. From the File menu, select Save As. The Save
As dialog box displays. (Click the blue Back
button to show the contents of the main
Overlays folder, if necessary.)

b. Click the Shortcut to Classroom Suite
Overlays folder to open that folder.

c. Click Save to store your overlay in the
Classroom Suite Overlays folder.

2. Minimize or hide the Overlay Maker 3 window. Do
not quit the program!

3. Launch Classroom Suite:

• Windows user: From the Start Menu, select
Programs, IntelliTools Software, Classroom
Suite, Classroom Suite.

• Macintosh user: Double-click the Classroom
Suite icon on your desktop.

4. Sign-in as an administrator or as a teacher.

5. At the Home Screen, select and open the Creativity
Tools folder. Select and open Writing Tools to
display a new word processing document.

6. From the Options menu, select IntelliKeys. 

7. Select Send Overlay.... The Open dialog box
displays, showing a folder that contains overlay
files.

8. Navigate to and open the Writing Sentences
overlay you saved in step 1.

9. A message box displays, asking if you want to
attach this overlay to the document. Click No. The
Writing Sentences overlay is sent to IntelliKeys.

10. Build sentences by pressing keys on the overlay.
Be sure to try the “Read” and “Delete” keys.

What you’ve learned: How to send an overlay using
Classroom Suite.

Save As dialog box showing contents of
IntelliTools Classroom Suite Overlays folder

Select Send Overlay... from the
Classroom Suite Options menu

Selecting a saved overlay to send
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Part 13: Using Your Overlay with
Other Word Processors
If you are using a word processor program other than
Classroom Suite:

1. Place the printed Write Sentences overlay on
IntelliKeys.

2. Make sure your IntelliKeys is connected to your
computer and functional.

3. Using Overlay Maker 3, open the Writing
Sentences overlay. 

4. Click the Send Overlay button on the Standard
Toolbar.

5. Launch your word processing program and try the
overlay.

The Read and Delete keys use key content for
Classroom Suite and may not work the same
with other programs.

Congratulations! You have successfully created an
overlay using Overlay Maker 3 and tried it.

To learn more program features, try the Intermediate
Tutorial – Modifying an Overlay.

Overlay placed on IntelliKeys

Finished Writing Sentences overlay

Send Overlay button

Note
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Notes:
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Part 1: Launching Overlay Maker 3
If it is not already launched, launch Overlay Maker 3.

Windows users:

From the Start Menu, select Programs, IntelliTools
Software, Overlay Maker 3, Overlay Maker 3.

Macintosh users:

Double-click the Overlay Maker 3 icon located on your
desktop.

Part 2: Opening and Saving An
Overlay Activity Kit Overlay
After launching, the Navigation Screen displays.

Notice the New button is selected and the contents of
the New folder are displayed in the navigation window
(the area in the center of the screen). 

The New folder contains two folders (Overlay Activity
Kits and Predesigned Layouts) and a Blank Overlay.

1. Click the Overlay Activity Kits folder to open it. 

The four subfolders in the Overlay Activity Kits
folder (Braille Access, Language Arts, Math, and
Off-Computer Activities) contain Overlay Activity
kits. Using these kits, you can easily make your
own IntelliTools Classroom Suite activities and
overlays.

Introduction
Many predesigned overlays are installed with Overlay Maker 3. These overlays are designed to be used with
Language Arts and Math activities. However, not all overlays meet the specific access needs of all students.
This tutorial will teach you how to modify a predesigned overlay.

About This Tutorial
It is recommended that you complete the Beginners Tutorial before beginning the Intermediate
Tutorial. 

For this tutorial, you will modify an overlay for an IntelliKeys user (e.g., a child learning to write sentences)
who can access a limited number of keys (in this scenario, five keys). You have chosen the 9-hole Keyguard
for Custom Overlays, as it works well for this student. You really like the Journal Writing activities but want
to simplify the overlay so it is more appropriate for this student.

In the process of modifying the Journal Writing L1 overlay, you will learn how to delete unwanted keys,
match key layout to a custom keyguard, modify the appearance of keys, modify the background, and view
your overlay three different ways. 

For assistance with program features, select Help from the Help menu or click a ? button.

After completing this tutorial, your 
overlay will look similar to this

Navigation Screen showing contents of 
Overlay Activity Kits folder

Tip

Note
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2. Select and open the Language Arts folder to see
kits designed for this curriculum area.

3. Select and open the Journal Writing folder. This
Overlay Activity kit contains:

• A step by step tutorial (as a PDF file).

• A shortcut (or link) that opens an IntelliTools
Classroom Suite sample activity.

• 4 Overlay Maker 3 overlays that can be used
with the sample activity.

• 1 overlay template.

4. Select and open the Journal Writing L1 (Level 1)
overlay. The overlay displays.

5. Click the Save button on the horizontal Standard
Toolbar. The Save As dialog window displays. 

6. Rename the overlay 9 Key Journal. 

7. Select the the My Overlays folder. 

8. Click Save.

What you’ve learned: How to open one of the
Overlay Activity Kit overlays and save it using a new
name in the My Overlays folder.

Part 3: Previewing a Keyguard Mask
One of the features of Overlay Maker 3 is the keyguard
mask preview. This feature enables you to position
keys on an overlay so the keys match one of the plastic
snap-in Keyguards for Custom Overlays.

1. From the View menu, select Show Keyguard
Mask. 

2. Select 9 Holes. A Keyguard Mask shows on top of
the 9 Key Journal overlay. 

3. Notice the holes in this mask are arranged in a 3
by 3 layout.

In the following parts of this tutorial, you will position
five keys in this nine hole mask. Keys will be arranged
in a 1–1–3 pattern—two keys in the left column and
two keys in the middle column will remain empty.

Keyguards for Custom Overlays are sold by
IntelliTools. Visit the IntelliTools Web site:
www.intellitools.com for more details.

What you’ve learned: How to preview a keyguard
mask on an overlay.

Journal Writing folder contents

Journal Writing L1 overlay saved as 9 Key Journal

9 Hole
keyguard mask
showing on a
blank overlay

Note

9 Hole keyguard mask showing on overlay



2503: Intermediate Tutorial – Modifying an Overlay

Part 4: Deleting Unnecessary Keys
Now you will modify the predesigned overlay so the
student can use it to write one sentence only. You will
keep keys that allow the student to write about what
he/she did today. You will delete unnecessary keys. 

Delete Procedure
1. Notice that by default, the Key Tool (on the

vertical Standard Toolbar) is selected when you
open Overlay Maker 3. 

If you are not sure what a toolbar button
does, hold your mouse over the button to
see a tooltip.

2. Click the Select Tool button.

3. Select the the Read Sentence and Advance key on
the top left corner of the overlay. It is labeled “It is
cool.”

4. Press the Delete or Backspace key on your
standard keyboard. 

5. Use the delete procedure to remove all the
“toolbar” keys on the top row of the overlay.

To select multiple keys using the Select
Tool, press the mouse button and drag the
Select Tool around all of the keys. 

6. Using the Select Tool, click the rectangular frame
that surrounded the top row of keys and delete it. 

7. Use the delete procedure to remove the three keys
on the right side of the overlay—the “I had,” “a
good day,” and “a bad day” keys.

8. Use the delete procedure to remove three of the
six keys that describe the day’s activity— the
“played a game,” “rode the bus,” and “cooked”
keys.

Keep the other three key choices—“played
sports,” “worked hard,” and “played with
friends”—so five keys remain on the overlay.

What you’ve learned: How to delete unwanted keys
and a frame.

Top row of “toolbar” keys on overlay deleted

More overlay keys deleted

Five keys remain on the overlay

Tip

Tip

Select Tool button
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Part 5: Repositioning and Resizing
Keys to Fit the Keyguard Mask
1. Select the “played sports” key. Drag it into the

upper hole of the mask’s righthand column. 

2. Select the “worked hard” key. Drag it into the
center hole of the mask’s righthand column. 

3. Select the “played with friends” key. Drag it into
the lower hole of the mask’s righthand column.

4. Select the “Today” key. Drag it into the center hole
of the keyguard mask’s lefthand column.

5. Select the ”I” key. Drag it into the center hole of
the keyguard mask’s middle column.  

6. To resize the keys to fit the holes in the mask:

a. Select a key. Notice the resizing handles
(black squares on the border of the key). 

b. Grab a resizing handle and drag the cursor in
the direction of the arrows to make the key
larger or smaller.

7. Using View menu options, hide the Grid Lines
(uncheck) and the keyguard mask (select None).

What you’ve learned: How to reposition keys to fit
the keyguard mask.

Part 6: Modifying Key Appearance
Overlay Maker 3 enables you to modify the appearance
of keys to best suit the needs of the IntelliKeys user.
You can choose from a variety of key colors, shapes,
and styles. 

1. Double-click the “Today” key to select and open its
Properties of Key dialog box. Click the
Appearance tab. 

2. Notice that there are two main appearance choices
on the lower section of this tab—Shape or Key
Style. 

3. Click Key Style. Scroll through the listings in key
style list box and select Blue Barrel. Click Apply to
preview the selected key style. Click OK to close
the Properties of Key dialog box.

4. Repeat step 3 to apply the same Blue Barrel key
style to the other four keys on the overlay.

What you’ve learned: How to modify the appearance
of a key using a Key Style option.

Keys repositioned and resized to fit keyguard mask

Selecting a Key Style

New key style selected for keys
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Part 7: Modifying a Key Picture
A picture on a key can easily be modified or switched.

1. Double-click the “played sports” key to select and
open the Properties of Key dialog box. Click the
Picture tab if it is not already displayed. 

2. Notice the picture editing toolbar above the
picture preview box. The four editing buttons on
the right side of the toolbar enable you to flip the
graphic horizontally or vertically, or rotate the
graphic clockwise or counterclockwise. Click
these buttons to flip and rotate the basketball
picture.

3. (Optional) To switch the basketball picture, click
the Insert Picture from Library button on the
editing toolbar. Using the Picture Library dialog
box, select and insert another picture. Or click
Insert Picture from File to use your own pictures
(e.g., from the Internet, a clip art collection, a
digital photo, etc.).

The Overlay Maker 3 Picture Library
includes an expanded collection of pictures. 

4. Click OK to close the Properties dialog box.

What you’ve learned: How to modify the appearance
of a key picture.

Part 8: Modifying the Overlay’s
Background
Overlay Maker 3 allows you to edit the background
color and pattern of an overlay. Selecting a pattern for
the background reduces the ink required when
printing overlays on a color printer.

1. Using the Select Tool, click the rectangular frame
that surrounded the original top row of keys and
delete it (if you didn’t already remove it when the
keys were deleted).

2. Click the Background Color button (on the
vertical Standard Toolbar) to display a selection of
colors and patterns.

3. Select a background color that contrasts with the
Blue Barrel key style (e.g., yellow). 

4. Also select a background pattern. 

What you’ve learned: How to change the overlay’s
background color and pattern.

Basketball key picture flipped

Selecting a new picture for the key

Overlay with new background color and pattern

Note
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Part 9: Modifying the Switch Content
In addition to overlay users, IntelliKeys provides
access to the computer for people using switches.
IntelliKeys has two built-in, programmable switch
ports along the side of the keyboard. When modifying
an overlay, the switch settings (i.e., the switch content)
can be modified to best suit the needs of a switch user.

1. Click the Edit Switches button (on the vertical
Standard Toolbar).

2. Notice the existing switch settings. To change
these settings, make a selection from the Choose
Preset drop-down list box. Select a different
setting from the list.

3. Click OK to close this dialog box.

What you’ve learned: How to customize switch
settings.

Part 10: Changing the Overlay View
Overlay Maker 3 enables you to preview the
appearance of your overlay to show how it will look
when it is placed on an IntelliKeys.

1. Click the Cycle Views button (on the vertical
Standard Toolbar).

2. Click the button three times to cycle through the
three different viewing options (Fit to Window,
Preview in IntelliKeys, and View Actual Size).
Notice that one option shows the overlay on the
IntelliKeys keyboard.

What you’ve learned: How to use the Cycle Views
button.

Part 11: Printing Your Overlay
1. From the File menu, select Page Setup.

2. Select Legal for the Paper size and Landscape for
the orientation. 

3. Click OK to close the Page Setup dialog box.

4. Click the Print button on the Standard Toolbar.
Check the settings in the print dialog box and print
the overlay.

5. Trim the printed overlay along the cut lines so it is
the correct size.

6. Place the printed overlay on an IntelliKeys.

Edit Content of Switches dialog box

A different view selected

Cycle Views button

Print button

Edit Switches button
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Part 12: Trying Your Overlay with the
Journal Writing Activity
This overlay is intended to be used with a talking word
processor, such as IntelliTools’ IntelliTalk 3. 

1. So you can easily access the overlay when using it
with an IntelliTalk 3 activity, save your overlay in
the IntelliTools Classroom Suite Overlays folder
(rather than in the Overlay Maker 3 Overlays
folder):

a. From the File menu, select Save As. The Save
As dialog box displays. (Click the blue Back
button to show the contents of the main
Overlays folder, if necessary.)

b. Click the Shortcut to IntelliTools Classroom
Suite Overlays folder to open that folder.

c. Click Save.

2. To open a the Journal Writing activity:

a. From the Overlay Maker 3 File menu, select
Open. 

b. Click the New button. Select and open the
Overlay Activity Kits folder. Select and open
the Language Arts subfolder. Select and open
the Journal Writing subfolder.

c. Click Shortcut to Journal Writing Activity. A
message box displays to confirm that you are
about to launch IntelliTools Classroom Suite.
Click Yes. If prompted, sign in. The Journal
Writing activity opens.

3. Attach the modified overlay to this activity:

a. From the Options menu, select IntelliKeys. 

b. Select Send Overlay.... The Open dialog box
displays.

c. Navigate to and open the 9 Hole Journal
overlay you saved in step 1.

d. A message box asks if you want to attach the
overlay? Click Yes. The overlay is attached to
the current document and sent to IntelliKeys.

4. (Optional) If you have a 9 Key Custom Keyguard,
place it over the IntelliKeys overlay. Use the
overlay to construct sentences on-screen. Notice
that as you build a sentence, the software program
reads the sentences aloud. This provides auditory
and visual support for early writers.

Saving the 9 Key Journal overlay into the
IntelliTools Classroom Suite Overlays folder

Shortcut launches IntelliTools Classroom Suite

Sending an overlay from the Journal Writing activity
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Part 13: Creating a Template
(Optional)
After creating an overlay that works well for an
IntelliKeys user, it is useful to save the layout of the
overlay without the activity-specific text or pictures.
This new overlay file can be used as the template for
writing-related overlays you might need in the future—
saving you design and authoring time.

1. If the 9 Key Journal overlay is not already
displayed, open the version you saved in the
IntelliTools Classroom Suite Overlays folder.

2. Delete the text on the keys:

a. Click the Text Tool button to select it.

b. Using the Text Tool, click the “Today” key.
Delete the word “Today” from the key. 

c. Repeat steps a and b for the remaining keys.

The Key Content for the keys on this
overlay is [Same As Text Label]. This key
content works with any text you add to a

key— so, in the future, you can change or add text
and the key will still type that text label on-screen. 

3. Delete the pictures on the keys:

a. Choose the Select Tool.

b. Double-click the key with the basketball
picture. A Properties of Key dialog box
displays. The Picture tab shows.

c. Click the Clear button on the editing toolbar. 

d. Repeat steps a–c to delete the pictures on the
two other keys in the righthand column.

4. Save the modified overlay as a template:

a. From the File menu, select Save As Template. 

b. Name your template so you can readily
identify it (e.g., 5 Blue Keys Template). 

c. Save the new template into your My Overlays
folder.

Save As Template protects your overlay file from
being easily overwritten—if you open it, change
it (e.g., add content), and save, you will be

prompted to give the modified file a different name—
thereby preserving the original template.

What you’ve learned: How to create an overlay
template.

Text deleted from keys

Pictures deleted from keys

Saving the overlay as a renamed template 
in the My Overlays folder

Tip

Note

Clear button



3103: Advanced Tutorial – The Parts of a Fish

03: Advanced Tutorial – The Parts of a Fish

Part 1: Launching Overlay Maker 3
If it is not already launched, launch Overlay Maker 3.

Windows users:

From the Start menu, select Programs, IntelliTools
Software, Overlay Maker 3, Overlay Maker 3.

Macintosh users:

Double-click the Overlay Maker 3 icon located on your
desktop.

Part 2: Using a Blank Overlay
1. At the Navigation Screen, click the New button. 

2. Select and open Blank Overlay. 

3. Click the Save button (on the Standard Toolbar).
The Save As dialog box displays. 

4. Notice that the overlay is labeled “untitled.” To
name the overlay, type The Parts of a Fish in the
Save As text box.

5. Select the My Overlays folder and click Save. The
new overlay is saved in the My Overlays folder.

Introduction
The overlay you will make using this tutorial is intended to teach students about fish. Students study the
parts of a fish to develop the understanding that the shape, form and structure of a fish’s parts influences its
lifestyle and behavior. Fish shape and anatomy helps us to discover information about how the fish moves
and where and how it lives. 

The finished overlay is designed to be used with a talking word processor such as Writing mode in
Classroom Suite, so that when a student presses the fish picture on the overlay they hear information about
each of the fish’s body parts. This information can be modified to be appropriate for the child’s age or
cognitive level. For instance, if a student presses the eye, they may hear something as simple as, “That’s the
eye. A fish uses its eyes to see.” Or as complex as, “The eye is a sight organ located on either side of the
fish’s head. Fish have varying levels of acuity.” In addition, the student can use the overlay to take a quiz or

learn some fun facts about fish.

To prepare for this tutorial, you may want to collect several books about fish or search the Internet
for information about fish. You can use this information to customize the overlay you make.

About This Tutorial
It is recommended that you complete the Beginners Tutorial and the Intermediate Tutorial before
beginning the Advanced Tutorial.

In this tutorial, you will be learning many advanced features of Overlay Maker 3. You will learn how to insert
a picture from the Picture Library, fix a picture to the background, create transparent keys, copy and paste
keys, modify key styles, add text boxes, and customize switch settings.

After completing this tutorial, your 
overlay will look similar to this

Blank overlay

Note

Tip



32 Overlay Maker 3 User’s Guide

Part 3: Creating a Background
Parts 3 and 4 of this tutorial will teach you how to
make a custom graphic for the overlay’s background.
This background graphic will be the foundation for the
keys that you add later in the tutorial.

Setting the Background Color
This section will teach how to add a color to the
background (sea blue) and how to customize your
color palette.

1. In the previous tutorial, Intermediate Tutorial –
Modifying an Overlay, you added a background
color to the overlay by clicking the Background
Color button (on the vertical Standard Toolbar). 

Click the Background Color button and notice that
the choice of blue colors is limited and none match
a sea blue color. Instead you will edit the color
palette to create a custom blue color.

2. From the Edit menu, select Background
Properties. Or, right-click on the overlay and select
Background Properties. A Background Properties
dialog box displays.

3. At the bottom of the dialog box is the Background
Color option and a button labeled Change.... Click
the Change button. A Pick Color dialog box
displays.

Customizing Your Color Palette
1. Under Additional Colors, [Ctrl]+click one of the

empty squares. A Color Palette dialog box
displays. (On a Windows computer you may also
have to select Define Custom Colors.) 

2. Select a blue color. 

3. To preview the color you have chosen, click OK to
close the Color Palette dialog box, click OK to
close the Pick Color dialog box, and select Apply
in the Background Properties dialog box. 

If the blue is not just right, click the Change button
and go through the steps to choose another color.

4. Once you have a blue color you like, click OK to
close the Background Properties dialog box.

To add your custom color to the Overlay
Maker 3 color palette, from the Pick Color
dialog box, select Save. 

What you’ve learned: How to edit the color palette.

Background Color button choices

Pick Color dialog box with custom color

Custom background color added to overlay

Tip

Background Color button
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Part 4: Adding a Picture to the
Background
Now you will put a picture of a fish on the overlay and
then add it permanently (i.e., fix it) to the blue
background.

Inserting a Picture From the Picture Library
1. Click the Picture Library button on the Standard

Toolbar. The Picture Library dialog box displays.

2. From the Category drop-down list box, select
Animals. 

3. Select the picture of the brook trout. 

4. Click Insert. A message dialog box displays that
indicates you are pasting the picture of the brook
trout as a picture on the overlay (not on a key). 

5. Click OK.

6. Resize the picture so the brook trout fills at least
most of the overlay. (You want the picture to be
large enough to easily position keys over each of
the fins, the eye, the gills, and the lateral line.)

Leave four rows of space along the bottom of the
overlay. This will allow space for several quiz keys.

To help you design a layout, Overlay Maker 3
enables you to access the area outside the
overlay grid. Be careful not to drag the graphic
of the fish off the grid into this area.

Fixing a Picture to the Background
To make it easier for you to position keys on top of the
fish (when you create keys in a later step), you can
make the fish picture a permanent part of the
background (i.e., fix it to background).

1. Click the fish to select it. 

2. From the View menu, select Advanced Toolbar.

3. Click the Fix to Background button on the
Advanced Toolbar. The fish picture is fixed to the
background of the overlay. Notice that you no
longer can move or resize it.

4. (Optional) From the View menu, deselect Grid
Lines to hide the grid and select Standard Toolbar
to hide the Advanced Toolbar.

What you’ve learned: How to add a picture to the
overlay and fix it to the background.

Selecting a picture from the Picture Library

Resize the picture to fit the overlay

Picture fixed to background (moved behind the grid)

Tip
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Part 5: Creating Keys and Editing
Key Content
In this section you will create keys over each part of
the fish, label these keys, and set key content. The
content of each key can be customized to meet the
cognitive or age level of a student.

Creating New Keys
1. Snap to Grid can make it difficult to position keys

over the irregular-shaped parts of the fish. From
the Overlay Maker menu, deselect Snap to Grid. 

2. Select the Key Tool from the vertical Standard
Toolbar.

3. Using the Key Tool, draw (click and drag) a key on
top of the fish’s dorsal fin (the fin on the top of the
fish).

Setting Key Content
1. Double-click the “dorsal fin” key. A Properties of

Key dialog box displays. 

2. Click the Key Content tab. The key content tells
Overlay Maker 3 what text to type on-screen when
using IntelliKeys with a word processing software
program.

3. Notice the default key content is [Same As Text
Label]. Select and delete this key content.

4. Take a moment to think about the cognitive or
grade level of the student you work with. This will
influence your choice of text on this key. 

• For a cognitively delayed child or a child who
is very young you may want the key to type a
simple sentence (e.g., Fin. Fins are used for
swimming.).

• For an older child you may want the key to
type a more involved explanation (e.g., Dorsal
fin. The dorsal fin is found on the upper
side of the body and used for balance,
steering, and jumping.).

5. Type the text you want typed on-screen in the
Content box (i.e., the new key content). 

6. Click OK to close the Properties of Key dialog box.

7. Using the procedures you used to create a key
over the dorsal fin, position keys over these other
parts of the fish: caudal fin, anal fin, pelvic fin,
pectoral fin, gills, mouth, eye, lateral line.

Key positioned over dorsal fin

New key content typed in Content box

Keys positioned over other parts of the fish
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To help you place keys, see the diagram on
this page or the enlargement of this
diagram on page 42.

8. Using the procedures you used to create new key
content for the dorsal fin key, enter new key
content for the remaining keys on the fish. (If you
are creating an overlay for a cognitively delayed
child you might choose to display the same
message for each key. 

Refer to The Parts of a Fish list to the right
for descriptions that can be used as key
content.

What you’ve learned: How to draw and edit the
properties of a key. How to deselect Snap To Grid. 

Part 6: Making Transparent Keys 
Since you want the IntelliKeys overlay user to see and
press the parts of the fish (the overlay background
picture) and not keys—you don’t want the keys to
show on the overlay—even though the keys are still
there. Therefore, you need to make the keys
transparent.

1. From the Edit menu, choose Select All. All the
keys on the overlay are selected.

To select all the keys in one area, you can
also click and drag the Select Tool around
those keys.

2. From the Edit menu, choose Properties. A
Properties of Keys dialog box displays.

3. Deselect the Show Fill option.

4. Deselect the Show Border or Line option. 

5. Click OK to close the Properties dialog box. 

Notice that the selected keys are now transparent. The
only indication of a selected key is its resizing handles.

What you’ve learned: How to make keys transparent.

The Parts of the Fish 

Note: This information can be used as key
content and to formulate quiz questions.
Anal fin – The fin on the lower side of the body near
the tail. It acts like a rudder for balance and is used
for rapid movement of the fish in water.

Caudal fin – The tail fin. This is the main source of
movement for most fish. It’s like the motor on a boat.
The caudal fin helps the fish to move forward at
great speed.

Dorsal fin – The fin on the upper side of the body.
The dorsal fin is used for balance, steering, and
jumping.

Pectoral fin – Each of the paired fins on either side
of the body, near the head. Pectoral fins are used for
steering.

Pelvic fin – Each of the paired fins on the bottom of
the body. The Pelvic fins are used in slow swimming.
They are sometimes called the ventral fins.

Eye – Sight organs located on the head. Fish have
varying levels of acuity.

Gills – Fleshy organs that are used for breathing.
Water passes through the mouth and over the gills of
the fish. As the water passes over the gills, oxygen
enters the fish’s bloodstream and is carried through
the body.

Lateral line – The lateral line is found on both sides
of the body. It is a sense organ that helps the fish
detect vibrations in the water.

Mouth – The part of the body which the fish uses to
catch food. It is located at the front of the body.

Tip

Tip

Tip

Use this diagram to help you place keys
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Part 7: Creating a Title by Combining
a Picture and a Text Box
The Overlay Maker 3 library includes many fun
graphics that can be included on an overlay for added
interest. In the next parts of this tutorial you will insert
a picture of a hanging sign from the Picture Library
and then create a text box on top of the picture—
making a composite image (i.e., a sign with text).

Inserting a Picture on the Overlay
1. So you don’t add a picture to a key, make sure that

none of the transparent keys are selected on the
overlay (click in the area around the edge of the
overlay to deselect any selected keys). You will
insert a picture on the overlay.

2. Click the Picture Library button on the Standard
Toolbar. The Picture Library dialog box displays.

a. Select the IntelliTools Picture Library option
(if it is not already selected).

b. From the Category drop-down list, select the
Stickers category. 

c. Scroll through the Stickers list to find the
hanging sign picture.

d. Select the hanging sign picture.

e. Click Insert. A dialog box displays asking if
you want to paste this picture on an overlay
and not on a key.

f. Click OK. The picture inserts on the overlay.

3. Using the resizing handles on the sides of this
picture, enlarge it to be approximately 7 grid
squares wide by 4 grid squares tall. (Optional: To
show the grid, select the Grid Lines option from
the View menu.)

4. Drag the graphic of the hanging sign to the top
left-hand corner of the overlay. Position the nail
and wire to hang slightly above the grid area of the
overlay. (The hanger will still show when you print
the overlay, even though it is slightly outside the
grid area.)

What you’ve learned: How to add a picture to
decorate the overlay.

Hanging sign selected from Picture Library

Picture positioned on overlay

Picture positioned slightly above grid

Picture Library button
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Overlapping a Text Box on the Picture
1. Click the Text Tool button on the Standard

Toolbar. 

2. Draw a text box inside the picture of the hanging
sign. An empty text box displays on top of the
picture.

As you insert Overlay Maker 3 objects, they
are automatically placed into a new layer of
the overlay. If you want an object to be

positioned behind or in front of another object,
select the object and click the Bring Forward or
Send Backward buttons on the Advanced Toolbar.

3. From the Font Name drop-down menu, select a
font that is appropriate for your student. Also
select a size (a 36 point font works well). 

4. Click inside the text box and type The Parts of a
Fish. 

5. By default, text boxes are set to be transparent.
Sometimes you want to add color to give higher
contrast for students, other times a color adds
interest. To color a text box:

a. Choose the Select Tool. 

b. Double-click the text box to open the
Properties of Text Box dialog box. 

c. Select (i.e., check) the Show Fill option.

d. Notice that the default fill color is white. This
can be changed by clicking the Change button
(next to Show Fill). The Pick Color dialog box
displays.

e. Choose a new color from the Standard Colors
drop-down list (silver works well as a text box
color). Click OK to close the Pick Colors
dialog box.

If you would like to preview the color you
chose, click Apply in the Properties of Text
Box dialog box. 

6. Click OK to close the Properties of Text Box
dialog box.

7. Resize both the hanging sign picture and the text
box until you like the appearance of both.

What you’ve learned: How to create a text box. How
to modify the appearance of a text box.

Text box on hanging sign picture

Silver selected from Pick Color dialog box

Text box with silver fill color

Tip

Note

Text Tool button
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Part 8: Creating Quiz Keys and Fun
Fish Facts Keys 
In the space along the bottom of the overlay you can
create additional keys such as Quiz keys or Fun Fish
Fact keys.

• Quiz keys. When these keys are pressed, a talking
word processor program (such as Classroom Suite)
asks questions (e.g., What fin is used for balance,
steering, and jumping?). To respond, the
IntelliKeys user presses a part of the fish pictured
on the overlay (i.e., a transparent key).

• Fun Fish Facts keys. When these keys are
pressed, a talking word processor program
provides a fun fact (e.g., Did you know that the
Climbing Perch, a fish native to India, can climb
onto land during dry spells?).

Fun Fish Facts can be found in the column to
the right.

1. Click the Key Tool button on the Standard Toolbar.

2. Draw a key in the lower left-hand corner of the
overlay that measures 4 grid squares wide by 3
grid squares tall. 

3. Notice that the fill color of the key is the same fill
color chosen for the text box you created in the
previous part of this tutorial. You can change the
fill color of a key by selecting the key and clicking
the Fill Color button on the toolbar along the left.

4. Click the Select Tool button. Click the key you just
made to make sure it is selected. From the
Standard Toolbar, click the Copy button. 

5. Click the Paste button to paste another key on
your overlay. Repeat this step to create a total of
five keys.

6. Select a key. Click the the Text Tool button.
Choose a font type, size, and/or style from the
drop-down lists. Click inside the selected key and
type ? (for a quiz question) or Did you know...
(for a Fun Fish Fact).

7. Repeat step 6 to put a text label on each key.

8. Double-click one of the keys you just created.
Select the Key Content tab. Delete the [Same As
Text Label] action and replace it with a quiz
question or a Fun Fish Fact. Do this for each of the
four other keys.

What you’ve learned: How to copy and paste keys.

Fun Fish Facts 

Note: This information can be used as key
content for Fun Fish Facts keys.
• Did you know... There are some fish, such as

salmon, that live in both fresh and salt water.
These fish are born in fresh water but eventually
swim downstream to the ocean. These fish are
called Anadromous.

• Did you know... Some fish have spots on their
tails to confuse predators. A predator thinks they
look like eyes and doesn’t know if he’s looking at
the front or the back end of the fish. By the time
he figures it out the fish has escaped!

• Did you know... Aquarium fish are the most
popular pet in America.

• Did you know... The largest fish is the Whale
Shark weighing about 50,000 pounds.

• Did you know... The Flying Fish has pectoral fins
that act like wings to help it glide through the
air.

• Did you know... The Lanternfish is a deep-sea
dweller that has many light producing organs
along its body, especially on the belly. It uses its
lights to attract prey.

Additional keys added to the overlay

Note
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Part 9: Drawing a Frame
Frames can be added to overlays to create a visual
discrimination between separate areas of the overlay.
In the next steps you will add a frame behind the Quiz
keys or the Fun Fish Facts keys.

1. Click the Shape button and select the rectangular
shape. 

2. Click the Frame Tool on the vertical Standard
Toolbar. Draw a frame around the Quiz/Fun Fish
Facts keys. 

3. Click the Fill Color button and select a fill color for
the frame that contrasts the color of the Quiz/Fun
Fish Facts keys.

What you’ve learned: How to create a frame. How to
modify the appearance of a frame.

Part 10: Reprogramming Switches
Using Overlay Maker 3 
In the next steps you will learn how to reprogram the
switch content so that Switch 1 reads the text on
screen and Switch 2 deletes text if a mistake is made.
This type of switch setting works well in a cooperative
learning situation where one student is using the
IntelliKeys to input text and a switch user edits text.

1. Click the Edit Switches button on the Standard
Toolbar. The Edit Switch Content dialog box
displays. Notice that the default switch settings are
Button Click for both switches.

2. Edit the switch content for Switch One:

a. Click the Edit button next to Switch One. 

b. Delete the actions in the Content box. 

c. From the Key actions drop-down list, select
Keyboard Keys. From the list below, select
Control. Click the Add button.

d. Directly after the control action, type the
letters rs. ([Ctrl]+rs is the keyboard shortcut
for Read Sentence when using IntelliTalk 3.)

e. Select OK to close the Switch 1 Content dialog
box.

Frame with a fill color surrounds keys

Edit Content of Switches dialog box

Frame Tool button

Fill Color button

New switch content for Switch One
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3. Edit the switch content for Switch Two:

a. Click the Edit button next to Switch Two. 

b. Delete the existing actions in the Content box. 

c. From the Keyboard Keys category, add
Control then type the letters ds. (Control+ds is
IntelliTalk 3’s keyboard shortcut for Delete
Sentence.) 

d. From the Key Actions drop-down list select
the Other category. Select Non Repeating and
click Add. (Adding Non Repeating ensures
that the student will not accidentally delete
more than one sentence at a time.)

e. Select OK to close the Switch 2 Content dialog
box.

4. Click OK to close the Edit Content of Switches
dialog box.

What you’ve learned: How to customize switch
settings.

Congratulations! You have completed The Parts of a
Fish overlay. 

If you haven’t already done so, save your work in the
My Overlays folder.

Part 11: Printing Your Overlay
1. From the File menu, select Page Setup.

2. Select Legal for the Paper size and Landscape for
the orientation. 

3. Click OK to close the Page Setup dialog box.

4. Click the Print button on the Standard Toolbar.
Check the settings in the print dialog box and print
the overlay.

5. Trim the printed overlay along the cut lines so it is
the correct size.

6. Place the printed overlay on an IntelliKeys.

What you’ve learned: How to check the Page Setup
dialog box options and print the overlay.

New switch content

A Page Setup dialog box (Macintosh)

New switch content for Switch Two

Print button
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Part 12: Trying The Parts of a Fish
Overlay
This overlay is intended to be used with a talking word
processor, such as Writing Mode in Classroom Suite. 

1. So you can easily access the overlay when using it
with a Writing mode activity, save your overlay in
the Classroom Suite Overlays folder (rather than
in the Overlay Maker 3 Overlays folder):

a. From the File menu, select Save As. The Save
As dialog box displays. (Click the blue Back
button to show the contents of the main
Overlays folder, if necessary.)

b. Click the Shortcut to IntelliTools Classroom
Suite Overlays folder to open that folder.

c. Click Save to store your overlay in the
IntelliTools Classroom Suite Overlays folder.

2. Launch Classroom Suite:

• Windows user: From the Start Menu, select
Programs, IntelliTools Software, Classroom
Suite, Classroom Suite.

• Macintosh user: Double-click the Classroom
Suite icon on your desktop.

3. Sign-in as an administrator or as a teacher. 

4. At the Home Screen, select and open the Creativity
Tools folder. Select Writing Tools to display a new
word processing document.

5. Send the overlay:

a. From the Options menu, select IntelliKeys. 

b. Select Send Overlay. A dialog box displays
showing the contents of the IntelliTools
Classroom Suite Overlays folder. 

c. Select and open The Parts of a Fish overlay.
Do not attach the overlay.

6. Place the printed overlay on IntelliKeys. 

7. Try the overlay.

What you’ve learned: How to use your overlay with
Writing mode in Classroom Suite.

The finished overlay

Save As dialog box showing contents of
IntelliTools Classroom Suite folder

The Parts of a Fish overlay in an IntelliKeys
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Part 13: Using The Fish Overlay with
Other Software Programs
You may own a talking word processor other than
Classroom Suite. The Parts of a Fish overlay, and other
overlays you create, can be used with other software
programs. You may have to re-edit the switch content
to match the keyboard shortcuts associated with the
read and delete functions of your software program. 

To determine keyboard shortcuts in other
software programs, open the program and
check each menu. Keyboard shortcuts are often
listed next to menu listings.

To use this overlay with another word processor:

1. Click the Send Overlay button on the Overlay
Maker 3 Standard Toolbar. Place the overlay on
IntelliKeys.

2. Launch your software program.

3. Try the overlay.

What you’ve learned: How to use your overlay with
another software program.

Keyboard shortcuts listed next to menu
options in a popular page layout program

Tip

Send Overlay button

Credit for the fish photo used in this tutorial: U.S. Fish and Wildlife Service. Photo by Duane Raver.

lateral line
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After the program launches, the Navigation Screen displays.

Navigation Screen: Contents
The Overlay Maker 3 Navigation Screen includes:

Directory Path
Shows hierarchy of currently open folders and files. Click the Back and Forward arrow
buttons (to the left of the directory path) to navigate the path. 

View Options Toolbar
Click the buttons on this toolbar to choose the way that folders and files show in the
navigation window. 

Navigation Window
The area in the center of the screen that shows the contents of the selected folder.

Overlays Button
Click to navigate to the Overlays folder. This folder holds saved overlays in the My
Overlays subfolder and the (Shortcut to) IntelliTools Classroom Suite Overlays folder.

New Button
Click to navigate to New folder. This folder holds two sub-folders—Predesigned Layouts
and Overlay Activity Kits— and a new (blank) overlay. The Predesigned Layouts folder
includes a useful selection of premade overlays. The Overlay Activity Kits folder provides
everything you need to create your own classroom activities with matching overlays. The
blank overlay is used to make new overlays from scratch.

Desktop Button
Click to open a navigation dialog box that you can use to open folders and files stored on
your computer (or computer network). 

04: Using the Navigation Screen

Navigation Screen showing contents of New folder

Navigation
window

Directory
Path

Overlays button

New button

Desktop button

File/Folder
management
buttons

Open 
button

Quit button

View Options
toolbar



You can only
manage the files
and folders in the

Overlays folder (not
those in the New folder).

You must have
List View selected
from the View

Options toolbar to use
File/Folder management
buttons. 
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File/Folder Management Buttons
These buttons relate to the folders and files that are currently open or selected (as shown
in the navigation window or by the directory path). 

• New Folder – Click to display the New Folder dialog box. Use this dialog box to create
a new subfolder. The new folder is created in the folder that is currently open.

• Properties – Click to display the Edit Folder Properties dialog box or the Edit File
Properties dialog box. Use these dialog boxes to rename the folder or file that is
currently selected. You can also add or edit the picture icon on a selected folder or file.

• Move – Click to display the Move File or Folder dialog box. Use this dialog box to
move the folder or file that is currently selected to another folder.

• Delete – Click to delete the folder or file that is currently selected.

Quit Button
Click to exit Overlay Maker 3. 

Open Button
Click this button to open the folder or the file that is selected (highlighted) in the
Navigation Screen’s navigation window. 

Help Button
Click to display the Help dialog box.

Note

Note
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New Folder Contents
Clicking the New button on the Navigation Screen displays the contents of the New folder
in the navigation window. The New folder contains these folders:

Overlay Activity Kits Folder
• Braille Access folder 

Braille Alphabet folder

Braille Keyboard folder

BrailleNote GPS folder

• Language Arts folder

Circle Time folder

Exploring Toys folder

I Can Write folder

Journal Writing folder

Making Lists folder

Preposition Game folder

Simple Sentences folder

• Math folder

Exploring Toys folder

Patterns folder

Preposition Game folder

• Off-Computer Activities folder 

Board Games folder

Cards folder

Dominoes folder

Lotto Game folder

Predesigned Layouts Folder
• Alternative Keyboards folder (overlays for special use)

• Custom Keyguards folder (blank overlays with keys positioned for keyguard layouts)

• Scanning folder (overlays for scanners)

• Standard Overlays folder (overlays for IntelliKeys Classic and IntelliKeys USB)

IntelliKeys Classic folder (overlays shipped with IntelliKeys Classic)

IntelliKeys USB folder (overlays shipped with IntelliKeys USB)

Blank Overlay 
Opens a new, untitled overlay, ready to be modified.

Navigation Screen showing 
contents of New folder



Overlay Folder Contents
Clicking the Overlays button on the Navigation Screen displays the contents of the
Overlays folder in the navigation window. The Overlays folder contains a subfolder labeled
My Overlays and a shortcut to the Overlays folder in the IntelliTools Classroom Suite
program.

My Overlays Folder
The My Overlays folder contains saved
overlay files.

Shortcut to IntelliTools
Classroom Suite Overlays
Folder
Selecting this shortcut opens the
Overlays folder in the IntelliTools
Classroom Suite program folder. 

The IntelliTools Classroom Suite
Overlays folder contains:

• Overlay files (files installed with
IntelliTools Classroom Suite for use with IntelliTools Classroom Suite documents).

• Installed with OM3 folder (contains files installed with Overlay Maker 3 for use with
IntelliTools Classroom Suite documents).

Clicking a
shortcut launches
IntelliTools

Classroom Suite or
IntelliTools Classroom
Suite Player.
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Managing Folders and Files
in the Overlays Folder
You can manage subfolders and files in
the Overlays folder using the File/Folder
management buttons—New Folder,
Properties, Move, and Delete. These
buttons are found on the right side of the
Navigation Screen. 

The File/Folder management buttons
relate to the folders and files that are
currently open or selected, as shown in
the navigation window or by the
directory path. These buttons are grayed
out when unavailable.

Creating New Folders and Editing Folder Properties
How do I create a new folder (i.e., a subfolder) in an existing Overlays folder?

1. At the Navigation Screen, click the Overlays button. Navigate to and open the folder in
which you want to create a subfolder.

2. Click the List View button on the View Options toolbar.

3. Click the New Folder button to display the New Folder dialog box. Use this dialog box
to name the new folder. Click OK. The new folder is created in the folder that is
currently open.

How do I rename a folder and/or add a picture to an Overlays folder icon?

1. At the Navigation Screen, click the Overlays button. Select the
folder that you want to rename and/or to which you want to
add a picture icon.

2. Click the List View button on the View Options toolbar.

3. Click the Properties button to display the Edit Folder
Properties dialog box. Use this dialog box to rename, or edit
the picture of the folder that is currently selected.

4. Click OK.

The File/Folder
management
buttons only work
when the

Overlays folder is
displayed and List View
is selected from the View
Options toolbar. (You
can’t add or edit the
folders and files in the
New folder.)
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Editing File Properties
How do I rename, add a picture, or add a note to a file in the Overlays folder?

1. At the Navigation Screen, click the Overlays button. Navigate to and select the file that
you want to rename and/or to which you want to add a picture icon and or note.

2. Click the List View button on the View Options toolbar.

3. Click the Properties button to display the Edit File Properties dialog box. Use this
dialog box to rename, edit the picture of, or add a note to the file that is currently
selected.

4. Click OK.

Moving and Deleting Folders and Files
How do I move a file or folder from one Overlays folder to another?

1. At the Navigation Screen, click the Overlays button. Navigate to and select the file that
you want to move.

2. Click the List View button on the View Options toolbar. 

3. Click the Move button to display the Move File or Folder dialog box. Use this dialog
box to move the folder or file that is currently selected to another location in the
Overlays folder.

4. Select the destination folder.

5. Click OK.

How do I delete a file or folder?

1. At the Navigation Screen, click the Overlay button. Navigate to and select the file that
you want to delete.

2. Click the List View button on the View Options toolbar. 

3. Click the Delete button to delete the folder or file that is currently selected. A Confirm
delete dialog box displays.

4. Click Yes to delete the selected file or folder.

Quitting Overlay Maker 3
At the Navigation Screen, click the Quit button.



Navigation Screen: FAQ
Here are some frequently asked questions about using the Navigation Screen:

How do I choose the way folders and files show in the navigation window?

Click the buttons on the View Options toolbar to choose the way that folders and files show
in the window. 

• Use the three buttons on the left of the toolbar to choose icon view or list view. 

• Use the two buttons on the right of the toolbar to resize icons or listings.

How do I navigate to a blank overlay?

1. Click the New button.

2. Select and open the Blank Overlay. A new (blank) overlay displays.

How do I navigate to a selection of predesigned overlay layouts?

1. Click the New button.

2. Select and open the Predesigned Layouts folder.

3. Select and open the desired subfolder.

How do I navigate to an Overlay Maker Overlay Activity kit?

1. Click the New button.

2. Select and open the Overlay Activity Kits folder.

3. Select and open the desired subfolder(s). 

What does an Overlay Activity Kit contain?

Overlay Activity kits typically contain: 

• A step by step tutorial. (You must have Adobe Reader installed to view this
printable PDF file.)

• Overlays and templates that can be modified to create new overlays.

• Shortcuts to activities and shortcuts to templates that can be modified to create
new activities. (Opening an activity automatically launches IntelliTools Classroom
Suite.)

How do I navigate to the contents of my computer (or computer network)?

Click the Desktop button to display a navigation dialog box that shows the contents of your
computer (or computer network).

How do I use Overlay Maker 3 to view the contents of the IntelliTools Classroom
Suite Overlays folder?

1. Launch Overlay Maker 3.

2. From the Navigation Screen, click the Overlays button.

3. Select the Shortcut to IntelliTools Classroom Suite Overlays folder.

4. Open the Installed with OM3 subfolder.

5. Select and open the desired file.

You must have
Classroom Suite
already installed

on your system, so that
you can have access to
Classroom Suite
curriculum activities.
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How do I open a selection displayed in the navigation window?

Depending on which Viewing Option is selected, click or double-click the desired icon or
listing to open it. Or select the desired icon or listing and then click Open.

I see the word shortcut used on folder and file names. What is a shortcut?

You can use shortcuts to access folders and files in the IntelliTools Classroom Suite
program. Selecting a shortcut automatically launches IntelliTools Classroom Suite or
IntelliTools Classroom Suite Player and opens the selected folder or file.

How do I get the buttons on the right side of the Navigation Screen to work?

1. Click the Overlays button—you can only manage files and folders in this folder.

2. Click the List View button on the View Options toolbar—you can only manage files and
folders in the Overlays folder when List view is selected.
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Finding and Opening Overlays
To find an overlay file, it is useful to know what type of file it is—a new file or a file that you
have opened and saved. If you are looking for a saved overlay, it is also useful to know if the
overlay file was saved using Overlay Maker 3 or IntelliTools Classroom Suite’s Make Overlay
feature. Using Overlay Maker 3, you can save to an Overlays folder in either program—
Overlay Maker 3 or IntelliTools Classroom Suite. Using IntelliTools Classroom Suite’s Make
Overlay feature, you would save to the IntelliTools Classroom Suite Overlays folder.

How do I find and open an overlay file using the Overlay Maker 3 Navigation
Screen?

1. Click the desired button on the left side of the Navigation Screen. 

• Click the Overlays button to show saved overlays in the navigation window.

• Click the New button to show a selection of predesigned overlays (organized in
subfolders) in the navigation window.

• Click the Desktop button to find files stored on your computer or network.

2. Once you find a desired file, select it and click Open.

You can also find overlay files by navigating to, and opening the Overlay Maker 3
program folder (in the IntelliTools folder on your hard drive or network). Search the
Overlay folder for the desired file.

Finding and Opening Overlays: Saved Using Overlay Maker 3
How do I find and open an overlay file I saved using Overlay Maker 3?

1. From the Navigation Screen, click the Overlays button. 

2. Select and open the My Overlays subfolder or the Shortcut to IntelliTools Classroom
Suite Overlays subfolder.

3. Navigate to and select the desired file.

4. Click Open.

Finding and Opening Overlays: Located Elsewhere on Your Computer
How do I find and open an Overlay Maker 3 overlay file I saved to my desktop or
elsewhere on my computer (or network)?

1. From the Navigation Screen, click the Desktop button. An Open dialog box displays. 

2. Navigate to and select the desired file using standard computer navigation procedures.

3. Click Open.

How do I find and open an Overlay Maker 2 overlay file located elsewhere on my
computer (or network)?

1. From the Navigation Screen, click the Desktop button. An Open dialog box displays. 

2. Navigate to and select the desired file using standard computer navigation procedures.

3. Click Open.

How do I find and open an Overlay Maker 2 group overlay file located elsewhere
on my computer (or network)?

.

Overlay Maker 3
files have the
extension .omc,

.oms, and .omt.
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1. Select Open Group... from the File menu. An Open dialog box displays. 

2. Navigate to and select the desired file using standard computer navigation procedures.

3. Click Open.

How do I find and open an overlay file created on a different platform?

1. From the Navigation Screen, click the Desktop button. An Open dialog box displays. 

2. Navigate to and select the desired file.

3. Click Open.

Finding and Opening Overlays: Saved Using Make Overlay
How do I find and open an overlay file I saved when I was using IntelliTools
Classroom Suite’s Make Overlay feature?

There are three ways to find an Overlay Maker 3 file that was created using IntelliTools
Classroom Suite’s Make Overlay feature:

• Method 1 – Using IntelliTools Classroom Suite IntelliKeys menu options.

1. Launch IntelliTools Classroom Suite and open a document (e.g., the activity used
with the overlay).

2. From the Options menu, select IntelliKeys.

3. Select Attach/Edit overlay. 

4. Click Attach.... An Open dialog box displays, showing the contents of IntelliTools
Classroom Suite’s Overlay folder.

5. Select and open the desired overlay.

• Method 2 – Using Overlay Maker 3 to show the contents of the IntelliTools Classroom
Suite Overlays folder.

1. Launch Overlay Maker 3.

2. From the Navigation Screen, click the Overlays button.

3. Select the Shortcut to IntelliTools Classroom Suite Overlays folder.

4. Open the Installed with OM3 subfolder.

5. Select and open the desired file.

• Method 3 – Using Overlay Maker 3 to navigate to the desktop.

1. Launch Overlay Maker 3.

2. From the Navigation Screen, click the Desktop button. An Open dialog box
displays. 

3. Navigate to and open the IntelliTools Classroom Suite program folder (stored on
your computer or network) using standard computer navigation procedures.

4. Select and open the desired file.
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Saving Overlay Files
Using Overlay Maker 3, you can save an
overlay in various ways, depending on
how you wish to use the overlay.

Files with the same name cannot
be saved in the same Overlay
Maker 3 folder.

Saving Overlay Files: Using
Save and Save As Options
An overlay can be saved to the Overlay
Maker 3 My Overlay folder or the
IntelliTools Classroom Suite Overlays folder
in order to store it. Once saved, it can be retrieved for further use (e.g., to be modified or
attached to an activity).

The first time an untitled overlay is saved, the Save As dialog box displays so that you can
give the overlay a name.

Why save an overlay in the My Overlays folder?

If the overlay is intended to be used with any program other than the three IntelliTools
Classroom Suite programs, save the overlay in the My Overlays folder. This makes it easier
to find, attach, and/or send the overlay.

How do I save an overlay in the My Overlays folder?

1. Select Save or Save As from the File menu. The Save As screen displays. Notice that
the directory path shows that the Overlays folder is open. 

2. Open the My Overlays folder. The saved overlay will be stored here.

3. Enter a name in the Save As text-entry box, if desired. 

• If you are saving an untitled overlay (either a new overlay or a document displayed
from an Overlay Activity kit) in the My Overlays folder, it is recommended that you
name the file so you can easily identify it.

• If you are saving a predesigned overlay in the My Overlays folder, you don’t have
to rename the overlay—you can keep the existing name. However, to help you
identify the file, it is recommended that you rename it using a variation of the
original name.

4. Enter a note in the Notes text entry box. The note will show when overlays are
displayed in the Navigation Screen or in the Save As screen using List view. Notes will
not show when documents are displayed in Icon view.

5. Click Save. The Save As screen closes and you are returned to the open overlay.

When working
with an open
overlay, you
should save your

work regularly by
selecting Save from the
File menu. Saving
updates the stored
version of your overlay.
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Why save an overlay in the
IntelliTools Classroom Suite Overlays
folder?

If the overlay is intended to be used with
Classroom Suite , save the overlay in the
IntelliTools Classroom Suite Overlays
folder. This makes it easier to find, attach,
and/or send the overlay.

How do I save an overlay in the
IntelliTools Classroom Suite Overlays
folder?

1. Select Save or Save As from the File
menu. The Save As screen displays.
Notice that the directory path shows
that the Overlays folder is open. 

2. Select the Shortcut to IntelliTools Classroom Suite Overlays folder to open the
Overlays folder in the IntelliTools Classroom Suite program. The saved overlay will be
stored here.

3. Enter a name in the Save As text-entry box, if desired. 

• If you are saving an untitled overlay (either a new overlay or a document displayed
from an Overlay Activity kit) in the IntelliTools Classroom Suite Overlays folder, it is
recommended that you name the document. 

• If you are saving a predesigned overlay in the IntelliTools Classroom Suite Overlays
folder, you don’t have to rename the overlay. You may want to keep the existing
name for easy identification.

4. Enter a note in the Notes text entry box. The note will show when overlays are
displayed in the Navigation Screen or in the Save As screen using List view. Notes will
not show when documents are displayed in Icon view.

5. Click Save. The Save As screen closes and you are returned to the open overlay.

Saving a Document to Another Location (e.g., in the Desktop Folder)
You can save an overlay to a location other than the Overlay Maker 3 My Overlay folder or
the IntelliTools Classroom Suite Overlays folder (for instance, your desktop).

How do I save a document to another location?

1. Select Save As from the File menu. The Save As dialog box displays.

2. Click the Desktop button. A Save As dialog box (Windows) or a Save File As dialog box
(Macintosh) displays.

3. Navigate to the desired location in your computer or on your computer network.

4. Name the file.

5. Click Save. All dialog boxes close and you are returned to the open overlay.

Clicking a
shortcut launches
Classroom Suite
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Saving Overlay Files: Using the Save As Template Option
An overlay can be saved as a template using the Save As Template menu option.

Why save an overlay as a template?

Once you make an overlay that can be used repeatedly, it is useful to save it as a template.
When opened, templates generate copies of themselves. By working with a copy, you can
preserve the original template. You don’t have to recreate the overlay from scratch each
time you wish to use it or create variations from it. The modified files you create from a
template can also be saved as new templates.

Overlays saved as a templates are typically stored in the My Overlays folder.

How do I save a template in the My Overlays folder?

1. Select Save As Template from the File menu. The Save As screen displays. Notice that
the directory path shows that the Overlays folder is open. The saved document will be
stored here.

2. Open the My Overlays folder. The saved overlay will be stored here.

3. Enter a name in the Save As text-entry box, if desired. 

• If you are saving an untitled file (either a new overlay or an overlay displayed from
an Overlay Activity kit template), it is recommended that you name the file so you
can easily identify it.

• If you are saving a file that already has a name and that you have modified, it is
recommended that you to rename the modified file so that the original file is not
overwritten. You may want use a variation of the original file name for easy
identification.

4. Enter a note in the Notes text entry box. The note will show when activities are
displayed in the Navigation Screen or in the Save As screen using List view. Notes will
not show when activities are displayed in icon view.

5. Click Save. The Save As screen closes and you are returned to the open document.
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Saving Overlay Files: Using the Save As Send-Only Option
To make it easy to only send an overlay’s key content to IntelliKeys, use the Save As Send-
Only option. By default, Send-Only files are saved to the desktop (though you can save
them elsewhere). Once saved, double-clicking the Send-Only file will send the overlay’s key
content to IntelliKeys without opening Overlay Maker 3 and displaying the overlay.

How do I save an Overlay Maker 3 overlay as a
Send-Only file?

1. Select Save As Send-Only from the File menu. The
Save As dialog box used with your operating system
displays.

2. Navigate to the desktop or elsewhere on your
computer (network).

3. Click Save. The Send-Only file has the extension .omc.

Send-Only Files (i.e., Content-Only): General Information
What is a Send-Only file?

A Send-Only file is an overlay file that only includes key content. It cannot be opened,
displayed, edited, and/or printed. Typically Send-Only files are saved to the desktop, so
that the files can be sent to IntelliKeys quickly.

Why save an overlay as a Send-Only file?

In some instances you may wish to send an overlay’s key content to IntelliKeys without
opening Overlay Maker 3 and displaying the overlay.

How do I send a Send-Only file to IntelliKeys?

Double-click the Send-Only file to send the overlay’s key content to IntelliKeys without
opening Overlay Maker 3 and displaying the overlay.

How do I edit a Send-Only file?

You can’t edit a Send-Only file. Therefore, before you save an overlay as a Send-Only file, it
is recommended that you save a copy of your file as an .oms file (an editable overlay) or an
.omt file (a template that can’t be easily overwritten).

Saving Overlay Files: Using the Export to DynaVox Option
How do I save an Overlay Maker 3 overlay so it is compatible with DynaVox
hardware?

1. Select Export to DynaVox from the File menu. The Save As dialog box used with your
operating system displays.

2. Navigate to the desktop or elsewhere on your computer (or network).

3. Click Save.
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Printing an Overlay
Due to the size and shape of the IntelliKeys touch-sensitive surface (8.5” x 13”), overlays
are bigger than a “regular” letter-size paper (8.5” x 11”). Therefore it is recommended that
you use legal size paper (8.5” x 14”) in the landscape (sideways) orientation to print
overlays. Then trim the overlay to 8.5” x 13” (includes margins).

How do I choose paper size and orientation?

1. From the File menu, select Page Setup.

2. Select Legal for the Paper size and Landscape for the orientation if these options are
not already selected. Click OK to close the Page Setup dialog box.

How do I print the overlay?

1. Select Print from the File menu or click the Print button on the Standard Toolbar. 

2. Choose the desired print settings (e.g., number of copies) and click OK. The overlay
prints.

3. Trim the printed overlay along the cut lines.

4. Place the printed overlay on the IntelliKeys.

Can I use letter size paper and portrait orientation for printed overlays?

Yes. The overlay will be printed on two sheets of paper. Use the dotted cut lines to trim the
pages to the correct overlay dimensions and tape the two pages together.

What do I do if an overlay is not correctly positioned on the page?

1. Select Preferences... from the Options menu. The Preference dialog box displays.

2. Click the Advanced tab.

3. Enter the needed Horizontal Offset and Vertical Offset measurements.

4. Click OK.

5. Print the overlay again.

How do I stop the overlay title from being printed on the overlay?

After an overlay is saved, the overlay name will print vertically in the left margin.

1. Select Preferences... from the Options menu. The Preference dialog box displays.

2. Click the Advanced tab.

3. Deselect the Print Overlay Title option.

How do I print a single level of a multilevel overlay?

1. Display the level that you want to print on-screen.

2. Select Print from the File menu or click the Print button on the Standard Toolbar. 

What are the dimensions of a trimmed overlay and what size are the margins?

The trimmed overlay dimensions are 8.5” x 13” (includes margins). The minimum margins
measurements are 7/16” (left vertical margin) and 1/4” for the top and bottom margins.
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Closing an Overlay
There are two ways to close an overlay:

• Select Close from the File menu to close the current overlay or Close All from the File
menu to close all open Overlay Maker 3 overlays.

• Or close a single overlay by clicking the close button on that overlay’s menu bar
(Windows) or title bar (Macintosh).

If you try to close an unsaved overlay, a Caution dialog box displays that asks if you
want to save that overlay. Clicking Yes displays the Save As dialog box.
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Menu Listings, Menu Actions, and Keyboard Shortcuts
There are nine menus included on the Overlay Maker 3 menu bar: File, Edit, Text, View,
Options, Levels, Overlay Maker, Window, and Help. Some menu listings have a
corresponding keyboard shortcut—keyboard users can press a combination of keys
([Ctrl]+     ), instead of making that menu selection.

File Menu Options

New...
Displays the contents of the New folder in Navigation Screen window. [Ctrl]+N

Open...
Displays the contents of the previously opened folder inNavigation Screen window.[Ctrl]+O

Open Group...
Displays the contents of your Desktop using your operating system’s Open dialog box.

Close
Closes the current overlay. [Ctrl]+W 

Close All
Closes all open overlays.

Save
Displays the Save As dialog box (showing the contents of the Overlays folder) the first time
Save is selected. After the file is saved, Save replaces saved file with current one. [Ctrl]+S 

Save As...
Displays the Save As dialog box (showing the contents of the Overlays folder).

Save As Template...
Displays the Save As dialog box (showing the contents of the Overlays folder).

Save As Send-Only...
Displays the contents of your Desktop using your operating system’s Save As dialog box.

Export to DynaVox...
Displays the contents of your Desktop using your operating system’s Save As dialog box.

Send Overlay
Sends the current overlay file to IntelliKeys, if the keyboard is connected. [Ctrl]+D 

Page Setup...
Displays Page Setup dialog box (used for setting printed page size and orientation).

Print...
Displays the Print dialog box. [Ctrl]+P 

Exit (Windows), Quit (Macintosh)
Closes the program.

Keyboard
shortcuts [Ctrl]+
appear

throughout the
following listings:

Windows users:
Simultaneously press the
[Ctrl] key and the      key
Macintosh users:
Simultaneously press the
[Ctrl] or [Command] key
and the     key 

Recently opened
overlays are also
listed on the File

menu.
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Edit Menu Options

Undo/Redo
Reverses one previous action/restores one previous action. [Ctrl]+Z

Cut
Deletes your selection and puts it on the clipboard. [Ctrl]+X 

Copy
Copies your selection and puts it on the clipboard. [Ctrl]+C 

Paste
Inserts the contents of clipboard. [Ctrl]+V

Clear
Deletes your selection.

Select All
Highlights and selects all the selectable objects on the current overlay level. [Ctrl]+A 

Duplicate
Copies your selection and inserts it on the current overlay level. 

Insert Picture From Library...
Displays the Picture Library dialog box. [Ctrl]+Y 

Insert Picture From File...
Displays the operating system’s Open dialog box.

Insert Picture From Boardmaker
Displays the Picture Library dialog box with Boardmaker images if the Boardmaker PCS
Library has been installed.

Fix to Background
Makes a selected frame, line, or picture part of the background.

Background Properties...
Displays the Background Properties dialog box.

Arrange

Bring Forward
Moves selection one layer forward.

Send Backward
Moves selection one layer backward.

Bring to Front
Moves selection to frontmost layer.

Send to Back
Moves selection to backmost layer.

Windows users:

[Alt]+_ enables
you to access

menus. Use arrow keys
to navigate menus and
[Enter] to select listings.
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Flip Horizontally
Flips selection along its vertical axis.

Flip Vertically
Flips selection along its horizontal axis.

Properties...
Displays the Properties dialog box for the selected object. 

Text Menu Options

Font
Displays the Font menu.

Size
Displays the Size menu.

Color
Displays the Color menu.

Plain Text
Displays selected text in default style. [Ctrl]+T 

Bold
Bolds selected text. [Ctrl]+B 

Italic
Italicizes selected text. [Ctrl]+I 

Underline
Underlines selected text. [Ctrl]+U 

View Menu Options

Standard Toolbar
Displays commonly used commands and tools arranged in a row (above the overlay) and a
column (to the left of the overlay).

Advanced Toolbar
Displays Standard Toolbar plus an additional row of editing tools.

Show Picture Library
Displays the Picture Library as a toolbar at the bottom of the window.

Show Status Bar
Displays the Status Bar below the overlay.

Show Keyguard Mask
Displays the selected keyguard mask on the foreground of the overlay. (You can select a
mask with 2, 3, 6, 9, 12, 15, 20, or 96 holes.)
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Grid Lines
Shows the IntelliKeys cell grid on the overlay (to help you position keys and other objects
on the overlay).

Fit to Window
Sizes the overlay to fit the window.

Preview in IntelliKeys
Shows how the overlay looks in an IntelliKeys.

View Actual Size
Displays the overlay actual size in the window. (Use scroll bars to see more of the overlay.)

Options Menu Options

IntelliKeys Settings...
Displays the IntelliKeys Settings dialog box (for the current overlay).

Preferences...
Displays the Preferences dialog box (for the Overlay Maker 3 program).

Levels Menu Options

Next Level
Displays the next level in the current multilevel overlay.

Previous Level
Displays the previous level in the current multilevel overlay.

Select a Level
Displays a list of levels in the current multilevel overlay.

New Level
Inserts a new level after the current level in the current multilevel overlay.

Delete Level
Removes the current level and its contents in the current multilevel overlay.

Duplicate Level
Inserts a copy of the current level after the current level in the current multilevel overlay.

Import Level...
Displays the Open dialog box. (The selected overlay file becomes a level in the current on-
screen overlay.)

View All Levels...
Displays the All Levels dialog box.

Send Current Level
Sends overlay information for the current level of a multilevel overlay.
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Overlay Maker Menu Options

Select Tool
Pointer is the Select Tool (selects and grabs).

Key Tool
Pointer is the Key Tool (draws a key).

Text Tool
Pointer is the Text Tool (draws a text box and/or shows where text will insert).

Line Tool
Pointer is the Line Tool (draws lines).

Frame Tool
Pointer is the Frame Tool (draws frames).

Border and Line Width
Displays a list of border and line width options (none–10 point). Used to set line and border
width for selected lines, keys, text boxes, and/or frames.

Border and Line Color...
Displays Pick Color dialog box. Used to select line and border color for selected lines, keys,
text boxes, and/or frames.

Fill Color...
Displays Pick Color dialog box. Used to select fill color for selected keys, text boxes,
and/or frames.

Snap to Grid
Keys and currently selected objects align to grid automatically.

Shape

Rounded Rectangle
Pointer draws a rounded rectangle shape.

Rectangle
Pointer draws a rectangle shape.

Circle/Oval
Pointer draws a circle/oval shape.

Octagon
Pointer draws an octagon shape.

Diamond
Pointer draws a diamond shape.

Overlay Maker
menu options are
also available as
toolbar buttons.
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Triangle
Pointer draws a triangle shape (triangle points up).

Triangle (right)
Pointer draws a triangle shape (triangle points right).

Triangle (down)
Pointer draws a triangle shape (triangle points down).

Triangle (left)
Pointer draws a triangle shape (triangle points left).

Star
Pointer draws a star shape.

Text Below Picture
Positions text below the picture on the selected key.

Edit Key Content...
Displays Key Content tab of Properties of key dialog box for the selected key.

Autosize Picture
Adjusts the size of an inserted picture to fit a selected key.

Select Picture in Key
Selects the picture in a selected key, if the key has a picture.

Switches...
Displays Edit Content of Switches dialog box.

Send Overlay
Sends the current overlay file to IntelliKeys, if the keyboard is connected. [Ctrl]+D 

Window Menu Options
Lists open Overlay Maker 3 files. The selected listing indicates the current (i.e., active)
overlay.

Help Menu Options

About Overlay Maker (Windows) 
Displays Overlay Maker 3 version number and a link to IntelliTools Web site.

Help
Displays Help files by topic and alphabetically.

Visit IntelliTools Web site
Opens the IntelliTools Web site if your computer is connected to the Internet.

Read Me
Displays Read Me document in the user’s Web browser.
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Toolbars and Tools
Many Overlay Maker 3 features can be accessed by clicking toolbar buttons. There are two
toolbars available: the Standard Toolbar and the Advanced Toolbar.

Toolbars: Selecting
How do I select a toolbar?

To choose a toolbar, make a selection from the View menu.

Toolbars: Standard Toolbar
What buttons are included on the Standard Toolbar?

The Standard Toolbar includes command and editing tools (as two parts—one horizontal
toolbar and one vertical toolbar):

• The horizontal toolbar has these buttons arranged in a row above the overlay: 

New, Open, Save, Cut, Copy, Paste, Undo, Send Overlay, Print, Help, Insert Picture
from File, Picture Library, Font Name (list box), Font Size (list box), Bold, Italic, and
Underline.

• The vertical toolbar has these buttons arranged in a column to the left of the overlay: 

Select Tool, Key Tool, Text Tool, Line Tool, Frame Tool, Cycle Views, Shape, Border
and Line Width, Border and Line Color, Fill Color, Text Color, Background Color, and
Edit Switches.
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Toolbars: Advanced Toolbar
What buttons are included on the Advanced Toolbar?

The Advanced Toolbar includes an expanded set of command and editing tools (as three
parts—two horizontal toolbars, one vertical toolbar).

In addition to the two sets of tools displayed by the Standard Toolbar, the Advanced
Toolbar includes the following buttons arranged in a row above the overlay:

Rotate Clockwise, Rotate Counterclockwise, Flip Horizontally, Flip Vertically, Clear,
Clear All, Select All, Properties, Duplicate, Fix to Background, Clear Background,
Bring Forward, Bring to Front, Send Backward, and Send to Back, Fit to Window, View
Actual Size, Preview in IntelliKeys.
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Toolbars: Authoring Buttons
These toolbar buttons, arranged in a column to the left of the overlay, are used for
authoring (i.e., creating and editing objects). They show when the Standard Toolbar is
selected and when the Advanced Toolbar is selected.

• Select – Used to select (i.e., activate) objects on an overlay. 

• Key Tool – Used to create keys on an overlay.

• Text Tool – Used to add text to overlays (in text boxes or as labels on keys).

• Line Tool – Used to draw lines on an overlay.

• Frame Tool – Used to draw frames (i.e., free shapes) on an overlay.

• Cycle Views – Used to switch between 3 views of the current overlay (Fit to Window,
Preview in IntelliKeys, View Actual Size).

• Shape – The selected shape shows on the button. Click the pullout to see all shape
choices. Affects selected frames and keys.

• Border and Line Width – The current border or line width shows on the button. Click
the pullout to see all line width choices. Affects selected lines and the borders of
selected keys, text boxes, and frames. 

• Border and Line Color – The current border or line color shows on the button. Click
the pullout to see all line color choices. Affects selected lines and the borders of
selected keys, text boxes, and frames.

• Fill Color – The current fill color shows on the button. Click the pullout to see all fill
color choices. Affects the area within selected keys, text boxes, and frames.

• Text Color – The current text color shows on the button. Click the pullout to see all
text color choices. Affects text in selected text boxes and keys. 

• Background Color – The current background color shows on the button. Click the
pullout to see all background color choices. Affects the background of the current
overlay. 

• Edit Switches – Use to select or edit the switch content of the current overlay.

Toolbar button
actions are also
available as
Overlay Maker

menu commands.

6706: Working with Menus, Toolbars, and the Status Bar

Tip



68 Overlay Maker 3 User’s Guide

Select Tool Border and
Line Color

Border and
Line Width

Shape

Cycle Views

Frame Tool

LIne Tool

Text Tool

Key Tool Fill Color

Save

Open

New

Edit
Switches

Background
Color

Text Color

Undo

Send
Overlay

Underline

Italic

Bold

Picture
Library

Insert
Picture from
File

Print

Toolbars: Identifying Standard Toolbar Buttons



6906: Working with Menus, Toolbars, and the Status Bar

Rotate
Clockwise

Clear
Background

Fix to
Background

Duplicate

Properties

Select All

Flip
Vertically

Flip
Horizontally

Rotate
Counter-
clockwise

Bring
Forward

Preview in
IntelliKeys

View Actual
Size

Fit to
Window

Send to
Back

Send
Backward

Bring To
Front

Toolbars: Identifying Advanced Toolbar Buttons

Help

Paste

Copy

Cut

Clear All

Clear

Toolbars:
Identifying
Additional Toolbar
Buttons



Status Bar
What is the Status Bar?

The Status Bar is the gray rectangular area at the bottom of the Overlay Maker 3 window. It
provides useful information when you are creating and/or editing overlays.

What information does the Status Bar show? 

The Status Bar:

• Identifies objects on the overlay – When your pointer is positioned over an object
included on an overlay, the object type shows on the left side of the Status Bar. If your
pointer is positioned over a key, the key content for that key also shows on the Status
Bar. In some instances, (e.g., if the key content is lengthy) only a portion of the key
content shows.

• Shows a scaling measurement (the size of the current view compared to the actual size
of the overlay, expressed as a percentage). The Scaling measurement shows on the
right side of the Status Bar.

Select Actual Size from the View menu to see the overlay at 100%.

• Identifies the current overlay level, if the overlay has more than one level. The level’s
name and number (e.g., 1 of 2, 4 of 5, 9 of 10, etc.) shows on the right side of the Status
Bar.

How do I show or hide the Status Bar?

• To show the Status Bar, select (i.e., check) the Show Status Bar option from the View
menu.

• To hide the Status Bar, deselect (i.e., uncheck) the Show Status Bar option from the
View menu. 

By default, the Status Bar shows each time a new overlay is opened.
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IntelliKeys Settings
When an IntelliKeys user needs
custom IntelliKeys settings and
shares the IntelliKeys, you can add
custom IntelliKeys settings to an
overlay. When that overlay is sent to
IntelliKeys, these settings take effect
and will override the previous
IntelliKeys settings. The new settings
stay in effect until the IntelliKeys is
reset or another overlay with different
settings is used. 

How do I restore the overlay’s IntelliKeys settings to default values?

Click the Clear All button in the IntelliKeys Settings dialog box to set the overlay’s
IntelliKeys settings to default values. 

IntelliKeys Settings: Touch Tab Options
Some individuals press extra, unwanted keys while reaching for a specific key.

Response Rate
Response Rate controls the response time of the IntelliKeys keys. Use the Response Rate
setting to adjust the amount of time an IntelliKeys user must press on a key before
IntelliKeys responds. 

The Response Rate option has 15 incremental settings, with 1 being the slowest
(IntelliKeys does not respond until the user presses a key for approximately two seconds)
and 15 being the fastest (IntelliKeys responds immediately to a key press).

How do I adjust the Response Rate? (The default setting is 15)

1. Select (i.e., check) the Response Rate option. 

2. Select the desired response rate (1–15) from the corresponding settings box.

Required Lift Off
Required Lift Off means that the user is required to lift his or her finger off a key before
any other key can be activated. For example, if a person types the letter A and then slides a
finger over to the letter B, the letter B will not be typed. The user must first lift his or her
finger completely off of the overlay and then press the letter B.

How do I set the Required Lift Off option? (The default setting is Off)

1. Select (i.e., check) the Required Lift Off option. 

2. Select On or Off. 

Key Sound 
Some individuals may find key sounds (i.e., the sounds emitted when a key is pressed)
distracting. This feature allows you to turn IntelliKeys key sound on or off.

How do I set the Key Sound option? (The default setting is On)

1. Select (i.e., check) the Key Sound option. 

2. Select On or Off. 

After using an
overlay that sends
customized
IntelliKeys

settings, it is
recommended that the
IntelliKeys be reset. (Use
the Keyboard Reset
option on the Setup
Overlay or on the
IntelliKeys USB control
panel.) 
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IntelliKeys Settings: 
Repeat Tab Options
Some individuals may need to have a key press
not repeat or the user may need to have a key
repeat without holding the key down. 

Repeat Rate
The Repeat Rate option has 15 incremental
settings, with 1 being the slowest repeat rate
and 15 being the fastest.

How do I adjust the Repeat Rate? (The default setting is 15)

1. Select (i.e., check) the Repeat Rate option.

2. Select the desired repeat rate (1–15) from the corresponding settings box.

Repeat
When Repeat is selected, IntelliKeys repeats the key’s key content until the user stops
pressing that key. On a Mac, IntelliKeys Classic users would open the Keyboard control
panel to set Key Repeat Off.

How do I set the Repeat option? (The default setting is On)

1. Select (i.e., check) the Repeat option. 

2. Select On or Off. 

Repeat Latching
When Repeat Latching is selected, IntelliKeys repeats the last repeating key press after the
user lifts off that key. The repeat continues until another key press stops the repeat. Repeat
Latching is a useful feature to select for individuals needing to continuously press Mouse
Arrows. 

How do I select Repeat Latching? (The default setting is Off)

1. Select (i.e., check) the Repeat Latching option. 

2. Select On or Off. 

IntelliKeys Settings: 
Shift Tab Options
Most computer programs use
keyboard shortcuts that require
pressing multiple keys
simultaneously. For instance, to
type a capital letter or execute
certain commands, a user is
required to press the Shift modifier key in combination with another key. Shift is the most
commonly used modifier key. Other Modifier keys include Control, Alt, Command and
Option.

Pressing two or more keys simultaneously may be difficult for some individuals. IntelliKeys
users can select Shift Key Action options to allow the user to press keys sequentially rather
than simultaneously.
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Shift Key Action: Latch
When Latch is selected and the user presses any modifier key, IntelliKeys will “hold down”
the modifier for the next non-modifier key press, then “release” all held down keys. 

For example, to type a word beginning with a capital letter using the latching feature, the
user first presses the Shift key, then types in the entire word. The first letter will be
capitalized automatically and the following letters will be lowercase. Shift Latch is the
IntelliKeys default setting unless another Shift Key Action is selected.

Shift Key Action: Lock 
When Lock is selected and the user presses any modifier once, IntelliKeys will latch (i.e.,
“hold down” the modifier for the next keystroke, then “release”). If the user presses a
modifier twice in succession, IntelliKeys will lock (i.e., “hold down” the modifier for all the
following keystrokes) until that modifier key is “released” by pressing it again.

For example, to type a word consisting of all capital letters (such as INTELLITOOLS) using
the locking feature, the user presses the Shift key twice, then types in the entire word.
Notice the IntelliKeys Shift light stays on. All letters in the word are capitalized
automatically. When the user presses Shift again, the user resumes typing in lowercase.
Notice the IntelliKeys Shift light is now off. 

Shift Key Action: No Latch
When No Latching is selected and the user presses any modifier, the modifier will not
affect any other key (i.e., it will not modify). This is useful when playing some game
programs.

For example, in some pinball game programs the Shift key is used to flip a paddle. In this
case the user would not want the Shift key to modify the next keystroke.

How do I select a Shift Key Action? (The default setting is Latching) 

1. Select (i.e., check) the Shift Key Action option. 

2. Click the radio button next to the desired Shift Key Action option. 

Indicator Lights
The indicator lights on the left side of the IntelliKeys keyboard provide visual indication of
the state of the IntelliKeys. A green light next to Shift, Caps Lock, and/or Mouse Down
indicates that the feature is active (i.e., that key on the overlay has been pressed). A red
light next to Alt/Option, Control/Command, and/or Num Lock indicates that the feature is
active (i.e., that key on the overlay has been pressed). Num Lock will not light up when
connected to a Macintosh computer.

The indicator lights also flash when the IntelliKeys keyboard is reset and when an overlay
is sent.

How do I select an Indicator Lights option for IntelliKeys Classic? (The default
setting is 3) 

1. Select (i.e., check) the Indicator Lights option. 

2. Click the radio button next to the desired option—3 or 6.
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IntelliKeys Settings:
Additional Tab Options
IntelliKeys has other useful features
described below. 

Mouse Arrows
This setting lets you activate the mouse
capabilities built into the IntelliKeys
Standard overlays. This setting has no
effect on custom overlays.

How do I select Mouse Arrows?
(The default setting is Off) 

1. Select (i.e., check) the Mouse Arrows option. 

2. Select On or Off. 

Mouse Speed
Mouse Speed refers to the speed at which the on-screen pointer moves when any of the
Mouse Arrows on an overlay are pressed. The Mouse Speed option has 15 incremental
settings, with 1 being the slowest and 15 being the fastest. IntelliKeys mouse speed only
applies when you are using the IntelliKeys USB and Mac IntelliKeys Classic Mouse arrows. 

How do I adjust Mouse Speed? (The default setting is 15) 

1. Select (i.e., check) the Mouse Speed option. 

2. Select the desired response rate (1–15) from the corresponding settings box.

Smart Typing 
Smart Typing types the following key presses automatically after the user types a certain
character:

• After typing an uppercase or lowercase q, IntelliKeys types a lowercase u.

• After typing a period, exclamation point, or a question mark, IntelliKeys types two
spaces and latches the Shift key so the next key press character entered by the user
will be capitalized. This is useful when ending one sentence and starting another.

• After typing a comma or a semicolon, IntelliKeys types one space.

• After typing a colon, IntelliKeys types two spaces.

How do I select Smart Typing? (The default setting is Off) 

1. Select (i.e., check) the Smart Typing option. 

2. Select On or Off. 

Custom Overlay Level 
This setting lets you specify which level in a multi-level overlay you want IntelliKeys to use
when first sent.

This setting remains active until replaced by another Custom Overlay Level setting or until
the IntelliKeys is Reset. Note: Unlike the [Go to Level…] action, this setting remains in
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effect when you switch to a Standard overlay. For IntelliKeys Classic only, this setting also
remains in effect when you turn off the computer and then turn the computer on. 

This setting should be used only by advanced Overlay Maker 3 users of multilevel
overlays. 

How do I set Custom Overlay Level? (The default setting is the current top level) 

1. Select (i.e., check) the Custom Overlay Level option. 

2. Select the desired custom overlay level from the corresponding settings box.

Data Send Rate 
The Data Send Rate setting can be useful for those using IntelliKeys with a custom overlay
that has keys with long text strings in the Key Content. This feature controls the IntelliKeys
data input to your computer. The Data Send Rate option has 15 incremental settings, with 1
being the slowest and 15 being the fastest. This setting remains until replaced by another
Data Send Rate or an IntelliKeys Keyboard Reset. 

How do I adjust the Data Send Rate? (The default setting is 15) 

1. Select (i.e., check) the Send Rate option. 

2. Select the desired response rate (1–15) from the corresponding settings box.

IntelliKeys Settings: Overlay Lock Tab Options

Overlay Lock 
The Overlay Lock feature protects an
overlay you’ve sent to IntelliKeys
Classic from getting accidentally
erased by another custom overlay. If
you try to send another custom overlay
to IntelliKeys Classic while the overlay
in memory is locked, you are warned
and have the option to send or not send
the new overlay.

Some programs have their own overlays which are automatically sent to IntelliKeys when
you open a document. This normally replaces any custom overlay you have sent previously.
To use these programs with your own custom overlay, protect your custom overlay with
overlay lock. 

Instead of Overlay Lock, IntelliKeys USB users use the Advanced control panel With
this overlay... feature.

This setting should be used only by advanced Overlay Maker 3 users.

How do I select Overlay Lock? (The default setting is Off) 

1. Select (i.e., check) the Overlay Lock option. 

2. Select On or Off. 
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Preferences...
The options included in the Preferences
dialog box enable you to change the
default program settings for Overlay
Maker 3. 

Changes remain in effect until they are
changed again or you restore the
original default settings (by clicking the
Restore Original Defaults button on the
Default Appearance tab).

Preferences: Default Appearance
Tab Options
The Default Appearance option enables you to select different initial appearance settings
for new overlays. 

How do I set the Default Appearance settings?

1. Using menu options or toolbar buttons, set the desired appearance settings for Text
Font, Size, Color, and Style; Frame and Key Shape; Line and Border Width and Color;
Fill Color and Pattern; Background Color and Pattern; Autosize Picture; Snap to Grid;
and Text Below Picture.

2. Click Capture to use these as the default appearance settings for new overlays.

How do I restore the Default Appearance settings?

1. Click Restore Original Defaults to use the original default appearance settings.

2. Click OK.

Preferences: Default Key
Content Tab Options
The Default Key Content option enables
you to select the initial key content for
new keys. 

How do I set the Default Key
Content?

1. Select the desired key content by
making selections from the Key
Actions drop-down list box and
adding the selection.

2. Click the Add button or type the
selection directly into the Content
entry box.

3. Click OK to make this the default key content for new keys.

How do I restore the Default Key Content?

1. Click Restore Original Defaults to use the original default Key Content [Same as Text
Label].

2. Click OK.
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Preferences: Default Switch Content Tab Options
The Default Switch Content option enables you to select the initial switch content for new
overlays. 

How do I set the Default Switch Content?

1. There are two ways to select switch content:

• Make a selection from the Choose Preset drop-down list box. 

• Click the Edit... button to display a Switch Content dialog box. Make a selection from
the Key Actions drop-down list box and click the Add button and/or type the desired
content directly into the Content entry box. 

2. Click OK to make these the new default settings for switch content for new overlays.

How do I restore the Default Switch Content?

1. Click Restore Original Defaults to use the original default Switch Content (4-Click and
Click).

2. Click OK.

Preferences: Advanced Tab Options
The Advanced tab options allow you to set advanced printing options and to show or hide a
warning box.

Printer Values 
In some instances, when printing overlays, an overlay may not be properly positioned on
the paper.

What do I do if the printer is printing overlays in the wrong place?

1. Enter Horizontal and/or Vertical offset values (expressed in decimal inches). 

2. Click OK.

Most Compatible Printing and Most Exact Printing
Windows Users: In some instances, patterns and pictures may not print exactly as they look
on-screen when the default option Most Compatible Printing is selected. Selecting the Most
Exact Printing option may improve your results.

Print Overlay Title 
By default, the overlay’s name shows in the left margin when the overlay prints.

How do I hide the overlay’s name when the overlay prints? 

1. Deselect this option.

2. Click OK.

Warn When Pasting Pictures
By default, a warning box displays when pictures are inserted.

How do I hide the warning box that shows when I insert a picture?

1. Deselect the Warn When Pasting Pictures option.

2. Click OK.

Windows Users: 
In some instances,
patterns and
pictures may not

print exactly as they look
on-screen when the
default option Most
Compatible Printing is
selected. Selecting the
Most Exact Printing
option may improve
your results.
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Keys: General Information
This chapter describes how to work with
keys using Overlay Maker 3. 

What’s a Key?
Overlays used with IntelliKeys can include
one or more keys. Keys are the only
interactive parts of an overlay. On a printed
overlay that you place on an IntelliKeys
keyboard, a key is a specific area that the
IntelliKeys user presses to have a response
take place on-screen. 

Positioning and Arranging Keys
Depending on the needs of the IntelliKeys user and the on-screen content, you might
include just a few keys on an overlay, or you may include many. You determine where each
key is positioned on the overlay. As you create and position the keys on the overlay using
Overlay Maker 3, remember that:

• Keys must be positioned within the overlay grid.

• You can use the program’s Snap to Grid feature to position keys so that they will be
aligned with the IntelliKeys touch-sensitive cells.

• Keys always show in front of the background. (A key cannot be fixed to the
background.)

• Keys cannot overlap other keys.

• Keys can overlap or be overlapped by text boxes, frames, lines, and/or pictures (since
each overlay level has multiple layers).

Setting Key Content
When creating keys using Overlay Maker 3, you decide what each key on the overlay does
(i.e., you set the key content). Your ability to set a diverse range of key content is what
makes the IntelliKeys so versatile—key content might be set to duplicate the actions of a
standard keyboard or mouse or be set to perform other actions that best meet a user’s
needs. Useful key content enables the IntelliKeys user to best perform on-screen
activities—make selections, type, navigate, etc.

The overlay file that is sent to the IntelliKeys keyboard includes content for every key on
the printed overlay, so that the touch-sensitive surface on the keyboard (underneath the
printed overlay) “knows” what to do when each key is pressed. 

Choosing Key Appearance
When making overlays using Overlay Maker 3, you choose how each key will look on the
printed overlay. You determine key size. You can select a predesigned key style or you can
pick a different shape, color, border. To make a key on a printed overlay easy to identify,
you can add a key picture and/or key text (i.e., a text label) to it. 

Working with Keys
Begin by displaying the overlay that you wish to work with using Overlay Maker 3. You can
start with a blank overlay or edit an existing overlay.
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Key: Creating
How do I create a key on an overlay?

1. Click the Key Tool button or select Key
Tool from the Overlay Maker menu.

2. Place the pointer on the overlay where
you want a corner of the key to be, and
drag the double-headed arrow pointer
in any direction. When you release the
mouse, the key displays on the overlay.
It is already selected (notice the black
resizing handles).

If the Snap to Grid option is selected, the key will be aligned with the overlay
grid, even if the grid is hidden.

3. (Optional) Resize and/or reposition the key.

4. Add key content, a text label if needed, and/or a picture (optional).

Key: Selecting
How do I select a key on an overlay?

1. Click the Key Tool button or the Select Tool button. Or choose Key Tool or Select Tool
from the Overlay Maker menu.

2. Click the key you wish to select. 

How do I tell the difference between a key and a frame, since they look similar
when selected?

A selected key has black-colored resizing handles—a selected frame has white-colored
resizing handles. The Status Bar can also be used to identify an object.

Key: Adding a Text Label
To identify it, it is useful to add a text label
to a key. (This text label is also referred to
as key text, to distinguish from other text on
the overlay.)

How do I add a text label to a key?

1. Select the key using the Select Tool.

2. Type. The text shows on the selected
key.

If a key includes both text and picture,
how do I place the text below the picture? 

Select Text Below Picture from the Overlay Maker menu or edit the key’s properties
(Properties of Key dialog box, Appearance tab, Text Below Picture option).

How can I can have the selected picture’s name inserted as a text label.

Before inserting a picture from the Picture Library, select the Include Name with Picture
option in the Picture Library dialog box.

You can also
create and edit
keys using the

Make Overlay feature of
IntelliTools Classroom
Suite.

The width and
color of the
border around

the key and the fill color
are determined by the
program’s default
settings or the previous
selections.

For more
information
about frames,

refer to chapter 9.
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Key: Adding a Picture
It is useful to add a picture to a key to
identify it. (Such a picture is also referred to
as a key picture, to distinguish from other
pictures on the overlay.)

What types of image files can I add to a
overlay?

You can import these image files: GIF, JPG
/JPEG, DIB, BMP, PNG, PICT, and PSD.
(Animated GIF files are not supported.)

How do I add a picture to a key?

There are three ways to add a picture to a key:

Key Picture: Inserting a Picture From IntelliTools Library
1. Select the key.

2. Select Insert Picture From Library
from the Edit menu or click the
Picture Library button. The Picture
Library dialog box displays.

3. (Optional) If Boardmaker 5 is
installed on your system, choose a
library.

4. Select the desired picture. Tip: Use
the search feature to find a picture.

5. (Optional) Select the Include Name
with Picture option to have the
selected picture’s name inserted as
the key’s text label.

6. Click Insert. The selected picture shows on the selected key.

Key Picture: Inserting a Picture From File
1. Select the key.

2. Select Insert Picture From File from the Edit menu or click the Insert Picture
From File button. The Open dialog box displays.

3. Navigate to the desired file.

4. Select the desired picture.

5. Click Open. The selected picture shows on the selected key.

Key Picture: Pasting a Picture From Clipboard
1. Copy the picture you wish to add to the key to your clipboard.

2. Select the key.

3. Select Paste from the Edit menu or click the Paste button. The selected picture
shows on the selected key.

To insert a picture
from the from the
Boardmaker PCS

Library, you must have
Boardmaker 5 (or a more
recent program version)
installed on your system.
The Boardmaker CD
does not have to be
inserted in your CD-ROM
drive for you to select
Boardmaker pictures.

To reduce the size
of your overlay
file, use Insert

Picture from File instead
of pasting a picture from
the clipboard.

8108: Working with Keys and Setting Key Content

Picture added to a key using the 
Overlay Maker 3 Picture Library

Picture Library dialog box

Tip

Note



How can I change the size of the picture to fit a selected key?

Select Autosize Picture from the Overlay Maker menu.

How can I quickly select a picture on a selected key?

• Choose Select Picture In Key from the Overlay Maker menu.

• Use the keyboard shortcut [Ctrl]+r.

Properties of Key
Each overlay key has properties. Picture and Appearance properties determine what the
key looks like. Key Content properties determine what it does (by default, what it types on-
screen). These properties are set and edited using the Properties of Key dialog box.

How do I display the Properties dialog box for a selected key?

There are multiple ways to display the Properties of Key dialog box for a selected key:

• Method 1 – With the pointer positioned over the key, right-click the mouse to display
the pop-up menu. Select Properties....

• Method 2 – Simultaneously press the [Ctrl] key on a standard keyboard and click the
key to display the pop-up menu. Select Properties....

• Method 3 – Select Properties... from the Edit menu.

• Method 4 – Click the Properties button on the Advanced Toolbar.

Key: Editing Picture Properties Using the Picture Tab
The Picture tab includes a toolbar and a picture preview box. The buttons are Cut, Copy,
Paste, Clear, Insert Picture from File, Insert Picture From Library, Flip Horizontally, Flip
Vertically, Rotate Clockwise, and Rotate Counterclockwise. The current picture shows in
the preview box.

How do I change, flip, or rotate a picture on a key using the Picture tab options?

1. Use one of the following methods to change, or edit a picture using the Picture tab
options:

• Click the Insert Picture From Library
button to display the Picture Library.
Select and insert the desired picture.

• Click the Insert Picture From File
button to display the Open dialog box.
Navigate to and select the desired
picture.

• Click the Paste button to paste a picture
from the clipboard.

The new picture shows in the picture
preview area. 

2. (Optional) Flip or rotate the picture.

3. Click Apply to preview selections. (Click
Cancel if you do not want the selections
applied.) Click OK to close the Properties
dialog box.

Double-click the
key to select it
and display the

Properties of Key dialog
box.

Once the
Properties of Key
dialog box
displays, you can

reposition it (so you can
see the key with which
you are working). 
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Key: Editing Appearance Properties Using the Appearance Tab
The Appearance tab includes options for border,
fill, text placement, auto-size picture, key shape,
and key style.

How do I change the appearance of a
selected key using the Appearance tab
options?

1. Select the desired options. 

Key Style overrides border, fill, and
shape settings.

2. Click Apply to preview selections. (Click
Cancel if you do not want the selections
applied.) Click OK to close the Properties
dialog box.

How do I make a selected key transparent?

Deselect the Show Border or Line and 
Show Fill options.

Key: Editing Key Content Properties Using
the Key Content Tab
The Key Content tab includes a listing of Key
Actions and a Content box. 

If the key is selected, this tab can be
displayed by right-clicking your mouse
and selecting Edit Key Content... from the
pop-out menu that displays.

How do I add or edit key content using the
Key Content tab options?

1. (Optional) Select a Key Actions category. 

2. Enter a key action in the Content box by:

• Double-clicking the action.

• Selecting the listing and clicking the
Add button.

3. Click Apply to preview selections. (Click Cancel if you do not want the selections
applied.) Click OK to close the Properties dialog box.
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Key: Changing Shape and Appearance Using On-Screen Tool Buttons
How do I change the shape of a key (e.g., change an oval key into a square key)
using the Shape button?

1. Select the key that you want to change.

2. Click the Shape button to display a choice of shapes (i.e., rectangle, triangle, circle,
etc.).

3. Select a different shape from the available choices. (The shape selected for a key is
also referred to as key shape, to distinguish it from other shapes on the overlay.)

How do I color the border of a key using the Border and Line Color button?

1. Select the key. The current border color shows on the Border and Line Color button.

2. Click the Border and Line Color button to display a choice of colors.

3. Select the desired color. (Note: Selecting the last color choice, a box with a red slash,
will hide the border.)

How do I set the border width of a key
using the Border and Line Width
button?

1. Select the key. The current border
width shows on the Border and Line
Width button.

2. Click the Border and Line Width
button to display a choice of line
thicknesses.

3. Select the desired line thickness.
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How do I fill a key with a solid color
using the Fill Color button?

1. Select the key. The current fill color
shows on the Fill Color button.

2. Click the Fill Color button to display a
choice of colors. 

3. Select the desired fill color. 

How do I fill a key with a pattern using
the Fill Color button?

1. Select the key.

2. Click the Fill Color button to display a
choice of patterns. 

3. Select the desired fill pattern. 

Why would I fill a key with a pattern?

Using patterns, instead of solid fill colors,
conserves ink when printing the overlay.

How do I change the color of a pattern
showing on a selected key?

Patterns have two parts, a foreground and a
background. To change the:

• Foreground color – Click the Fill Color
button and select a color.

• Background color – While pressing the
[Ctrl] key, click the Fill Color button
and select a color. 

To change a
pattern to a solid
fill, click the first
choice (black

square) in the pattern
box.
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Key: Repositioning
How do I reposition a key on an overlay?

1. Using the Select Tool or Key Tool, click the key and hold down the mouse button.

2. Drag the key to a new location that:

a. Is big enough to hold the key.

b. Does not already contain another key.

If the Snap to Grid option is selected the key will be aligned with the overlay grid,
even if the grid is hidden.

Can I move a key off the grid?

You can temporarily move a key off the overlay grid during the design process to help you
position keys on an overlay. (Select Preview in IntelliKeys from the View menu for a useful
design view). However, keys must be placed entirely in the grid if you intend them to be
printed and functional.

Key: Resizing
How do I resize a key on an overlay?

1. Using the Select Tool or Key Tool, select the key. Eight handles (black squares) show
at the corners and edges of the key. 

2. Drag a selection handle in the desired direction.

Key: Using Arrange Options (Bring Forward, Send Back, etc.)
How do I bring a key forward or send it towards the back if I want it to overlap,
or be overlapped by, other objects on the overlay?

Each level of an overlay has multiple layers. You can position a key on a different layer than
a picture, a line, a free shape, or a text box. The program ensures that a key never overlaps
another key.

There are multiple ways to change a layer that a selected key is on:

• Select Arrange from the Edit menu and choose the desired Arrange option (Bring
Forward, Send Backward, Bring to Front, or Send to Back).

• Simultaneously press the [Ctrl] key on a standard keyboard and click the overlay key.
Choose the desired Arrange option from the menu that displays.

• With the pointer positioned over the key, right-click your mouse. Choose the desired
Arrange option from the menu that displays.

• Click one of the Arrange buttons (Bring Forward, Bring to Front, Send Backward,
Send to Back) on the Advanced Toolbar.

Key: Deleting
How do I delete a key on an overlay?

1. Using the Select Tool or Key Tool, select the key. 

2. Press the [Delete] key on a standard keyboard or select Clear from the Edit menu or
click the Cut button (on the toolbar above the overlay).
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Setting Key Content (i.e., What a Key Does)
Every key on an IntelliKeys overlay has a property called key content. The key content is
what the key does, or more accurately, what command is sent to the user’s computer when
that overlay key is pressed. Most actions that can be accomplished using the keys on a
standard keyboard can be replicated by setting the matching key content for an overlay
key. By default, a key types its text label on-screen when pressed.

Setting Key Content: For Use with Word Processors
For IntelliKeys users working with word processors (such as IntelliTools’ Classroom Suite,
or Microsoft Word), a key’s content can be set to send text (e.g., a single character, a group
of letters, a single word, or a group of words, etc.) to the computer, so that text will show
on-screen when the IntelliKeys user presses the key. For instance, if an IntelliKeys user
presses an overlay key that has the word Hello as the key content, the word Hello will show
on-screen. A talking word processor (such as IntelliTools’ Classroom Suite) can then speak
the word aloud.

Setting Key Content: For Use with Curriculum Activities
For IntelliKeys users working with computer-based curriculum activities, the key content is
typically set to select buttons displayed on-screen. For instance, if clicking a button on-
screen plays a sound, the key content of the corresponding overlay key can be set to select
that button and play that sound. Or if clicking a button on-screen displays the next page in a
document, the key content of the corresponding overlay key can be set to select that button
and display the next page.

Key Content: Categories
An overlay key can include the following types of key content:

• Single Text Characters – including letters, numerals, and symbols (e.g., A, 6, %).

• Text Strings – such as words, sentences, or combinations of letters, numerals, and
symbols (e.g., Total, $2.75, I like milk.).

• Menu Commands – any menu command that has a keyboard shortcut (e.g., [Ctrl]+P
for Print, [Ctrl]+S for Save, [Ctrl]+W for Close, etc.).

• Keyboard Actions – the functions of a standard keyboard (e.g., [Tab], [Caps Lock],
[Shift], etc.).

• Mouse Actions – the navigation, select, and drag functions of a “handheld” mouse (e.g.,
Click, Up, Down, etc.).

• Other Actions – additional actions needed by an IntelliKeys user (e.g., Non-Repeating,
Go to Level, Smart Typing Toggle, etc.).

• IntelliKeys Setup Commands – enable an IntelliKeys user to set IntelliKeys
performance parameters (e.g., [Response Rate 8], [Keysound off]).

Key Content: Including Multiple Actions
In most cases, you can include more than one type of key content on the same key, so a
single key press results in multiple actions. For instance a single key could type and
perform a keyboard action (e.g., I like cows.[Enter]). 
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However, some key content entries cannot be combined. For instance, IntelliKeys Setup
commands and certain other special characters may require separate keys. Overlay Maker
3 will alert you if you try to combine characters requiring separate keys with other types of
content.

Key Content: Creating a Key That Types On-Screen
How do I create an overlay key that types on-screen?

When an overlay key with this default key content [Same as Text Label] is pressed, the
same text that shows on the key (i.e., the key’s text label) is typed on-screen. For instance,
if an IntelliKeys user presses an overlay key that has the word Hello as the text label, the
word Hello is typed on-screen. 

1. Create a key. 

2. Start typing (i.e., type the text you want
displayed on the key). If the key content is
[Same As Text Label], your entry will be
typed on-screen when the key is pressed by
the IntelliKeys user.

3. To verify if [Same as Text Label] is the key
content:

a. Display the key’s Properties of Key
dialog box. 

b. Click the Key Content tab. The default
key content in the Content box is [Same
as Text Label] (brackets included).

c. Click OK to close the Properties of Key
dialog box.

Or, if the Status Bar is showing, position the pointer over the key. The key content
shows on the left side of the Status Bar.

How do I create an overlay key that types something other than the key’s text
label?

1. Create a key.

2. Display the key’s Properties of Key dialog box. Click the Key Content tab. 

3. Delete the [Same As Text Label] key content.

4. Type the new content in the Content box. You can enter: 

• Single Text Characters—including letters, numerals, and symbols (no brackets
needed).

• Text Strings—such as words, sentences, or combinations of letters, numerals, and
symbols (no brackets needed).

5. (Optional) Add additional actions as key content.

6. Click OK to close the Properties of Key dialog box. 

If you do not
want the key to
type its text label,
or if the key does

not have a text label, be
sure to delete the [Same
As Text Label] content.
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Key Content: Creating a Key That Performs Standard Keyboard
Actions/Commands
What standard keyboard actions can I add as key content using the Key Content
tab of the Properties of Key dialog box?

The following actions, typically found on a standard keyboard, are listed in the Key Content
tab of the Properties of Key dialog box. When used as key content, each action is enclosed
by brackets.

• Escape, Function Key..., Print Scrn, Scroll Lock, Pause.

• Tab, Caps Lock, Backspace, Enter.*

• Control, Left Control, Right Control.

• Shift, Left Shift, Right Shift. 

• Alt or Option, Left Alt or Option, Right Alt or Option.

• Down Arrow, Left Arrow, Right Arrow, Up Arrow. 

• Insert, Home, Delete, End, Page Down, Page Up. 

• Num Lock, Num Pad.

* Return and Enter are interchangeable. Select [Enter] from the Keyboard Actions list or
type [Return].

How do I create an overlay key that duplicates an action that can be performed
using a standard keyboard? 

1. Create a key.

2. Display the key’s Properties of Key dialog
box. Click the Key Content tab.

3. Add a Keyboard Keys action:

a. Select the Keyboard Keys category
from the Key Actions drop-down list
box.

b. Select the desired Keyboard Keys
listing.

c. Click the Add button. 

(Or type the desired action in the Content
box. Surround each action with brackets.)

4. (Optional) Add additional actions as key content.

5. Click OK to close the Properties of Key dialog box. 

Double-clicking a
Key Action listing
adds it to the

Content box.
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How do I create an overlay key that duplicates a command that can be performed
using a standard keyboard?

Any menu command that has a keyboard shortcut can be included as key content for a
selected key (e.g., [Ctrl]+P for Print, [Ctrl]+S for Save, [Ctrl]+W for Close, etc.).

1. Create a key.

2. Display the key’s Properties of Key dialog box. Click the Key Content tab.

3. Type the desired keyboard shortcut in the Content box. Surround each action with
brackets (e.g., [Control]p, [Control]s, or [Control]w).

4. (Optional) Add additional actions as key content.

5. Click OK to close the Properties of Key dialog box. 

Key Content: Creating a Key That Performs a Mouse Action
What mouse actions can I add using the Key Content tab of the Properties of Key
dialog box?

Mouse Button and Navigation Actions:

• Button Click, Button Double-click, Button Down (Drag), Button Toggle, Button Up
(Release).

• Right Button Click, Right Button Double-click, Right Button Down (Drag), Right
Button Toggle, Right Button Up (Release).

• Mouse Down, Mouse Down-Left, Mouse Down-Right.

• Mouse Up, Mouse Up-Left, Mouse Up-Right.

• Mouse Left, Mouse Right.

How do I create an overlay key that performs a mouse action?

1. Create a key.

2. Display the key’s Properties of Key dialog box. Click the Key Content tab.

3. Add a Mouse Action:

a. Select the Mouse Actions category from the Key Actions drop-down list box.

b. Select the desired Mouse Actions listing.

c. Click the Add button. 

(Or type the desired action in the Content
box. Surround each action with brackets.)

4. (Optional) Add additional actions as key
content.

5. Click OK to close the Properties of Key
dialog box.

How many mouse action keys should I
include on an overlay?

The number of mouse action keys included on an
overlay depends on what the IntelliKeys user will
need to do for the on-screen activity.

Some keystroke
combinations
cannot be

entered in the Content
box by pressing those
combinations using a
standard keyboard.
Instead, you need to
enter them by adding a
Keyboard Keys listing.

Double-clicking a
Key Action listing
adds it to the
Content box.
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To enable a user to navigate on-screen activities, you would probably include at least
Mouse Up, Mouse Down, Mouse Right, Mouse Left, and Button Click keys. 

To enable a user to use pull-down menus, or any application program using dragging,
include a Button Toggle key, or a Button Down (Drag) key and Button Up (Release) key.

Some mouse actions cannot be combined as key content. For instance, you cannot create a
single key which that click in the upper left corner of the screen every time it was pressed.
To enable a user to move the cursor to a specific location (i.e., the upper left corner of a
document) and then click, you need to include two or more keys—one or more to position
the cursor and another to click.

If you are using IntelliKeys Classic with a Windows system, it is important to
remember that the mouse functionality is not built into IntelliKeys Classic, but
instead relies on Microsoft’s accessibility utility Mouse Keys. For IntelliKeys Classic

to work as a mouse, your computer must have MouseKeys running in the background. For
additional information, refer to the IKeys Classic WinMouse PDF document in Overlay
Maker 3’s Documentation folder.

Key Content: Creating a Key That Performs Other Actions
What other actions can I add as key content using the Key Content tab of the
Properties of Key dialog box? What do these actions do?

• Go to Level – Instructs IntelliKeys to select a particular level from the overlay
currently in the keyboard. After choosing this option, the Special Characters dialog box
displays. Select the name of the level you want to use from the Go To Level drop-down
list box.

• Non-Repeating – The key, when pressed, does not repeat—no matter how long you
hold the key down. This overrides any overlay setup Repeat setting. 

• Non-Smart Typing – Causes the IntelliKeys Smart Typing feature to be inactive for the
content of this key. With Smart Typing on, IntelliKeys automatically types certain
characters for you (e.g., a u after you type q; two spaces and [Shift On] after you type a
period).

• Same as Text Label – Types the same text as the text label. This is the default setting.

• Separate Repeat Key – Repeats the last key sent to the computer by IntelliKeys.

• Smart Typing Toggle – If Smart Typing is on,
this temporarily turns Smart Typing off.
Pressing the key again turns Smart Typing
back on. 

How do I create an overlay key that performs
other commonly used actions?

1. Create a key.

2. Display the key’s Properties of Key dialog
box. Click the Key Content tab.

3. Add an Other action:

a. Select the Other category from the Key
Actions drop-down list box.
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b. Select the desired Other listing.

c. Click the Add button. 

(Or type the desired action in the Content box. Surround each action with brackets.)

4. (Optional) Add additional actions as key content.

5. Click OK to close the Properties of Key dialog box.

Key Content: Creating a Key That Changes IntelliKeys Settings
It is recommended that only advanced users (those with experience setting up
IntelliKeys and adding key content) use Setup actions as key content.

Why use Setup actions as key content?

By using Setup actions as key content, an IntelliKeys user can change an IntelliKeys
keyboard setting by simply pressing a key on an overlay. An overlay key can only contain
one Setup action. 

What Setup actions can I add as key content using the Key Content tab of the
Properties of Key dialog box? What do these Setup actions do?

• 3 Indicator Lights – Sets the Indicator Lights for IntelliKeys Classic to respond when
[Shift], [Caps Lock], and/or [Num Lock] is on.

• 6 Indicator Lights – Sets the Indicator Lights to respond when the [Control], [Alt],
[Num Lock], [Shift], and/or [Caps Lock] keys are active. When 6 is selected, the
indicator lights display red as well as green. (Note: A removable label that describes
these six lights is included with IntelliKeys Classic. It can be pressed over the indicator
lights when needed and peeled off easily.)

• Custom Overlay Level – Specifies which overlay level you want IntelliKeys to use.

• Data Send Rate – Sets the speed at which IntelliKeys sends characters to the computer.
This is only important when IntelliKeys must send a string of characters in response to
a single key press. You might find that when using some programs, characters in a text
string get lost. If this occurs, try a slower Data Send Rate.

• Feature Reset – (IntelliKeys Classic) Resets all of the other features in this list to their
default settings. It does not delete any custom overlays in IntelliKeys memory.

• IBM Repeat Rate – For Windows computers. Specifies the delay that occurs from the
time a key is pressed until it begins repeating, as well as the rate at which the key
repeats.

• IBM Repeat – With an IBM and compatible computers. Specifies whether or not keys
repeat. The On setting allows keys to repeat. The Off setting prevents keys from
repeating.

• Keysound – Keysound On sets the keyboard to beep when a key is pressed. Keysound
Off turns the sound off.

• Latching Shifts – Specifies the functionality of the modifier keys ([Shift], [Control],
[Alt], [Option], and [Command]). With shift latching on (the default setting), modifier

Double-clicking a
Key Action listing
adds it to the
Content box.
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keys latch down until you press another non-modifier key. Then all latched modifier
keys are released. 

• List Features – Displays a list of the current settings for the IntelliKeys.

• Locking Shifts – Specifies the functionality of the modifier keys ([Shift], [Control], [Alt]
and [Command]). With shift locking on, IntelliKeys operates just like latching mode
when you press a modifier key once. When you press a modifier key twice, it remains
locked until you press it again.

• Mouse Arrows – Activates the mouse capabilities built into the IntelliKeys Classic
Standard overlays. This setting has no effect on custom overlays. 

• No Latch Shifts – Specifies the functionality of the modifier keys ([Shift], [Control],
[Alt], [Option], and [Command]). With no latching selected, modifier keys do not
remain pressed when you release the key.

• Repeat Latching – Sets a key to repeat continuously even after you remove your finger
from the key (for instance a mouse arrow key). Repeating only stops when you press
elsewhere on IntelliKeys. Clicking On activates the option, clicking Off deselects it.
The time until repeat latching takes effect is controlled by the IBM Repeat Rate on all
computers, including the Macintosh.

• Required Lift Off – Clicking On sets the keyboard so that you must lift your finger from
the keyboard before another key responds. Clicking Off deselects this option.

• Response Rate – Specifies the length of time you must press a key before IntelliKeys
responds. (15, the fastest setting, is the default. 1 is the slowest setting, and requires
you to hold down a key for approximately two seconds before it responds.) Type a
value ranging between 1 and 15 in the text box. 

• Smart Typing – Activates Smart Typing. With Smart Typing on, IntelliKeys
automatically types certain characters for you (e.g., a u after you type q; two spaces and
[Shift On] after you type a period.)

How do I create an overlay key that sends Setup commands to IntelliKeys?

1. Create a key.

2. Display the key’s Properties of Key dialog box. Click the Key Content tab.

3. Add a single Setup Command action.

a Select the Setup category from the Key
Actions drop-down list box.

b. Select the desired Setup listing.

c. Click the Add button. 

(Or type the desired action in the Content
box. Surround each action with brackets.)

4. Click OK to close the Properties of Key
dialog box.
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Working with Objects: General Information
In addition to keys (the interactive, touch-sensitive areas of an overlay), Overlay Maker 3
enables you to include text boxes, frames, lines, pictures, and a background on a printed
overlay. 

Although a printed overlay with only keys on it is completely functional, these non-
interactive objects are typically added to an overlay for identification, informative, and/or
decorative purposes. Including these objects on the printed overlay can make it easier for
an IntelliKeys user to understand, and interact with, what he or she sees on-screen. 

For instance, you might include text in text boxes for instructions, titles, or captions.
Brightly-colored lines and shapes could be added to attract a child’s attention to specific
parts of an overlay. Groups of related keys might be framed in a colored box. Pictures of on-
screen images could be included to create a visually interesting overlay.

Working with Text Boxes (i.e., Free Text)

Text Boxes: General Information
Text is added to an overlay by drawing a text box using the Text Tool, and typing the
desired characters (letters, symbols, numerals, etc.) in the text box. 

Each text box has appearance properties—you can select a border color, border width, a fill
color, and/or a fill pattern. If you make the text box transparent, only the text within the
text box will show. The text within a text box also has properties—you can select a font,
size, style, and color.

Why add text boxes to an overlay?

In addition to any text that shows on overlay keys, it is often useful to add text to an overlay
for informative and/or decorative purposes (e.g., instructions, titles, captions, etc.). 

Is the text in a text box the same as “free text?”

Yes. User manuals for previous versions of Overlay Maker defined free text as, “text which
is not contained within a key.” A text box was referred to as a “free text rectangle.”

How does an Overlay Maker 3 text box compare to a text box used in IntelliTools
Classroom Suite?

Similarities: 

Both types of text boxes contain editable text that the activity author (e.g., the teacher)
types in. In addition, both are created using the Text Tool, have Properties dialog
boxes, have borders and a background that can be filled with color, can be selected and
resized, can be selected and repositioned, and can contain multiple fonts and different
text sizes and colors.

Differences:

Overlay Maker 3 text boxes are not interactive—the IntelliKeys user cannot press the
text box on a printed overlay and hear its contents read aloud. IntelliTools Classroom
Suite text boxes are created to be part of on-screen activities (though the IntelliTools
Classroom Suite document could be printed).

Use the Arrange
feature to
position a text

box behind or in front of
keys and other objects.
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Text Box: Creating and Entering Text
How do I create a text box on an overlay and enter text?

1. Click the Text Tool button or select
Text Tool from the Overlay Maker
menu.

2. Place the pointer on the overlay where
you want a corner of the text box to be.
Draw the text box by dragging the
pointer in any direction. When you
release the mouse, the text box
displays. It is already selected (notice
the resizing handles). A flashing
insertion cursor shows in the text box.

To align a selected text box with
the overlay grid (even if the grid
is hidden), select the Snap to Grid option from the Overlay Maker menu.
Reposition the text box and it aligns to the grid.

3. Type the desired text. Characters appear to the left of the flashing cursor. Your entry is
automatically centered in the text box.

4. (Optional) Resize and/or reposition the text box.

5. (Optional) Edit border properties (i.e., color the border and set a new border width).

6. (Optional) Edit fill properties (i.e., fill the text box with a color).

How do I enter text in a selected text box?

After creating and selecting the text box:

1. Click the Text Tool button or select Text Tool from the Overlay Maker menu.

2. When flashing cursor shows in the text box, type the desired text. Characters appear to
the left of the flashing cursor. Your entry is automatically centered in the text box.

3. If needed, resize the text box.

Text Box: Selecting
How do I select a text box on an overlay?

1. Click the Text Tool button or select Text Tool from the Overlay Maker menu. Or click
the Select Tool button or choose Select Tool from the Overlay Maker menu.

2. Click the text box that you want to be selected.

3. Notice the resizing handles on the border of the selected text box.

The width and
color of the text
box’s border, and

the color/pattern that
fills the text box are
determined by the
program’s default
settings or the previous
selections.
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Text Box: Resizing
How do I resize a text box on an overlay?

1. Select the text box. Resizing handles show on the border of the text box.

2. Place your pointer on a resizing handle. The pointer shows as a double-headed arrow.

3. Drag the resizing handle in either direction the arrow points until you are satisfied with
the new size of the text box.

Text Box: Repositioning
How do I reposition a text box on an overlay?

1. Choose the Select Tool. 

2. Position the mouse pointer on the text box.

3. When the mouse pointer shows as a hand icon, grab and drag the text box to the
desired position on the overlay.

To align a selected text box with the overlay grid (even if the grid is hidden),
select the Snap to Grid option from the Overlay Maker menu. Reposition the text
box and it aligns to the grid.

Text Box: Using Arrange Options (Bring Forward, Send Back, etc.)
Using the Arrange feature, it is possible to position a text box behind or in front of keys and
other objects.

How do I bring a text box forward or send it towards the back if I want it to
overlap, or be overlapped by, other objects on the overlay?

1. Select the text box.

2. Select an Arrange option from the Edit menu (or right-click to display the same options
listed on the pop-up menu).

The Bring Forward and Send Backward commands incrementally move an
object between the foreground and background. The Bring to Front and Send to
Back commands move an object directly to the foreground and to the backmost
layer.

Text Box: Deleting
How do I delete a text box on an overlay?

1. Select the text box.

2. Press the [Delete] key on a standard keyboard or select Clear from the Edit menu or
click the Cut button (on the toolbar above the overlay).
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Properties of Text Box
The appearance of a selected text box can be changed by selecting different options in its
Properties dialog box.

How do I display the Properties of Text Box dialog box for a selected text box?

There are multiple ways to display the Properties of Text Box dialog box for a selected text
box:

• Method 1 – With the cursor positioned over the text box, right-click the mouse to
display the pop-up menu. Select Properties....

• Method 2 – Simultaneously press the [Ctrl] key on a standard keyboard and click the
text box to display the pop-up menu. Select Properties....

• Method 3 – Select Properties... from the Edit menu.

• Method 4 – Click the Properties button on the Advanced Toolbar.

Using the Select Tool, double-click the text box to display the Properties dialog box.

How do I color the border of a selected text box and/or set a new border width
using its Properties dialog box?

1. Display the text box’s Properties dialog box.

2. Select (i.e., check) the Show Border or
Line option from the Appearance tab.
The current border color shows in the
preview box.

3. To change the border color, click
Change. The Pick Color dialog box
displays. Choose a different color and
click OK to close the Pick Color dialog
box.

4. Select the desired border width (1–10).

5. Click Apply to preview the new selections.
Click OK to close the Properties dialog box.

How do I fill a selected text box with a color using its Properties dialog box?

1. Display the text box’s Properties dialog box.

2. Select (i.e., check) the Show Fill option from the Appearance tab. The current fill color
shows in the preview box.

3. To change the fill color, click Change. The Pick Color dialog box displays. Choose a
different color and click OK to close the Pick Color dialog box.

4. Click Apply to preview the new selections. Click OK to close the Properties dialog box.
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Text Box: Changing Appearance Using On-Screen Tool Buttons
How do I color the border of a text box using the Border and Line Color button?

1. Select the text box. The current border color shows on the Border and Line Color
button.

2. Click the Border and Line Color button to display a choice of colors.

3. Select the desired color for the border of the selected text box. (Note: Selecting the last
color choice, a box with a red slash, will hide the border.)

How do I set a new border width for a
text box using the Border and Line
Width button?

1. Select the text box. The current border
width shows on the Border and Line
Width button.

2. Click the Border and Line Width button
to display a choice of line thicknesses.

3. Select the desired line width for the
border of the selected text box.

How do I fill a text box with a color
using the Fill Color button?

1. Select the text box. The current fill color shows on the Fill Color button.

2. Click the Fill Color button to display a choice of colors and patterns.

3. Select the desired fill color for the selected text box. Text boxes cannot be filled with a
pattern.

Text Boxes: Changing Text Properties (Font, Size, Color, and Style)
How do I change the font, size, and style of the text in a selected text box?

1. Click the Text Tool button or select Text Tool from the Overlay Maker menu. A
flashing cursor shows in the text box.

2. Select (i.e., highlight) the text that you want to change.

3. Using the toolbar above the overlay, make the desired selection(s) from the font drop-
down list box, the size drop-down list box, and/or the style buttons (Bold, Italic, and
Underline). Or, make the desired selection(s) from the Text menu. (If you did not
select text, new text font, size, and style settings are applied to the next text that you
type.)

How do I change the color of text in a selected text box?

1. Click the Text Tool button or select Text Tool from the Overlay Maker menu. A
flashing cursor shows in the text box.

2. Select (i.e., highlight) the text that you want to change. The current text color shows
on the Text Color button (the button labeled with the letter A).

3. Click the Text Color button to display a choice of colors. Select the desired color. Or,
select the desired color from the Text menu. (If you did not select text, new text font,
size, and style settings are applied to the next text that you type.)

IntelliKeys users:
when the flashing
insertion cursor

displays, double-click to
select the nearest word.
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Working with Frames (i.e., Free Shapes)

Frames: General Information
Frames are added to an overlay using the Frame Tool. The initial shape of a frame can be
easily switched (by selecting a different shape from the Shape button’s pullout menu).

Each frame has properties—you can select a border color, border width, a fill color, and/or
a fill pattern. Frames are not interactive. Frames do not contain text or pictures.

Why add frames to an overlay?

For instructional and/or decorative purposes, it is often useful to add frames to a printed
overlay. Groups of related keys can be framed, or boxed, to help the IntelliKeys user
navigate an overlay. For instance, framed boxes behind groups of keys can be filled with
color to make the groupings more noticeable.

You can position a frame behind or in front of keys and other objects using the Arrange
feature.

Is a frame the same as a “free shape?”

Yes. User manuals for previous versions of Overlay Maker used the term “free shape” to
refer to a frame drawn on an overlay using the Key Tool and a [Ctrl]+click and drag action
or [Command]+click and drag action.

Frame: Creating
How do I create a frame on an overlay?

1. Click the Frame Tool button or select Frame Tool from the Overlay Maker menu.

2. Place the pointer on the overlay where you want a corner of the frame to be, and drag
the pointer in any direction. When you release the mouse, the frame displays on the
overlay. It is already selected (notice the white resizing handles). 

To align a selected frame with the overlay grid (even if the grid is hidden), select
the Snap to Grid option from the Overlay Maker menu. Reposition the frame and
it aligns to the grid.

3. (Optional) Resize and/or reposition the frame.

4. (Optional) Edit border properties (i.e., color the border and set a new border width).

5. (Optional) Edit fill properties (i.e., fill the frame with a color and/or pattern).

Frame: Selecting
How do I select a frame on an overlay?

1. Click the Select Tool button or choose Select Tool from the Overlay Maker menu.

2. Click the frame that you want to be selected.

3. Notice the white resizing handles on the border of the selected frame.

The initial shape
of the outline
drawn using the
Frame Tool is

determined by the
program’s default
settings or the previous
Shape button selections.

The width and
color of the
border around

the frame, and the fill
color are determined by
the program’s default
settings or the previous
Border and Line Width
button, Border and Line
Color button, and Fill
Color button selections.
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Frame: Changing the Shape of Frames
How do I change the shape of a selected frame (e.g., change a circle to a star) on
an overlay?

1. Select the frame on the overlay that you want to switch.

2. Click the Shape button to display a choice of shapes (i.e., rectangle, triangle, circle,
etc.).

3. Select a different shape from the choices displayed by the Shape button.

Frame: Resizing
How do I resize a frame on an overlay?

1. Select the frame. White resizing handles show on the border of the frame.

2. Place your pointer on a resizing handle. The pointer shows as a double-headed arrow.

3. Drag the resizing handle in either direction the arrow points.

Frame: Repositioning
How do I reposition a frame on an overlay?

1. Choose the Select Tool. 

2. Position the mouse pointer on the frame.

3. When the mouse pointer shows as a hand icon, grab and drag the frame to the desired
position on the overlay.

Frame: Using Arrange Options (Bring Forward, Send Backward, etc.)
Using the Arrange feature, you can position a frame behind or in front of keys and other
objects.

How do I bring a frame forward or send it towards the back if I want it to overlap,
or be overlapped by, other objects on the overlay?

1. Select the frame.

2. Select an Arrange option from the Edit menu (or right-click to display the same options
listed on the pop-up menu).

Frame: Fixing to Background
You can make a frame a permanent part of the background picture. Once it has been “fixed
to background”, the frame cannot be selected, repositioned, or deleted.

How do I fix a frame to the background?

1. Select the frame.

2. Click the Fix to Background button. 

The Bring
Forward and Send
Backward

commands move an
object incrementally
between the foreground
and background. The
Bring to Front and Send
to Back commands move
an object directly to the
foreground or to the
background.
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Properties of Frame
The appearance of a selected frame can be
changed by selecting different options in
its Properties dialog box.

How do I display the Properties dialog
box for a selected frame?

There are multiple ways to display the
Properties of Frame dialog box for a
selected frame:

• Method 1 – With the cursor positioned
over the frame, right-click the mouse to display the pop-up menu. Select Properties....

• Method 2 – Simultaneously press the [Ctrl] key on a standard keyboard and click the
frame to display the pop-up menu. Select Properties....

• Method 3 – Select Properties... from the Edit menu.

• Method 4 – Click the Properties button on the Advanced Toolbar.

How do I color the border of a selected frame and/or set a new border width
using its Properties dialog box?

1. Display the frame’s Properties dialog box.

2. Select (i.e., check) the Show Border or Line option from the Appearance tab. The
current border color shows in the preview box.

3. To change the border color, click Change. The Pick Color dialog box displays. Choose
a different color and click OK to close the Pick Color dialog box.

4. Select the desired border width (1–10).

5. Click Apply to preview selections. Click OK to close the Properties dialog box.

How do I fill a selected frame with a color or a pattern using its Properties dialog
box?

1. Display the frame’s Properties dialog box.

2. Select (i.e., check) the Show Fill option from the Appearance tab. The current fill color
shows in the preview box.

3. To change the fill color, click Change. The Pick Color dialog box displays. Choose a
different color and click OK to close the Pick Color dialog box.

4. Click Apply to preview selections. Click OK to close the Properties dialog box.

Using the Select
Tool, double-click
the frame to
display the

Properties of Frame
dialog box.
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Frame: Changing Appearance Using On-Screen Tools Buttons
How do I color the border of a frame using the Border and Line Color button?

1. Select the frame. The current border color shows on the Border and Line Color button.

2. Click the Border and Line Color button to display a choice of colors.

3. Select the desired color. (Note: Selecting the last color choice, a box with a red slash,
will hide the border.)

How do I set the border width of a frame using the Border and Line Width
button?

1. Select the frame. The current border width shows on the Border and Line Width
button.

2. Click the Border and Line Width button to display a choice of line widths.

3. Select the desired line width.

How do I fill a frame with a color or a pattern using the Fill Color button?

1. Select the frame. The current fill color shows on the Fill Color button.

2. Click the Fill Color button to display a choice of colors and patterns.

3. Select the desired fill color and/or pattern.

Why would I fill a frame with a pattern?

Using patterns, instead of solid fill colors, conserves ink when printing the overlay.

Frame: Deleting
How do I delete a frame on an overlay?

1. Select the frame.

2. Press the [Delete] key on a standard keyboard or select Clear from the Edit menu or
click the Cut button (on the toolbar above the overlay).
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Working with Lines

Lines: General Information
Lines are added to an overlay using the Line Tool.

Each line has properties—you can select a line color and a line width. Lines are not
interactive. 

Why add lines to an overlay?

For instructional and/or decorative purposes, it is often useful to add lines to a printed
overlay. 

Using the Arrange feature, you can position a line behind or in front of keys and other
objects.

Line: Creating
How do I create a line on an overlay?

1. Click the Line Tool button or select Line Tool from the Overlay Maker menu.

2. Place the pointer on the overlay where you want one end of the line to be, and drag the
cursor in any direction. When you release the mouse, the line displays on the overlay. It
is already selected (notice the resizing handles). 

To align a selected line with the overlay grid (even if the grid is hidden), select
the Snap to Grid option from the Overlay Maker menu. Reposition the line and it
aligns to the grid.

3. (Optional) Resize and/or reposition the line.

4. (Optional) Edit line properties (i.e., choose a different line color and set a new line
width).

Line: Selecting
How do I select a line on an overlay?

1. Click the Select Tool button or choose Select Tool from the Overlay Maker menu.

2. Click the line that you want to be selected.

3. Notice the resizing handles on the ends of the line.

Line: Resizing
How do I resize a line (i.e., make the line shorter or longer) on an overlay?

1. Select the line. Resizing handles show on the ends of the line.

2. Place your pointer on a resizing handle. The pointer shows as a double-headed arrow.

3. Drag the resizing handle in either direction the arrow points.

The width and
color of the line
are determined

by the program’s default
settings or the previous
selections.
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Line: Repositioning
How do I reposition a line on an overlay?

1. Choose the Select Tool. 

2. Position the mouse pointer on the line.

3. When the mouse pointer shows as a hand icon, grab and drag the line to the desired
position on the overlay.

Line: Changing Direction
How do I change the direction of a line (i.e., to change its “angle”) on an overlay?

1. Select the line.

2. Drag an endpoint to the desired position.

Press [Shift] and rotate the line to “snap” it to vertical, horizontal, or 45 degree
angles.

Line: Using Arrange Options (Bring Forward, Send Back, etc.)
Using the Arrange feature, you can position a line behind or in front of keys and other
objects.

How do I bring a line forward or send it towards the back if I want it to overlap,
or be overlapped by, other objects on the overlay?

1. Select the line.

2. Select an Arrange option from the Edit menu (or right-click to display the same options
listed on the pop-up menu).

Line: Fixing to Background
You can make a line a permanent part of the background picture. Once it has been “fixed to
background”, the line cannot be selected, repositioned, or deleted.

How do I fix a line to the background?

1. Select the line.

2. Click the Fix to Background button.

Line: Deleting
How do I delete a line on an overlay?

1. Select the line.

2. Press the [Delete] key on a standard keyboard or select Clear from the Edit menu or
click the Cut button (on the toolbar above the overlay).
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Properties of Line
How do I display the Properties dialog
box for a selected line?

There are multiple ways to display the
Properties of Line dialog box for a selected
line:

• Method 1 – With the pointer
positioned over the line, right-click the
mouse to display the pop-up menu.
Select Properties....

• Method 2 – Simultaneously press the [Ctrl] key on a standard keyboard and click the
line to display the pop-up menu. Select Properties....

• Method 3 – Select Properties... from the Edit menu.

• Method 4 – Click the Properties button on the Advanced Toolbar.

How do I color a selected line and/or set a new line width using the Properties
dialog box?

1. Display the Properties dialog box. The current line color shows in the preview box.

2. (Optional) Click Change. the Pick Color dialog box displays. Choose a different color
and click OK to close the Pick Color dialog box.

3. Select the desired line width (1–10).

4. Click Apply to preview selections. Click OK to close the Properties dialog box.

Line: Changing Appearance Using On-Screen Tool Buttons
How do I color a selected line using the Line Tool?

1. Select the line. The current line color shows on the Border and Line Color button.

2. Click the Border and Line Color button to display a choice of colors.

3. Select the desired color.

How do I change the width of a selected line using the Border and Line Width
button?

1. Select the line. The current line width shows on the Border and Line Width button.

2. Click the Border and Line Width button to display a choice of line widths.

3. Select the desired line width.

Using the Select
Tool, double-click
the line to display
the Properties of

Line dialog box
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Working with Pictures (i.e., Free Pictures)

Pictures: General Information
Pictures are added to an overlay by inserting pictures from Overlay Maker 3’s Picture
Library, inserting pictures from other sources (such as digital photographs), or by pasting
pictures from your clipboard.

Each picture has properties, enabling it to be flipped or rotated. Picture objects are not
interactive—pressing one will not result in an on-screen action.

Why add pictures to an overlay?

For identification, instructional and/or decorative purposes, it is often useful to add one or
more pictures to a printed overlay in addition to, or instead of, the pictures that appear on
keys. 

Using the Arrange feature, it is possible to position a picture behind or in front of keys and
other objects.

Can I add a large picture to the overlay in place of a background?

Yes. Place the picture on the overlay, enlarge the picture if needed, and use the Send to
Back feature to place the picture behind all other objects on the overlay.

The picture will appear to be on the background, even if it is not on the actual background
layer.

Picture: Inserting/Pasting on an Overlay
How do I place a picture on an overlay?

There are multiple ways to place a picture on an overlay:

Inserting a Picture From the Picture Library
With no objects on the overlay selected:

1. Select Insert Picture From Library from
the Edit menu or click the Picture Library
button. The Picture Library dialog box
displays. 

2. (Optional) If Boardmaker 5 is installed on
your system, choose a library.

3. Search for and/or select the desired
picture. 

4. Click Insert. A message box displays
asking you to confirm that you are pasting
a picture on the overlay, not on a key.
(Note: If you are inserting multiple pictures,
you can choose not to have this message display.)

5. Click OK to proceed. The selected picture inserts on the overlay.

6. (Optional) Reposition and/or resize the picture.

To insert a picture
from the
Boardmaker PCS

Library, you must have
Boardmaker 5 (or a more
recent program version)
installed on your system.
The Boardmaker CD
does not have to be
inserted in your CD-ROM
drive for you to select
Boardmaker pictures.
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Inserting a Picture From the Picture Library Toolbar 
With no objects on the overlay selected:

1. Select Show Picture Library from
the View menu. The Picture
Library dialog box displays as a
toolbar below the overlay.

2. Search for and/or select the
desired picture. 

3. Click Insert. A message box
displays asking you to confirm that
you are pasting a picture on the
overlay, not on a key. 

4. Click OK to proceed. The selected
picture inserts on the overlay.

5. (Optional) Reposition and/or resize
the picture.

Inserting a Picture From a File
With no objects on the overlay selected:

1. Select Insert Picture From File from the Edit menu or click the Insert Picture From
File button. The Open dialog box displays.

2. Navigate to the desired file.

3. Select the desired picture.

4. Click Open. The selected picture inserts on the overlay.

5. (Optional) Reposition and/or resize the picture.

Pasting a Picture From the Clipboard
1. Copy the picture you wish to add to the overlay to your clipboard.

2. Select Paste from the Edit menu or click the Paste button. The selected picture is
pasted on the overlay.

Picture: Selecting
How do I select a picture on an overlay?

1. Click the Select Tool button or choose Select Tool from the Overlay Maker menu.

2. Click the picture that you want to be selected.

3. Notice the resizing handles on the borders of the picture.

Picture: Resizing
How do I resize a picture on an overlay?

1. Select the picture. Resizing handles show on the borders of the picture.

2. Place your cursor on a resizing handle. The pointer shows as a double-headed arrow.

3. Drag the resizing handle in either direction the arrow points.

You can search
the Picture Library
Toolbar by
category, or select

All Pictures. Pictures are
listed alphabetically.
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Picture: Repositioning
How do I reposition a picture on an overlay?

1. Choose the Select Tool. 

2. Position the mouse pointer on the picture.

3. When the mouse pointer shows as a hand icon, grab and drag the picture to the
desired position on the overlay.

Picture: Flipping and/or Rotating
How do I flip a selected picture on an overlay?

1. Display the Properties of Picture dialog box. Notice that the selected picture shows in
the picture tab.

2. Click the Flip Horizontally and/or Flip Vertically buttons.

3. Click Apply to preview selections. Click OK to close the Properties dialog box.

How do I rotate a selected picture on an overlay?

1. Display the Properties dialog box. Notice that the selected picture shows in the picture
tab.

2. Click the Rotate Clockwise and/or Rotate Counterclockwise buttons.

3. Click Apply to preview selections. Click OK to close the Properties dialog box.

Picture: Using Arrange Options (Bring Forward, Send Backward, etc.)
Using the Arrange feature, it is possible to position a picture behind or in front of keys.

How do I bring a picture forward or send it towards the back if I want it to
overlap, or be overlapped by, other objects on the overlay?

1. Select the picture.

2. Select an Arrange option from the Edit menu (or right-click to display the same options
listed on the pop-up menu).

Picture: Fixing to Background
You can make a picture a permanent part of the background picture. Once it has been
“fixed to background”, the picture cannot be selected, repositioned, or deleted.

How do I fix a picture to the background?

1. Select the picture.

2. Click the Fix to Background button. 
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Properties of Picture
How do I display the Properties dialog box for a selected picture?

There are multiple ways to display the Properties of Picture dialog box for a selected
picture:

• Method 1 – With the cursor positioned over the picture, right-click the mouse to
display the pop-up menu. Select Properties....

• Method 2 – Simultaneously press the [Ctrl] key on a standard keyboard and click the
picture to display the pop-up menu. Select Properties....

• Method 3 – Select Properties... from the Edit menu.

• Method 4 – Click the Properties button on the Advanced Toolbar.

How do I edit the properties of a selected picture?

1. Display the Properties dialog box. Notice that the selected picture shows in the picture
tab.

2. Use the tools in the toolbar above the preview box to:

• Delete the picture (using the Clear button).

• Place the current picture on your clipboard (using the Cut or Copy buttons).

• Replace the picture (using the Paste, Insert from File, or Insert From Library
button).

• Flip or rotate the picture (using the Transform buttons).

3. Click Apply to preview selections. Click OK to close the Properties dialog box.

Picture: Deleting
How do I delete a picture object on an overlay?

1. Select the picture.

2. Press the [Delete] key on a standard keyboard or select Clear from the Edit menu or
click the Cut button (on the toolbar above the overlay).

Double-click the
picture to select it
and display the
Properties of

Picture dialog box.
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Working with Backgrounds

Background: General
Information
Backgrounds are added to an overlay
using the Background Properties
dialog box. You can add a solid color
background, a patterned background,
or a background picture.

Background pictures are added to an
overlay by inserting pictures from
Overlay Maker 3’s Picture Library,
inserting pictures from other sources
(such as digital photographs), or by pasting pictures from your clipboard.

A background picture has properties, enabling it to be flipped.

A background shows behind all objects on an overlay (keys, text boxes, frames, lines, and
pictures), including those that are “sent to back” using the Arrange feature.

Backgrounds are not interactive.

Why add a background to an overlay?

For identification and/or decorative purposes, it is often useful to add a background to a
printed overlay. 

Background: Adding a Background Picture to an Overlay
How do I add a background to an overlay?

You add a background to an overlay using the Background Properties dialog box.

How do I display the Background Properties dialog box?

• Method 1 – Position the mouse over the background. Right-click the mouse to display
the pop-up menu. Select Background Properties.

• Method 2 – Simultaneously press the [Ctrl] key on a standard keyboard and click the
background. Select Background Properties from the pop-up menu.

• Method 3 – Select Background Properties from the Edit menu.

What types of image files can I use as a background picture?

You can import these image files: GIF, JPG/JPEG, DIB, BMP, PNG, PICT, and PSD.

Can I use a background picture and a background color?

Yes. You can select both using the Background Properties dialog box.
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Background Properties
How do I add a background picture to an
overlay using the Background Properties
dialog box?

There are three ways to add a background picture
to an overlay using the Background Properties
dialog box:

Background: Inserting a Background
Picture From IntelliTools Library
1. Select Insert Picture From Library from the

Edit menu or click the Picture Library button.
The Picture Library dialog box displays. 

2. (Optional) Choose a library. If you have
Boardmaker installed on your system, you will
be able to select from the IntelliTools Picture
Library or from the Boardmaker PCS Library.

3. Search for and/or select the desired picture.

4. Click Insert. The selected picture is previewed in the Background Picture dialog box.

5. Click OK. The picture inserts on the overlay’s background.

Background: Inserting a Background Picture From File
1. Click the Insert From File button. The Open dialog box displays.

2. Navigate to the desired file.

3. Select the desired picture.

4. Click Open. The selected picture inserts on the overlay’s background.

Can I add a large picture to the overlay in place of a background?

Yes. Place the picture on the overlay, enlarge the picture if needed, and use the Send to
Back feature to place the picture behind all other objects on the overlay.

The picture will appear to be the background, even if it is not actually on the Background
layer (i.e., it has no Background Properties).

Background: Pasting a Picture From Clipboard
1. Copy the picture you want to be the background to your clipboard.

2. Select Paste from the Edit menu or click the Paste button. The selected picture is
previewed in the Background Picture dialog box.

3. Click OK. The picture inserts on the overlay’s background.

Background: Resizing
How do I resize a background on an overlay?

1. Display the Background Properties dialog box. Notice that the current background
shows in the Picture tab.
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2. Select Stretch, Center, or Tile.

3. Click OK.

Background: Deleting
How do I delete an overlay background?

1. Display the Background Properties dialog
box(select Background Properties from the
Edit menu). Notice that the current
background shows in the dialog box.

2. Click the Clear button.

3. Click OK 

Background: Flipping
How do I flip a background picture on an
overlay?

1. Display the Background Properties dialog box
(select Background Properties from the Edit
menu). Notice that the current background picture
shows in the Properties dialog box.

2. Click the Flip Horizontally and/or Flip Vertically buttons.

3. Click OK to close the Background Properties dialog box.

Background: Changing Appearance by Editing Picture Properties
How do I edit the properties of a background on an overlay?

1. Display the Properties dialog box (select Background Properties from the Edit menu).
Notice that the current background shows in the dialog box.

2. Use the tools to:

• Delete the current background (using the Clear button).

• Place the current background picture on your clipboard (using the Cut or Copy
buttons).

• Replace the current background picture (using the Paste, Insert from File, or
Insert From Library button).

• Flip the current background picture (using the Transform buttons).

3. Click OK to close the Background Properties dialog box.
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Background: Choosing a
Background Color or Pattern
How do I color a background using
the Properties of Background
dialog box?

1. Display the Background Properties
dialog box (select Background
Properties from the Edit menu).
Notice that the current background
color shows in the Background
Color preview box. 

2. Click Change. The Pick Color
dialog box displays. Choose a
different color and click OK to close the Pick Color dialog box.

3. Click OK to close the Background Properties dialog box.

How do I color a background using the Background Color button?

1. Select the background.

2. Click the Background Color button to display a choice of colors. 

3. Select the desired background color. 

How do I add a pattern to the
background?

1. Select the background.

2. Click the Background Color button
to display a choice of patterns. 

3. Select the desired fill pattern. 

Why would I fill a background with
a pattern?

Using patterns, instead of solid fill
colors, conserves ink when printing the
overlay.

How do I change the color of a
background pattern?

Patterns have two parts, a foreground and a background. To change the:

• Foreground color – Click the Fill Color button and select a color.

• Background color – While pressing the [Ctrl] key, click the Fill Color button, and
select a color. 

Can I use a background picture and a background color?

Yes. You can select both using the Background Properties dialog box.

To change a
pattern to a solid
fill, click the first
choice (black
square) in the

pattern box.
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Making a New Overlay: Preparation
There are four things to do before you make an overlay using Overlay Maker 3:

1. Decide the overlay’s purpose. 

2. Determine its basic layout and appearance.

3. Connect a printer and IntelliKeys to your computer. 

4. Launch Overlay Maker 3.

Making a New Overlay: Using a Blank Overlay
How do I make an overlay using a blank overlay?

1. From the Navigation Screen, click the New button.

2. Select and open the Blank Overlay. A new (blank) overlay displays.

3. Add one or more keys to the overlay. Add different or additional key content to the
key(s) if the default key content [Same As text Label] is not the needed key content.
Edit the appearance of the key(s). Add a text label and/or key picture. Position key(s).

4. (Optional) Click the Cycle Views button or select a view from the View menu to show
the overlay in the size that helps you best lay out objects on the overlay.

5. (Optional) Add one or more objects to the overlay (text boxes, frames, lines, and/or
pictures). Edit the appearance of the object(s). Position and or arrange objects(s).

6. (Optional) Add a background color or background picture to the overlay.

7. Edit the switch content, if needed.

8 Save the overlay file.

9. Print the overlay.

You can create an
overlay without
having an

IntelliKeys connected;
however, you will not be
able to test the overlay.

You can create an
overlay without
having a printer

connected; however, you
will not be able to print
the overlay.
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Making a New Overlay: Using an Overlay Activity Kit
See Chapter 13 for detailed information about using Overlay Activity Kits.

How do I navigate to an Overlay Maker 3 Overlay Activity kit?

1. From the Navigation Screen, click the New button.

2. Select and open the Overlay Activity Kits folder.

3. Select and open the desired subfolder(s).

What does an Overlay Activity Kit contain?

Overlay Activity Kits contain: 

• A tutorial. (You must have the Adobe Reader program installed to view this printable
PDF file.)

• One or more overlays.

• Shortcuts to one or more activities. (Opening an activity automatically launches
IntelliTools Classroom Suite)

• One or more templates. (Templates are designed to be modified).

How do I make a new overlay using an Overlay Activity kit?

Each Overlay Activity kit includes an easy-to-follow, step by step tutorial that will instruct
you how to make a new overlay. Depending on the Overlay Activity Kit you are working
with, you will make an overlay using Overlay Maker 3 or the IntelliTools Classroom Suite
Make Overlay feature.

Using Overlay Maker 3:

• Some kits contain an Overlay Maker 3 overlay template. Templates are designed to be
modified. Using Overlay Maker 3, you can customize the overlay template and save it
as a new overlay file.

• Some kits contain a predesigned Overlay Maker 3 overlay, ready to use. Using Overlay
Maker 3, you can edit the overlay and save it as a new overlay file.

Using IntelliTools Classroom Suite:

• Some kits contain an IntelliTools Classroom Suite template. Templates are designed to
be modified. Using IntelliTools Classroom Suite, you can customize the template to
create a new activity. 

Then, using the IntelliTools Classroom Suite Make Overlay feature, you can generate a
matching overlay. The Make Overlay automatically saves the new overlay (in the
IntelliTools Classroom Suite Overlays folder) and launches Overlay Maker 3 (to enable
you to edit the new overlay, if needed).

• Some kits contain a predesigned IntelliTools Classroom Suite activity, ready to use.
Using IntelliTools Classroom Suite, you can edit the activity to create a new activity. 

Then, using the IntelliTools Classroom Suite Make Overlay feature, you can generate a
matching overlay. The Make Overlay automatically saves the new overlay (in the
IntelliTools Classroom Suite Overlays folder) and launches Overlay Maker 3 (to enable
you to edit the new overlay, if needed).

To modify
IntelliTools
Classroom Suite

templates and activities,
you must have the full
program installed on
your system.
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Making a New Overlay: Using a Predesigned Layout
How do I navigate to a selection of predesigned overlay layouts?

1. Click the New button.

2. Select and open the Predesigned Layouts folder.

3. Select and open the desired subfolder.

How do I make a new overlay using a predesigned layout?

1. Click the Cycle Views button or select a view from the View menu to show the overlay
in one of three ways.

2. (Optional) Add one or more keys to the overlay. Add different or additional key content
to the key(s) if the default key content [Same As text Label] is not the needed key
content. Edit the appearance of the key(s). Add a text label and/or key picture.

3. Delete unneeded keys.

4. Reposition keys, if needed.

5. (Optional) Add one or more objects to the overlay (text boxes, frames, lines, and/or
pictures). Edit the appearance of the object(s). Position and or arrange objects(s).

6. Delete unneeded objects.

7. Reposition objects, if needed.

8. (Optional) Add a background color or background picture to the overlay.

9. Edit the switch content, if needed.

10. Save the overlay file.

11. Print the overlay.

Try the 
Overlay Maker 3
tutorials (see
chapter 3 of this

User’s Guide) to learn
about Overlay Maker 3's
many features.
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Making a New Overlay: To Work with Other Software Programs
Creating an overlay to work with computer programs other than IntelliTools Classroom
Suite requires:

• An understanding of how the program is used with a standard keyboard and a standard
mouse. 

• Knowing what the IntelliKeys user would find difficult to do when using the standard
keyboard and/or the standard mouse. 

These two pieces of information determine what type of access you want your overlay(s) to
provide to the user and how you can best design the overlay.

For example, to provide access to the program to a physically challenged IntelliKeys user,
you might need to modify the keyboard layout used on a standard keyboard. The overlay
you make might have keys in different places or fewer keys. For a visually impaired
IntelliKeys user, you might want to enlarge and/or increase the color contrast of the keys
compared to a standard keyboard. Or you may want the IntelliKeys user to be able to type
words, phrases, or paragraphs by pressing just one overlay key. 

How do I make an overlay that works with my computer program?

In many instances, an IntelliKeys user can best interact with a program by taking advantage
of the keyboard shortcuts built into that program. 

What is a keyboard shortcut?

A keyboard shortcut is a combination of keys that can be substituted for a menu command
and/or on-screen toolbar choices. Pressing this combination of keys on a standard
keyboard results in the same action as selecting a menu listing or clicking a button. 

For example, for Microsoft Word, Ctrl+C (Windows) or Cmd+C (Macintosh) is the
keyboard shortcut for Copy (i.e., simultaneously pressing the Ctrl and the C keys makes a
copy of a selection). Ctrl+V (Windows) or Cmd+V (Macintosh) is the keyboard shortcut for
Paste (i.e., simultaneously pressing the Ctrl and the V keys will paste a selection). 

Typically, you can find keyboard shortcuts listed next to menu options. To find more
keyboard shortcuts, search the program’s Help or refer to the program’s User’s Guide. 

Search Windows Help for the topic “Shortcut Keys.” Search Macintosh OS X Help
for the topic “Full Keyboard Access.”

How do I use a keyboard shortcut with Overlay Maker 3?

1. Create a key on an overlay.

2. Display the Key Content tab of the Properties of Key dialog box. (Double-clicking a
selected key is one way to display this dialog box.)

3. Enter the keyboard shortcut as the key content. Use the available Key Actions (add an
action from the Keyboard Keys category listings) when possible.

For example, [Control]c is the key content for the Copy command; [Control]v is the
key content for the Paste command. 

When the IntelliKeys user presses this key, the corresponding command is sent to the
computer—without the use of a standard keyboard or standard mouse.

Try the 
Overlay Maker 3
tutorials (see
chapter 3 of this

User’s Guide) to learn
about Overlay Maker 3's
many features.
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What if the program I’m using requires a mouse point-and-click response? 

1. Create a key on an overlay.

2. Display the Key Content tab of the Properties of Key dialog box. (Double-clicking a
selected key is one way to display this dialog box.)

3. Enter the keyboard shortcut as the key content. Use the available Key Actions (add an
action from the Mouse Actions category listings).

When the IntelliKeys user presses this key, the corresponding mouse command is sent to
the computer—simulating the use of a standard mouse. For example [Button Click] sends
a mouse click to the computer.

IntelliTools Classroom Suite’s Make Overlay feature automatically creates overlay keys that
enable an IntelliKeys user to access on-screen buttons. For example [Function Key 12]next
page[Enter][Non Repeating] will activate a button named Next Page.

How do I make an overlay so that an IntelliKeys user can interact with switch
accessible programs?

1. Determine what standard keyboard or standard mouse input a switch accessible
program responds to by referring to that program’s User’s Guide (Tip: Search for the
topic “Setting up Switches.”)

2. Edit the overlay’s switch content to select the desired input. 

For instance, to have a switch send a mouse click, set the IntelliKeys switch #1 Switch
Content to [Button Click]. Or if the automatic scan keyboard shortcut is Control+Enter,
set the IntelliKeys switch #1 Switch Content to [Control][Enter].
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Making a New Overlay: For DynaVox Users
Overlays made from IntelliTools Classroom Suite documents can be saved as DynaVox-
compatible files so DynaVox users can work with IntelliTools Classroom Suite activities.

You must be using DynaVox Series 4 with software version 1.05 (or a more recent version).

How do I make an overlay for a DynaVox user?

1. Save your overlay as an overlay (an .oms file) or a template (an .omt file) using Overlay
Maker 3. Do not close the overlay.

2. From the File menu, choose Export to DynaVox. This will create a DynaVox Series 4
file (file name.dpkg) on your desktop.

3. Move the DynaVox Series 4 file (file name.dpkg) to the DynaVox using a USB memory
stick or other media transfer device previously formatted for your DynaVox Series 4
device.

4. Connect the DynaVox AccessIT module to the USB port of the computer running
IntelliTools Classroom Suite.

5. On the DynaVox Series 4 device, navigate to the exported overlay file (file name.dpkg)
and open it. 

6. On the computer, open the corresponding IntelliTools Classroom Suite activity.

7. Point the DynaVox Series 4 device in the direction of the AccessIT module and use the
DynaVox page (file name.dpkg) to communicate with the selected IntelliTools
Classroom Suite activity.

For technical questions, contact your DynaVox technical support representative.
Phone 1-800-344-1778, email tech@dynavoxsystems.com, or visit the Web site:
www.dynavoxsystems.com.
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This chapter explains how Overlay Maker 3 is used with IntelliTools Classroom Suite. Once
installed on a computer with IntelliTools Classroom Suite, Overlay Maker 3 launches
automatically when a user selects the IntelliTools Classroom Suite Make Overlay or
Edit/Attach Overlay feature. 

Using IntelliTools Classroom Suite with IntelliKeys and overlays is an ideal solution
for students who have difficulty using a standard mouse or a standard keyboard. 

IntelliTools Classroom Suite: Making a New Overlay Using
Overlay Maker 3
If you are working with an IntelliTools Classroom Suite document(for instance, if you are
designing an activity) and want to create an overlay, Overlay Maker 3 must be installed on
your computer. Once installed, Overlay Maker 3 launches automatically when you select
Make Overlay from the IntelliTools Classroom Suite IntelliKeys menu options. 

Make Overlay
With Overlay Maker 3 installed, the Make Overlay feature displays as a three-step wizard—
complete a step and click the Next button to proceed. The Make Overlay feature enables
you to create an overlay file based on an open document. 

The first screen of the Make Overlay wizard enables you to select the buttons (toolbar and
page buttons) and regions from a document and include them in an overlay file. When the
overlay file is printed, buttons and regions show as keys on the overlay.

How do I create an overlay file and attach it using the Make Overlay feature?

1. Open the document for which you will create an overlay. This document must have at
least one custom toolbar (button), page button, or region.

2. Select IntelliKeys, Make Overlay from the Options menu. The Make Overlay dialog
box displays. The Make Overlay dialog box contains a list of all toolbar buttons, page
buttons, and regions from the current document (including toolbars that are hidden
from view). 

By default, only toolbar buttons, page buttons, and regions that are currently visible in
the document are pre-selected.

To categorize listings, make a selection from the Show drop-down list box.

3. Wizard Step 1 – Select any additional
toolbars, such as hidden toolbars, that
you want to include in your overlay.
Deselect any toolbars or buttons that you
do not want to include.

4. Click Next to view a selection of
predesigned overlay layouts.

5. Wizard Step 2 – Select a layout. (You
have a chance to modify the layout later
using Overlay Maker 3).

6. Click Next to name the overlay and select
additional options.

If you select
Buttons on Page,
only the page

buttons on the current
page will have keys
created. If you select
Regions on Page, only
the regions on the
current page will have
keys created.

Wizard Step 2 –
Many of the
layout choices

match IntelliKeys Custom
Keyguards.
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7. Wizard Step 3 – Enter a name for the
overlay in the Overlay Name text entry
box. (The default name is the activity
name.)

8. Select additional options, if desired.

• Switch Action:

Select Automatic Scanning – for
single-switch use. Selecting
Automatic Scanning will set the
content of both switch ports on
the IntelliKeys to [Ctrl]+[Enter]
(Windows) or [Ctrl]+[Return]
(Macintosh).

Step Scanning – for use with two
switches. Selecting Step
Scanning will set the content for
switch port 1 to [Ctrl]+[Right
Arrow] and the content for
switch port 2 to [Ctrl]+[Down
Arrow].

• Use Background Picture as Overlay
Background (IntelliMathics 3 and
IntelliPics Studio 3 only) – Uses the
background displayed on the
current page of the open document
as the overlay background.

• Key Appearance:

Use Button Appearance Settings – Uses the button appearance settings when
the corresponding key is generated on an overlay.

Show Button Pictures Only – Shows the button picture (not the button name)
as the key picture when the corresponding key is generated on an overlay.

Show Button Name Only – Shows the button name (not the button picture) as
the key text when the corresponding key is generated on an overlay.

• Show Text Below Picture – Positions the key text below a key picture if both show
on a key.

9. Click OK to attach this overlay to the current document and save it in the IntelliTools
Classroom Suite Overlays folder. Overlay Maker 3 launches to enable you to display
and/or modify this overlay, if needed.

10. (Optional) Overlay Maker 3 displays the selected toolbars as keys on a grid. (The grid
is displayed for alignment purposes and is not printed.) Edit and print the overlay. 

11. From the Overlay Maker 3 File menu, select Save. Exit (or Quit) Overlay Maker 3. The
open IntelliTools Classroom Suite document (see step 1) remains on-screen.

12. Select IntelliKeys from the Options menu. Notice that the name of the new overlay is
listed, because the overlay is now attached to the document.

If, after creating
an overlay, you
rename existing

toolbars in a document,
create new buttons, or
delete buttons, you need
to remake the overlay
using the instructions on
this page.

Make Overlay Wizard Step 2

Make Overlay Wizard Step 3

Note
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You can double-
click a key to see
its content (i.e.,

what the key does).
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IntelliTools Classroom Suite: Including Standard Toolbar Buttons in an
Overlay
The buttons included on Standard Toolbars are not copied into an overlay during the Make
Overlay process, as they are not a permanent part of the original document. However, there
are two ways to include them in an overlay: copying toolbars from the Standard Library into
your document and making an overlay from the modified document, and copying buttons
from the Toolbar Buttons overlay (a predesigned overlay).

How do I use the Standard Library to add Standard Toolbar buttons to an
overlay?

Many of the buttons included on Standard toolbars are included in the Standard Library.
Once these Library toolbars have been added to a document, the buttons on these toolbars
will be selectable to become overlay keys when you use the Make Overlay option.

1. Select Custom Toolbars and Buttons from the Edit menu.

2. Click Add Toolbar... (located in the upper left corner of the screen). The Add Toolbar
dialog box displays.

3. Click the Add from Standard Library tab.

4. Select a custom toolbar from the Standard Library that includes the same Standard
Toolbar buttons you wish to include in a new overlay. The preview box shows the
buttons in the selected toolbar.

5. Click Insert. The selected toolbar is inserted in the open document. The Add Toolbar
dialog box closes (unless you have checked the Stay Open After Insert option).

6. Repeat steps 2–5 for each Library toolbar you want to insert in the document.

7. Click Done. 

8. Make an overlay using the procedure described in the previous section Making a New
Overlay.

How do I use the Toolbar Buttons Overlay to add Standard Toolbar buttons to an
overlay?

A Toolbar Buttons overlay is provided for you in the Overlays folder. The keys included on
this overlay represent Standard Toolbar buttons.

1. Launch Overlay Maker 3.

2. At the Navigation Screen, click the
Overlays button.

3. Navigate to and select the Shortcut
to IntelliTools Classroom Suite
Overlays subfolder (this shortcut
opens the Overlays folder in the
IntelliTools Classroom Suite
program folder).

4. Select the Toolbar Buttons overlay.
Click Open.

Tip

Toolbar Buttons overlay
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Once the overlay
is displayed, you
can change the

placement of keys by
dragging them to the
desired location. See
chapter 8 for additional
editing options.
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5. Select the key from the Toolbar Buttons Overlay that you wish to include in the new
overlay.

6. Select Copy from the Edit menu.

7. Select New from the File menu to display the Navigation Screen.

8. From the New folder, select and open Blank Overlay.

9. Select Paste from the Edit menu.

10. Repeat steps 5–9 for each key you wish to copy from the Toolbar Button Overlay to the
new overlay.

11. Select Save from the File menu.

12. Exit/Quit Overlay Maker 3.

Note
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IntelliTools Classroom Suite: Programming Switches Using
Overlay Maker 3
When using IntelliKeys additionally as a switch interface, you can program the switch ports
by creating an overlay file for the IntelliTools Classroom Suite open document using the
Make Overlay feature. (Overlay Maker 3 must be installed.) 

How do I set switch content using the Make Overlay feature?

1. Refer to page 121 and follow Make Overlay steps 1–7. 

2. At step 8, from the Switch Action area in the Make Overlay dialog box, select either
Automatic Scanning or Step Scanning, depending on the needs of the switch user.

3. Finish creating an overlay. The resulting overlay file contains the desired switch
commands.

4. Open the document. When the attached overlay file is sent to IntelliKeys, the switch
ports are programmed automatically.

When working with Overlay Maker 3, switch content can be set using the Edit
Content of Switches dialog box. To display this dialog box, select Switches... from
the Overlay Maker menu or click the Edit Switches button on the vertical Standard
Toolbar.

Edit Content of Switches Dialog Box
There are two ways to select switch content using the Edit Content of Switches dialog box:

• Select content for both switches by making a selection from the Choose Preset drop-
down list box. Click OK to close the Edit Content of Switches dialog box.

• Select content for switches individually. 

a. Click the Edit... button to display a Switch Content dialog box. 

b. Make a selection from the Key Actions drop-down list box and click the Add button
and/or type the  desired content directly into the Content entry box. 

c. Click OK to close the Switch Content dialog box.

d. Click OK to close the Edit Content of Switches dialog box.

IntelliTools Classroom Suite: Displaying an Overlay File
Sometimes it is useful to see what an overlay file looks like (e.g., to see how overlay keys
are arranged, to preview an overlay you want to print, etc.).

How do I display an overlay file attached to a document so I can see what keys
are in the overlay?

1. If Overlay Maker 3 is installed, select IntelliKeys, Attach/Edit Overlays from the
Options menu. The Attach/Edit Overlays box displays.

2. From the Overlay Files list box, select the overlay file you want to display.

3. Click Edit.... Overlay Maker 3 launches automatically and the overlay file displays.

11: Using Overlay Maker 3 with IntelliTools Classroom Suite

Tip
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IntelliTools Classroom Suite: Editing an Attached Overlay
In some instances it may be useful to edit a pre-existing overlay. For example, you might
want to delete some keys that a student could find distracting, reposition some keys to
make them easier to press, or change the color of a key to make it easier to see. Overlay
Maker 3 allows you to edit an overlay that is already attached to a document, or to edit an
overlay that has not yet been attached to a document (perhaps one that another teacher has
already designed). 

How do I edit an attached overlay?

To make changes to an overlay file, you must have Overlay Maker 3 installed. Using Overlay
Maker 3, you can modify the placement of keys and/or change fonts and colors to best suit
the IntelliKeys user. The edited overlay can be saved and printed.

1. Open the document with the attached overlay you want to change. 

2. Select IntelliKeys, Attach/Edit Overlays from the Options menu. The Attach/Edit
Overlays dialog box displays.

3. From the Overlay Files list box, select the overlay you want to modify and click Edit.
Overlay Maker 3 launches automatically and the overlay file displays.

For information about working with overlay keys, text boxes, pictures, backgrounds
etc., refer to chapters 8 and 9.

4. After making the changes, print the edited overlay.

5. Select Save from the Overlay Maker 3 File menu.

6. Select Quit/Exit to close Overlay Maker 3.

When I use Make Overlay, where is the attached overlay saved?

By default, the overlay is saved to the IntelliTools Classroom Suite Overlays folder. If you are
using Overlay Maker 3, you can navigate to this folder easily by clicking the Overlays
button on the Navigation Screen. Click the Shortcut to IntelliKeys Classroom Suite
Overlays folder.

Overlay Maker 3
font and color
options affect the

printed overlay, not the
activity to which the
overlay is attached.

Overlay Maker 3
files cannot be
edited using

previous versions of
Overlay Maker.

Overlay Maker 3 User’s Guide
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IntelliTools Classroom Suite: Attaching an Overlay
More than one overlay can be attached to a document to accommodate the varying needs
of a single student or of students sharing an IntelliKeys. You can choose which overlay to
send to IntelliKeys. However, only one attached overlay can be active at a given time. You
can switch between overlays during an activity.

If you create an overlay using the Make Overlay feature, the overlay is automatically
attached.

How can I tell if a document has an overlay file (or files) already attached to it?

1. Open the document. 

2. Select IntelliKeys from the Options menu to see a list of attached overlays.

How can I tell if an attached overlay was sent to IntelliKeys?

• When a document opens, you should see a message indicating that an overlay is being
sent to IntelliKeys.

• You can also select IntelliKeys from the Options menu to see a list of attached overlays.
The attached overlay most recently sent to IntelliKeys has a check mark next to it. 

How can I attach an overlay file to a document?

1. Open the document.

2. Select IntelliKeys, Attach/Edit Overlays from the Options menu. The Attach/Edit
Overlays dialog box displays.

3. Click Attach. A navigation dialog box displays. If the Overlays folder is not already
showing, navigate to it.

4. Select the overlay file you want to attach to the document and click Open.

5. Click OK. The Attach/Edit Overlays dialog box closes.

6. Save the document.

How do I detach an overlay file from a document?

1. Open the document.

2. Select IntelliKeys, Attach/Edit Overlays from the Options menu. The Attach/Edit
Overlays dialog box displays.

3. From the Overlay Files list box, select the overlay file you want to detach from the
document and click Detach.

4. Click OK. The Attach/Edit Overlays dialog box closes.

5. Save the document.

Attach Edit
The Attach/Edit Overlays dialog box includes:

• Overlay Files list box – Lists the names of all overlays attached to the open document.

• Overlay Location – Shows directory path for selected overlay.

• Attach... – Click to navigate to an overlay that you wish to attach.
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IntelliTools sales
representative or

visit our Web site:
www.intellitools.com
to order preprinted
overlays.
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• Detach – Click to detach the selected overlay from the open document.

• Edit...– Click to open Overlay Maker 3.

IntelliTools Classroom Suite: Sending Overlays
The selected, attached overlay for an IntelliTools Classroom Suite document is sent to
IntelliKeys automatically. If an overlay file is used infrequently, you may not want to attach
it to a document and have it sent automatically to IntelliKeys each time that document is
opened. In that case, you can send an overlay file manually using the IntelliTools Classroom
Suite Options menu’s IntelliKeys, Send Overlay option.

An unattached overlay that is sent using Overlay Sender works only as long as the
associated document is open. If the document is closed or becomes inactive (if you switch
to another document) you must resend the overlay to use it again.

Note
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IntelliTools Classroom Suite: Printing an Overlay
Overlay Maker 3 must be installed on your computer in order to print overlay files for use
with IntelliKeys. You can use IntelliTools’ Overlay Maker 3 to print any IntelliTools
Classroom Suite overlay on legal-size paper using a standard computer printer.

How do I print an overlay file that is attached to a document?

1. If Overlay Maker 3 is installed, select IntelliKeys, Attach/Edit Overlays from the
Options menu. The Attach/Edit Overlays box displays.

2. From the Overlay Files list box, select the overlay you want to print and click Edit....
Overlay Maker 3 launches automatically and the overlay file displays.

3. From the File menu, select Page Setup. The landscape orientation and legal paper
settings are recommended.

4. From the File menu, select Print.

5. Exit/Quit Overlay Maker 3. 

How do I print an overlay file that is not attached to a document?

1. Navigate to and open the IntelliTools Classroom Suite program folder installed on your
computer’s hard drive (or if you are on a network, on the appropriate server).

2. Locate the Overlays folder and open it.

3. Double-click the desired file. If installed, Overlay Maker 3 will launch and open the
overlay file.

4. From the File menu, select Page Setup. The landscape orientation and legal paper
settings are recommended.

5. From the File menu, select Print.

6. Exit/Quit Overlay Maker 3 or Overlay Printer. 
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IntelliTools Classroom Suite: Finding, Saving and Storing
Overlay Files
IntelliTools Classroom Suite overlay files are stored in the Overlays folder, located in the
IntelliTools Classroom Suite program folder. 

Where do I save overlay files I created?

By default, overlays you create using the Make Overlay option will be saved in the
IntelliTools Classroom Suite Overlays folder.

Where do I store overlay files I received from another user?

It is recommended that you store overlays you receive from other users in the Overlays
folder (IntelliTools folder, IntelliTools Classroom Suite folder, Overlays folder).

1. Navigate to and open the IntelliTools Classroom Suite program folder installed on your
computer’s hard drive (or if you are on a network, on the appropriate server).

2. Locate and open the Overlays folder.

3. Save or store all IntelliTools Classroom Suite overlay files in this Overlays folder.

4. Alternately, if you will be exporting your document and overlay, store the overlay file in
the same folder as the document.

Where do I find the Overlays folder with overlay files?

If a document you are working with does not have the desired overlay already attached to
it, you cannot view or print it using IntelliKeys options (listed on the Options menu). In this
case, you need to make a selection from the IntelliTools Classroom Suite Overlays folder.
For instance, you may want to print copies of a preprinted IntelliTools Classroom Suite
overlay, print additional overlay files that you need, or print overlays that you received from
another user.

1. Navigate to and open the IntelliTools Classroom Suite program folder installed on your
computer’s hard drive (or if you are on a network, on the appropriate server).

2. Locate and open the Overlays folder to see a list of overlay file names. Most overlay file
names match the name of the document with which they are associated. 

3. Alternatively, the overlay file may be in the same folder as the document file.

IntelliTools Classroom Suite: Importing and Exporting Files
with Attached Overlays
What happens when I use the IntelliTools Classroom Suite Import and Export
features?

The Import and Export features will collect all the overlay files attached to the document
you are importing or exporting. Imported overlays are stored in the IntelliTools Classroom
Suite Overlays folder.



IntelliTools Classroom Suite: Additional Information
A set of preprinted overlays designed for IntelliTools Classroom Suite activities is available
from IntelliTools. 

IntelliTools Classroom Suite: Using the Preprinted Overlays Supplied
with Overlay Maker 3
Eight preprinted overlays have been supplied to you (four doublesided sheets) for use with
IntelliTools Classroom Suite activities. 

What activity works with each overlay? How do I navigate to and open these
activities?

• I Can Write Word by Word L2. – Works with the Write Word by Word L2 activity.

(Published\Overlay Activity Kits\Language Arts\I Can Write\Writing Word by
Word\Level 2\Shortcut to Write Word by Word L2 Activity)

• Kittens Keyboard – Works with the Keyboard Writing activity. 

(Published\Overlay Activity Kits\Language Arts\I Can Write\Keyboard Writing\Shortcut
to Keyboard Writing Activity)

• The Weather – Works with the Circle Time activity. 

(Published\Overlay Activity Kits\Language Arts\Circle Time\Shortcut to Circle
Activity)

• Journal Writing L4 – Works with the Journal Writing activity. 

(Published\Overlay Activity Kits\Language Arts\Journal Writing\Shortcut to Journal
Writing Activity)

• Patterns and Sports – Works with the Patterns and Sports activity. 

(Published\Overlay Activity Kits\Math\Patterns\Shortcut to Patterns and Sports
Activity)

• Medium Game Board – See the PDF file for game instructions. 

(Published\Overlay Activity Kits\Off-Computer Activities\Off-Computer Activities
Tutorial)

• Simple Sentences 1 – Works with the Simple Sentences activity. 

(Published\Overlay Activity Kits\Language Arts\Simple Sentences\Shortcut to Simple
Sentences Activity) Open the activity and select the corresponding toolbar buttons.

• Simple Sentences 2 – Works with the Simple Sentences activity. 

(Published\Overlay Activity Kits\Language Arts\Simple Sentences\Shortcut to Simple
Sentences Activity). Open the activity and select the corresponding toolbar buttons.
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Using Overlay Maker 3, you can create multiple levels in a single overlay file. Each level
functions as a separate overlay, even though it is part of one file. 

Each level in an overlay is analogous to a page in a document. Similar to working with
pages, you can create a new level, duplicate the current level, delete the current level, and
navigate to the next or previous level. Though an overlay file can contain up to 15 levels,
only one level is active at any one time (the level displayed on-screen).

Multilevel Overlays: FAQ
Why create multiple levels in an overlay?

Using a multilevel overlay enables the IntelliKeys user to quickly and easily change the
functionality of IntelliKeys to match an on-screen activity. Instead of using on-screen menu
commands to send a new overlay file (which requires several steps), the IntelliKeys user
can simply press a key (with “Go To Level...” as key content) on the printed overlay. This
sends the key content on that new level to the IntelliKeys. Depending on the activity, the
printed overlay might need to be changed or not—a single printed overlay can be designed
to work with multiple levels.

How may levels can be included in a single overlay file?

A single overlay file can contain up to 15 levels.

How can I best manage multiple levels in an overlay?

You can best manage multiple levels using the All Levels dialog box.

How do I show the All Levels dialog box?

Select View All Levels... from the Levels menu. The All Levels dialog box displays.

How do I create a new level?

1. Select New Level from the Levels menu or click the New Level button in the All Levels
dialog box. The New Level Name dialog box displays.

2. Enter a new name in the Name text-entry box. You can use any name, but it is helpful
to choose a name that is readily identifiable.

3. Click OK.

How do I duplicate the current level to create a new level?

• Select Duplicate Level from the Levels menu.

• Or click the Duplicate Level button in the All Levels dialog box.

How do I delete the current level?

• Select Delete Level from the Levels menu.

• Or click the Delete Level button in the All Levels dialog box.

How do I rename the current level?

1. Select View All Levels from the Levels menu. The All Levels dialog box displays.

2. Click the Rename Level button. The Rename Level dialog box displays.

3. Enter a new name in the Name text-entry box.

4. Click OK.
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How do I show a level on-screen in a multilevel overlay?

There are multiple ways to show a level:

• Choose Select a Level from the Levels menu and select the desired level.

• Navigate to the desired level by selecting Next Level or Previous Level from the Levels
menu.

• Select the desired level from the All Levels dialog box.

• Click the button displayed below the overlay that corresponds to the desired level.

How do I know what level I am looking at?

There are two ways to know what level you are looking at:

• Using the Status Bar – The current level name and the number of total levels are
displayed on the right side of the Status Bar. To display the Status Bar, select Show
Status Bar from the View menu.

• Viewing the Level button – A button that corresponds to each level displays below the
overlay. Each button is labeled with a level name. The highlighted button indicates the
current level.

How do I make an existing overlay become part of a multilevel overlay? 

1. Select Import Level... from the Levels menu. The Open dialog box displays.

2. Navigate to and select the desired overlay file using standard computer navigation
procedures.

3. Click Open. The New Level Name dialog box displays.

4. Name the level. (Tip: Use a readily identifiable name.)

How do I convert an existing Overlay Maker 2 group overlay to a multilevel
overlay? 

1. Select Open Group... from the File menu. The Open dialog box displays.

2. Navigate to and select the desired overlay file (i.e., for Windows, an .omg file) using
standard computer navigation procedures.

3. Click Open. Each overlay in the group is converted to a single level in a multilevel
overlay. Levels will be named automatically (using a numeric sequence).

4. (Optional) Rename levels.

How do I send the current level to IntelliKeys?

Select Send Current Level from the Levels menu.

This feature is useful to test the function of a single level.

How does the sequence of the levels affect the overlay’s function?

The first level in a multilevel sequence (see the All Levels dialog box) is sent first. The
subsequent order of sending is determined by Go to Level commands (based on level
names).
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All Levels
Use the All Levels dialog box to manage the levels in a multilevel overlay. The All levels
dialog box includes:

• Preview box – A preview of all the levels in the current overlay. Click a level to select it.

• New Level button – Click to display the New Level Name dialog box. Enter a name in
the New Level Name dialog box and click OK. The dialog box closes and a new level is
added to the overlay. A preview of the new level shows in the preview box.

• Delete Level button – Click to delete the selected level. (Note: If there is only one level
in an overlay, you cannot delete it).

• Duplicate Level button – Click to display the New Level Name dialog box. Enter a
name in the New Level Name dialog box and click OK. The dialog box closes and a
new level (a duplicate of the selected level) is added to the overlay. A preview of the
new level shows in the preview box.

• Rename Level button – Click to display the Rename Level dialog box. Enter a new
name in the Rename Level dialog box and click OK. The selected level is renamed.

If you have keys that navigate to a specific level (i.e., the key content is [Go to
Level...]) and you rename a level, the name used in the key content will be
automatically changed to the new level name. 

• Move Toward End button – Click to move the selected level to the right in the preview
box. (If there is only one level in an overlay, this button is dimmed.)

• Move Towards Beginning button – Click to move the selected level to the left in the
preview box. If there is only one level in an overlay, this button is dimmed.

• Display Details... button – Click to show a text file that lists the levels’ numbers, names,
switch content, and keys with Go to Level key content. 

If you contact the IntelliTools Technical Support Department regarding a
problem with a multilevel overlay, to help diagnose the problem you may be
asked to copy and send the text file to IntelliTools.

• View – Select one of three viewing options (2 x 2, 3 x 3, 4 x 4) for the levels displayed in
the preview box.
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Overlay Maker 3 includes a number of overlays and overlay templates to help you begin
using the program quickly and easily. Associated activity files are also provided, so that you
can use the overlays with an on-screen Classroom Suite activity. These activities, overlays,
and templates are grouped together into Overlay Activity Kits. Each Kit also includes a
printable tutorial (PDF).

This chapter provides an overview of these Overlay Activity kits, so that you can select the
ones that are appropriate for your students and their curricular goals. Overlay Activity Kits
are available in the curricular areas of Language Arts, Math, and Braille Access. In
addition, there are Overlay Activity Kits for off-computer activities (Overlay Maker 3 can be
used for purposes other than making IntelliKeys overlays, e.g., making game boards).

Overlay Activity Kits: Suggested Grade Levels

Language Arts PreK     K       1       2       3       3–12
Simple Sentences •            •

Exploring Toys •            •

Preposition Game •            •           •

Circle Time •           •

I Can Write Word by Word •           •           •

I Can Write Letter by Letter •           •           •

I Can Write Keyboard Writing •           •           •

Making Lists •           •           •

Journal Writing •           •           •           •

Math PreK     K       1       2       3       3–12
Exploring Toys •            •

Preposition Game •            •           •

Patterns and Sports •            •           •

Off Computer PreK     K       1       2       3       3–12
Game Boards, Cards, etc. •            •           •

Braille Access PreK     K       1       2       3       3–12
Braille Alphabet •           •           •

Braille Keyboard •           •           •           •             •

BrailleNote GPS® •

Overlay Activity Kits: Language Arts
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Overlay Activity Kits: Language Arts: Simple Sentences
Description
This activity gives students an opportunity to build sentences, quickly and easily. There are
only two keys available on the overlay. The student presses a key with a subject (an animal
or child) and sees the subject on the screen in an IntelliPics Studio 3 activity. In addition,
the text is entered on the screen and is read back to the student. When the student presses
the second key the animal or child performs an action and the completed sentence is read.
Simple Sentences is designed for the very beginning reader or writer.

Objectives/Skills
• Practice building simple sentences.

• Develop sentence structure skills.

Grade Levels
PreKindergarten–Kindergarten

Curricular Area
Language Arts

Standards
• Students employ a wide range of strategies as they write and use different writing

process elements appropriately.

• Students use a variety of technology and information resources to gather and
synthesize information and to create and communicate knowledge.

Overlay Activity Kits: Language Arts: Circle Time
Description
The two overlays contained in the Circle Time Overlay Activity Kit, the The Weather
overlay and Calendar overlay, are examples of ways to use IntelliKeys during circle time
activities. Two associated activities are also included. 

Objectives/Skills
• Participation in classroom activities.

• Practice writing sentences.

• Practice identifying and writing the date.

Grade Levels 
Kindergarten–Grade 1

Curricular Areas
Language Arts, Life Skills

Standards
• Students identify words and construct meaning from text, illustrations, graphics, and

charts, using phonics, word structure, and context clues.

• Students use available technology to compose text.

Refer to the
printable tutorial
in this Overlay
Activity Kit for

easy-to-follow step by
step instructions.
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Overlay Activity Kits: Language Arts: I Can Write Series

Description 
Teaching students how to write is one of the key areas of literacy instruction. Students
need many opportunities to integrate reading and writing to build the necessary skills for
literacy. Because of the challenges of spelling, vocabulary, and penmanship, writing can be
a frustrating process for many students. The I Can Write series uses the strategies of
sentence modeling with prepared word banks. Students who complete the Writing Word by
Word activities can transition easily into highly motivating Writing Letter by Letter activities
and overlays. The I Can Write series provides teachers with a step-by-step method for
teaching beginning writing skills using IntelliKeys, Classroom Suite, and Overlay Maker 3.

The I Can Write series provides teachers with a step by step method for teaching beginning
writing skills using IntelliKeys, Classroom Suite, and Overlay Maker 3. This series includes: 

• Writing Word by Word – Writing Word by Word develops writing fluency by providing
word banks and repetitive sentence patterns that enable students to create a variety of
sentences. Three levels of activities and overlays are provided. Templates are also
provided so teachers can create their own sentence activities and make custom
overlays to accompany them.

• Writing Letter by Letter – Writing Letter by Letter demonstrates a letter-by-letter
approach to writing words and sentences. Students work on spelling and letter sounds
with a word they have seen several times in the Word by Word activities, kittens.
Templates are provided for creating Letter by Letter activities for 3, 5, 7, and 9 letter
words, along with directions for creating custom overlays.

• Keyboard Writing – Keyboard Writing offers a simple strategy for painlessly
introducing students to a standard keyboard layout. Only the letters needed to spell a
single word, “kittens,” are marked on the keyboard overlay. The keyboard layout used
on the kittens keyboard is an alphabetical layout as young students have been exposed
to alphabetical order. The My Words box is used to focus the student’s spelling on
words that can be written with the letters from the word “kittens.” The templates
provided can be used when writing words other than kittens.

Objectives/Skills
• Developing writing fluency.

• Practicing reading and writing sight words.

• Developing sentence structure skills.

• Developing spelling proficiency by limiting letter choices and promoting success.

Grade Levels 
Kindergarten–Grade 2

Curricular Area 
Language Arts

Standards 
Students employ a wide range of strategies as they write and use different writing process
elements appropriately.

Refer to the
printable tutorial
in this Overlay
Activity Kit for

easy-to-follow step by
step instructions.
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Overlay Activity Kits: Language Arts: Making Lists
Description
Being able to write lists helps students learn to organize their world, plan ahead, and
practice spelling skills. The Making Lists Overlay Activity Kit contains two different
overlays designed with highly motivating themes of food and shopping. In addition, the kit
includes a template overlay so you can create additional activities that reflect current areas
of study or specialized interests of the student.

Objectives/Skills
• Students employ a wide range of strategies.

• Students organize their thinking.

Grade Levels 
Kindergarten–Grade 2

Curricular Areas 
Life Skills, Language Arts

Standards
• Students match oral words to printed words.

• Students identify words and construct meaning from text, illustrations, graphics, and
charts, using phonics, word structure, and context clues.

• Students use available technology to compose text.

Overlay Activity Kits: Language Arts: Journal Writing
Description
The Journal Writing Overlay Activity Kit includes four levels of journal writing overlays.
These levels enable students to develop sophisticated writing skills that include language
comprehension; sentence structure; use of past, present, and future tenses; and writing
independence. The overlays provide a supported learning environment so students develop
writing confidence through success. The Journal Writing series can be used with the
CLassroom Suite activity included in the kit, or with any talking word processor. 

Objectives/Skills
• Develop writing fluency.

• Practice reading sight words.

• Develop sentence structure skills.

Grade Levels 
Kindergarten–Grade 3

Curricular Area 
Language Arts

Standards 
• Student writes to communicate ideas and information effectively.

• Student uses emergent writing skills to write in a variety of forms.

• Student uses complete sentences.

Refer to the
printable tutorial
in this Overlay
Activity Kit for

easy-to-follow step by
step instructions.
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Overlay Activity Kits: Language Arts and Math

Overlay Activity Kits: Language Arts and Math: Exploring Toys 

Description
When using Exploring Toys, students explore attributes of color, number, and movement
by interacting with toys. In this cause and effect activity, students select an attribute for a
toy (such as color) and immediately see the effect of their choice on screen. Support for
literacy is provided by building sentences (on the computer screen and read aloud) that
reflect student choices.

Objectives/Skills
• Explore numerical value through 3.

• Explore the attributes of size and color.

• Explore different movement patterns.

Grade Levels
PreKindergarten–Kindergarten

Curricular Areas 
Language Arts, Math

Standards
• Number and Operations: Understand numbers, ways of representing numbers,

relationships among numbers, and number systems.

• Problem Solving: Build new mathematical knowledge through problem solving.

Overlay Activity Kits: Language Arts and Math: Preposition Game

Description
Prepositions are used to express spatial relations of both location and direction. In both
Language Arts and Math, understanding prepositions is critical. This activity introduces
students to simple prepositions using items that are found around the home. 

Objectives/Skills
Build an understanding of prepositions.

Grade Levels
PreKindergarten–Grade 1

Curricular Areas 
Language Arts, Math

Standards
Problem solving: Build new mathematical knowledge through problem solving.

Refer to the
printable tutorial
in this Overlay
Activity Kit for

easy-to-follow step by
step instructions.
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Overlay Activity Kits: Math

Overlay Activity Kits: Math: Patterns and Sports

Description
Students use this activity to practice recognizing and extending patterns using popular
sports themes. The sports theme motivates students to extend their knowledge and to
complete challenging pattern activities.

Objectives/Skills
• Identify objects and their names.

• Discriminate among various objects.

• Recognize and continue a pattern.

• Create patterns.

Grade Levels
PreKindergarten–Grade 1

Curricular Area
Math

Standards
Problem solving: Build new mathematical knowledge through problem solving.

Refer to the
printable tutorial
in this Overlay
Activity Kit for

easy-to-follow step by
step instructions.
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Overlay Activity Kits: Braille Access
Bruce McClanahan, Assistive Technology Specialist in Vancouver, WA, has developed a
series of three Overlays designed for students who are learning Braille. The Braille
activities address the core curriculum for students who are blind.

Overlay Activity Kits: Braille Access: Braille Alphabet

Description
Students use this Overlay Activity Kit to learn the letters in the alphabet as well as to learn
single-letter and whole-word contractions. 

Objectives/Skills
• Learn the basic alphabet.

• Learn single-letter and whole-word contractions.

Grade Levels 
Kindergarten–Grade 2

Curricular Area 
Language Arts

Standards
Students identify letters, words, and sentences.

Overlay Activity Kits: Braille Access: Braille Keyboard

Description
With Braille labels placed over each letter and key on the overlay, the activity is designed to
take advantage of the unique read and delete features of Classroom Suite. Students use this
overlay and activity to practice reading and writing Braille and using simple screen reading
keys. This activity can also be used as training for students who may eventually move into
using screen reader software.

Objectives/Skills
• Basic reading and writing Braille.

• Introduction to screen reading keys.

Grade Levels 
Kindergarten–Grade 12

Curricular Areas
Language Arts

Standards
Students identify letters, words, and sentences.

Refer to the
printable tutorial
in this Overlay
Activity Kit for

easy-to-follow step by
step instructions.
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Overlay Activity Kits: Braille Access: BrailleNote GPS®

Description
The BrailleNote GPS activities are designed to help students, and their orientation and
mobility instructors, learn the commands in the classroom, before taking the BrailleNote
GPS device on the street.

Objectives/Skills
• Enable students to independently learn the keystrokes of the BrailleNote GPS.

Grade Levels 
Grades 3–12

Curricular Areas 
Orientation and Mobility

144 Overlay Maker 3 User’s Guide



Overlay Activity Kits: Off-Computer Activities

Description
Overlay Maker 3 can also be used to create classroom resources for off-computer activities,
as the program can print pages that include shapes, text boxes, pictures, etc. 

Jo Meyer, of SoftTouch, has used Overlay Maker 3 to create a series of off-computer games
for students who need a structured learning environment. These games provide
opportunities to practice skills repeatedly, thus building knowledge. The games target a
variety of cognitive levels, scaffolding skills from beginners to more advanced users.
Multiple levels separate the skills required to play the games into discreet stages.

Game categories include Board Games, Cards, Dominos, and Lotto. Each category
includes overlays at easy, medium, and hard levels.

Objectives/Skills
• Developing an understanding of rules.

• Sequential learning.

• Cooperative play.

Grade Levels
Cognitive age level from 2–7 years old

Curricular Areas
Language Arts, Life Skills

Standards
Students identify words and construct meaning from text, illustrations, graphics, and
charts, using phonics, word structure, and context clues.

Refer to the
printable tutorial
in this Overlay
Activity Kit for

easy-to-follow step by
step instructions.
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Troubleshooting – Installation
The Overlay Maker 3 installer could not install the Overlay Activity Kits. 

Probable cause: IntelliTools Classroom Suite was not found in the current operating
system's Applications folder.

Solution: 

1. Classroom Suite must be installed in the current operating system’s Application
folder in order to use the Overlay Activity Kits.

Troubleshooting – Creating an Overlay
The picture and/or text label is cropped at the edges of the key.

Probable cause: The Autosize Picture setting is off or the picture copied into the key
is larger than the area of the key. Another possibility is that Autosize is on and the
shape of the visible key is not a rectangle.

Solutions:

• Select the key and [Ctrl]+click to open the Properties of Key window, select
Autosize Picture on. 

• Enlarge the size of the key. 

• Select a rectangular shape for the key instead of an irregular shape.

• Reduce the size of the picture before adding it to the overlay key. To reduce the
size of the picture: 

a. Paste it into Paint (Windows) or ClarisWorks (Macintosh) or AppleWorks
(Macintosh).

b. Resize it. 

c. Copy it and paste it back into Overlay Maker 3. 

If your picture requires additional resizing, you will need to use a graphics or photo
editing program to edit your picture.

The picture on the key is not the expected size.

Probable cause: The picture may include large amounts of background surrounding
the picture.

Solutions: 

• Select the key and [Ctrl]+click to open the Properties of Key window;
check/uncheck Autosize Picture.

• Reduce the size of the picture. To reduce the size of the picture: 

a. Paste it into Paint (Windows) or ClarisWorks (Macintosh) or AppleWorks
(Macintosh).

b. Resize it using scaling tools or crop parts of the picture to make it smaller.

c. Copy it and paste it back into Overlay Maker 3. 
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If your picture requires additional resizing, you will need to use a graphics or photo
editing program to edit your picture.

I cannot add a color or pattern to the picture on the key.

Probable cause: Your picture’s surrounding background is not white.

Solution: Copy the picture into a graphics or photo editing program to edit the picture.
Then paste it back into Overlay Maker 3.

I cannot see some of my keys or objects in some of the Views. 

Probable cause: Your keys or objects are outside of the overlay grid.

Solution: From the View menu, select Preview in IntelliKeys.

I cannot paste a picture into my overlay. 

Probable cause 1: You are trying to paste a picture into a (free) text box or text label.

Solution: Use the Select Tool to [Ctrl]+click to open the Properties of Key dialog
window. Click the Picture tab. Click the Paste button. 

Solution: From the Edit menu, select Background Properties. Click the Paste button. 

Solution: Click the Select Tool. Then click an empty area of the overlay grid. Click the
Paste button (or from the Edit menu select Paste or press the shortcut keys [Ctrl]+ v).

Probable cause 2: You are trying to paste an image that is text and graphic.

Solution: Paste the selection into Wordpad (Windows) or ClarisWorks/AppleWorks
(Macintosh). Copy the graphic only. Then paste it in an Overlay Maker 3 key or as a
(free) picture or as a background picture. 

Solution: Launch a “Paint” program. Paste the picture into that program. Save the
picture in the Overlay Maker 3 supported file formats, i.e., GIF, JPG/JPEG, DIB, BMP,
PNG, PSD, and PICT (Macintosh). Import the picture file into Overlay Maker 3.

A key copied from an overlay created using a previous version of Overlay Maker
does not paste in Overlay Maker 3.

Probable cause: Overlay Maker 3 is technically a different program than previous
versions of Overlay Maker. 

Solution: Open your overlay file in Overlay Maker 3. Copy a key from one open overlay
window and paste the key in another open overlay window.
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Troubleshooting – Problems Printing an Overlay
The overlay prints incorrectly on two sheets of paper.

Probable cause 1: Letter or A4 size paper is selected in the Page Setup dialog box.

Solution: Select legal-size paper.

Probable cause 2: Portrait orientation (vertical) is selected in the Page Setup dialog
box.

Solution: Select landscape orientation (horizontal).

Probable cause 3: You do not have legal size paper. 

Solution: In the Page Setup dialog box, select Letter or A4 size paper and select
portrait orientation (vertical).

Keys on the edge of the overlay aren't printed completely.

Probable cause: The Print Area setting for the printer is not large enough.

Solution: Open the Page Setup dialog box. Select a Larger Print Area (Note: For some
printers, you must click the Options or Advanced button. Older laser printers had less
printable area than ink jet printers).

A color picture on a key is printing in black and white.

Probable cause: Your color ink cartridges are empty or clogged.

Solution: Try printing a color document from another application. If this also prints
only black and white, replace your color ink cartridges.

Some of my keys or objects are not printed.

Probable cause: Keys or objects are not entirely on the overlay grid. 

Solution: From the View menu, select Preview in IntelliKeys. Move all keys and
objects entirely onto the overlay grid. Then Print again. 

I want to print the overlays on a computer that does not have Overlay Maker 3
installed.

Probable cause: Overlay Maker 3 is not installed.

Solution: Install IntelliTools Overlay Maker 3 Trial. Overlay Printer 3 Trial is
downloadable from the IntelliTools Web site www.intellitools.com.
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Troubleshooting – Problems Sending an Overlay
Sending a custom overlay to my IntelliKeys does not display the IntelliKeys
sending progress bar and the overlay does not type as expected.

Probable cause 1: IntelliKeys is not receiving signals from your computer.

Solution: Turn off your computer, and then unplug and reconnect the IntelliKeys
cable.

Turn on the computer again. Use the IntelliKeys Setup Overlay to press Keyboard
Reset twice in succession. Or open the IntelliKeys USB control panel and click
Keyboard Reset. Resend the custom overlay. You should see in the middle of your
screen the IntelliKeys sending progress bar appear and then disappear. 

Probable cause 2: IntelliKeys USB is Off or its mode is With this overlay.

Solution: Press the On/Off switch located on the upper left edge of the IntelliKeys
USB case—the | should be depressed. Then open the IntelliKeys USB control panel
and click Keyboard Reset. Send the overlay again. 

Probable cause 3: A version 1.01 IntelliKeys is plugged into your computer.

Solution: Use a ROM version 1.05 or later in IntelliKeys. Contact IntelliTools Technical
Support about upgrading your IntelliKeys. To check the ROM version of your
IntelliKeys, open any word processor and insert the Setup Overlay into IntelliKeys.
Press the List Features key. At the bottom of the list that appears, you will see the ROM
version.

Probable cause 4: IntelliKeys is connected to the computer with an iMate adapter.

Solution: Macintosh only. The iMate USB Driver (an extension) must be installed
correctly. See the insert that came with the iMate adapter for further information. In
addition, you can visit www.griffintechnology.com or the Technical Support area of our
Web site: www.intellitools.com.

Probable cause 5: The computer does not have any IntelliTools software installed.

Solution: Install IntelliTools Overlay Sender 3. Overlay Sender 3 is downloadable from
the IntelliTools Web site www.intellitools.com.

To send the overlay, open Overlay Sender 3, navigate to the overlay file, and click Open.
For Windows, go to the Start menu, select Programs, IntelliTools Software, Overlay
Sender. 
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Troubleshooting – Problems Using Overlays
The IntelliKeys [Shift] keys do not work at all.

Probable cause: IntelliKeys is set to No Latching.

Solution: Use the IntelliKeys Setup Overlay to press Keyboard Reset twice in
succession. Or open the IntelliKeys USB control panel and click Keyboard Reset.
Resend the custom overlay.

The IntelliKeys [Shift] keys work erratically.

Probable cause 1: Some features in the Easy Access control panel (Macintosh) or
Accessibility Options control panel (Windows) are active.

Solution: (Windows): Turn off all Accessibility Options features. If you require the use
of MouseKeys for your IntelliKeys, leave MouseKeys selected. For more information
about MouseKeys, see the IntelliKeys User’s Guide.

Solution: (Macintosh): Open the Easy Access control panel. Turn off all Easy Access
features.

Probable cause 2: Your single letter (character) keys have the Key Content [Non-
repeating].

Solution: Open the overlay file in Overlay Maker 3. For each single letter (character)
key, delete the special character [Non-repeating]. For example, Key Content = d[Non-
repeating] should be Key Content = d. Send the overlay again.

Probable cause 3: Your key types a word or phrase.

Solution: The Shift key only works with single letter (character) keys, just like the
standard keyboard. When the overlay key types more than one letter (character), the
overlay key Shift will not capitalize the first letter of a lowercase word. Capitalized
words for building sentences can be done with Overlay Maker 3 levels. For example,
one level has overlay keys that type the words in lowercase letters. Another level has
overlay keys that type the same words correctly capitalized for starting a sentence.
Each level requires a switching key. For example, a key labeled Shift would have key
content [go to level capital words][Non-repeating] and on the capital words level, a key
labeled Lowercase would have key content [go to level lowercase words][Non-
repeating].

Overlay keys respond incorrectly.

Probable cause 1: The overlay was not sent.

Solution: Send the overlay again.

Probable cause 2: The overlay information sent to IntelliKeys does not match the
printed overlay that was inserted into IntelliKeys.

Solution: Check that the printed overlay name is the same as the overlay name being
sent.

Probable cause 3: There is a standard overlay inserted in IntelliKeys behind the
printed custom overlay. 
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Solution: Remove any standard overlay that may be behind the printed custom overlay.
Send the overlay again.

Probable cause 4: IntelliKeys USB is Off or its mode is With this overlay use....

Solution: Press the On/Off switch located on the upper left edge of the IntelliKeys
USB case—the | should be depressed. Then open the IntelliKeys USB control panel
and click Keyboard Reset. Send the overlay again. 

IntelliKeys responds inappropriately when touched between overlay keys.

Probable cause 1: The overlay printout was trimmed incorrectly, misaligning the
keys on the printed overlay to the placement of the keys sent to the IntelliKeys. 

Solution: Print out the overlay again and trim it carefully.

Probable cause 2: The overlay keys are positioned with Snap to Grid Off.

Solution: For visual esthetics, overlay keys can be positioned not aligned to the
IntelliKeys touch sensitive cell grid. You can reposition the keys with Snap to Grid On
or press the center of the key instead of the outer boundaries of the key. 

Single uppercase letters are printing out lower case.

Probable cause: Your text label is a single capital letter, and your key content is
[Same As Text Label]. To enable you to make an alphabet keyboard more conveniently,
the [Same As Text Label] special character changes all single uppercase letter text
labels to a lower case letter.

Solution: Edit your key's key content, and change the [Same As Text Label] special
character to the single upper letter, e.g., if the key's text label is A, change the key
content from [Same As Text Label] to Key Content = A.

Shortcut keystroke commands (as key content) respond incorrectly.

Probable cause 1: You used an uppercase letter in the key content.

Solution: For example, [Ctrl]+P is a Windows shortcut keystroke to open the Print
dialog box. On the standard keyboard you press the two keys Control and P
simultaneously and then release these keys. The overlay Key Content is [Control]p
(not [Control]P, because that is really [Control][Shift]p).

For example, [Command]+P is a Macintosh shortcut keystroke to open the Print dialog
box. On the standard keyboard you press the two keys Command and P
simultaneously and then release these keys. The overlay Key Content is [Command]p
(not [Command]P, because that is really [Command][Shift]p).

Probable cause 2: The overlay's shortcut keystrokes were made for a Windows
computer and the overlay is being used on a Macintosh computer.

Solution: Windows and Macintosh shortcut keystrokes can be essentially the same
except for the modifier key. [Ctrl]+S is the Windows shortcut keystroke to save a file.
[Command]+S is the Macintosh shortcut keystroke to save a file. IntelliKeys Classic
will map Command (Macintosh) to Alt (Windows) while IntelliKeys USB will map
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Command (Macintosh) to Control (Windows). To avoid cross platform confusion, if
your overlay has modifier keystroke combinations, create one overlay for Windows and
one overlay for Macintosh using the appropriate platform specific modifiers in the key
content. Windows modifier keys are Shift, Control, and Alt. Macintosh modifier keys
are Shift, Control, Option, and Command. 

Some text is missing when an overlay key is pressed.

Probable cause: The key content is a large amount of text. 

Solution: Shorten the text for this key and create another key for the remaining text.
Or adjust the IntelliKeys Data Send Rate. Refer to the IntelliKeys User's Guide. 

When an overlay key is pressed, the words or sentences typed are not being
spoken.

Probable cause 1: Your program that you are typing in does not support Speech
output. For example, Overlay Maker 3 and Microsoft Word do not support Speech
output when typing text. 

Solution: Use your IntelliKeys custom overlay with a program that supports Speech
output when text is typed, like Classroom Suite.

Probable cause 2: Spaces or punctuation are missing after words or sentences in the
key content. IntelliTalk 3 recognizes a word if it has a space, comma, semi-colon, or
colon after it. A sentence is recognized if it has a period, exclamation point, or question
mark after it.

Solution: Edit your text label or key content so that words and sentences have a space
or punctuation at the end.

The font and font size on the overlay key is not being typed when the overlay key
is pressed.

Probable cause: The font and attributes selected in Overlay Maker 3 are for the look
of the printed overlay. As with standard keyboards, the font and font size is program
specific. For example, open Classroom Suite and select the font and font size that you
chose for the custom overlay’s keys’ text labels. 

Solution: Open the program that you are using with your custom overlay, and select
the font and font size that you chose for your overlay's text labels in Overlay Maker 3.
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